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1   Introducción 

El software Capture Pro es una aplicación de digitalización de producción fácil 
de instalar y utilizar para la captura electrónica de documentos. 

Este software es una opción perfecta para el procesamiento de imágenes 
y formularios, para las aplicaciones de flujo de trabajo y como aplicación 
independiente. Gestiona la digitalización a una y dos caras, la indexación y la 
creación de lotes en color, blanco y negro y/o escala de grises. Los lotes se 
pueden exportar fácilmente a una gran cantidad de aplicaciones comunes. 
El software Capture Pro permite aprovechar en su totalidad las capacidades 
de los escáneres para obtener la máxima productividad. Todas las funciones 
están disponibles en el software y no se requiere ninguna aceleración especial 
de hardware.

El software Capture Pro se diseñó para ser una herramienta rápida, precisa 
y fácil de usar. Proporciona un rendimiento óptimo del escáner y una 
productividad máxima. Una pantalla para múltiples páginas a alta velocidad 
presenta las imágenes y datos opcionales de índice a medida que se 
digitalizan los documentos. Incluye un conjunto completo de herramientas 
basadas en iconos que permiten simplificar la gestión de la digitalización. 

Esta Guía del administrador ofrece información detallada sobre la creación de 
configuraciones de trabajo, que permitirán a los usuarios hacer un uso más 
eficiente del software Capture Pro. Además, incluye información sobre la 
configuración de páginas, códigos de barra y códigos de parche, importación 
automática y más. 

Compatibilidad con 
escáneres

El software Capture Pro es compatible con escáneres Kodak y Alaris, así 
como con algunos escáneres de otros fabricantes. En el siguiente enlace, 
se incluye una lista completa:
www.kodakalaris.com/go/kcsscannersupport.

Para obtener información actualizada sobre los requisitos del sistema y los 
sistemas operativos certificados, consulte la página de especificaciones en el 
sitio web de Capture Pro:
https://www.alarisworld.com/solutions/software/document-scanning-software/
capture-pro-software#Specifications.

https://www.alarisworld.com/solutions/software/document-scanning-software/capture-pro-software#Specifications
https://www.alarisworld.com/solutions/software/document-scanning-software/capture-pro-software#Specifications
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Documentación 
relacionada

Además de esta Guía del administrador, dispone de la documentación 
siguiente:

• Ayuda en línea: proporciona información sobre el producto, incluida la 
configuración detallada del producto, detalles sobre la interfaz y numerosas 
funciones avanzadas. Para encontrar esta información en el archivo de 
ayuda, puede utilizar la tabla de referencia del contenido, el índice o la 
función de búsqueda. 

Para acceder a la ayuda, presione F1, seleccione el botón Help (Ayuda) 
en un cuadro de diálogo o haga clic en el icono ? de la esquina superior 
derecha de cualquier ventana.

• Guía de inicio rápido: ofrece una serie de procedimientos básicos 
y sencillos para empezar a utilizar el software de inmediato, incluyendo la 
instalación y el inicio del software Capture Pro, así como los procedimientos 
para digitalizar mediante configuraciones de trabajo predefinidas 
y predeterminadas. Puede encontrar un PDF de esta guía en la sección 
Manuales y guías de la página de asistencia del software Capture Pro: 
https://support.alarisworld.com/capture-pro-software#Manuals. 

• Guía del usuario: esta guía detalla los pasos básicos para crear un lote 
nuevo, digitalizar documentos, editar las imágenes digitalizadas y generar 
un lote. Además, se incluye una descripción de las ventanas, los menús 
y las herramientas.

Network Edition: Guía del sistema: explica los procedimientos de 
instalación de Capture Pro Network Edition. Puede encontrar un PDF de esta 
guía en la sección Manuales y guías de la página web de asistencia del 
software Capture Pro:
• https://support.alarisworld.com/capture-pro-software#Manuals

Notas de la versión: contienen información que puede no estar disponible en 
otra documentación de ayuda. Para consultar las notas de la versión, vaya 
a www.kodakalaris.com/go/kcsdownloads y acceda a la sección Estación de 
trabajo/Software cliente del sitio web, que contiene un enlace a las notas de 
la versión más actualizadas. 

Aplicaciones de 
detección de virus

Si utiliza una aplicación de detección de virus, el rendimiento del sistema 
mejorará si excluye del análisis las carpetas y subcarpetas de salida de lotes, 
de imágenes digitalizadas y del grupo de trabajo del software Capture Pro. 

Los nombres predeterminados de estas carpetas son: 

C:\ScanPro

C:\BatchesPro

C:\Usuarios\Público\Documentos\KCS Pro

C:\Archivos de programa (x86)\Kodak\Capture Pro

NOTA: Si modificó las carpetas de instalación predeterminadas mediante la 
opción de instalación Avanzada, excluya esas carpetas cuando 
configure el software antivirus.

https://support.alarisworld.com/capture-pro-software#Manuals
https://support.alarisworld.com/capture-pro-software#Manuals
www.kodakalaris.com/go/kcsdownloads
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Instalación del 
software

Antes de comenzar, consulte el sitio web de Kodak Alaris para asegurarse de 
que su equipo cumpla con la configuración recomendada para el software 
Capture Pro:
https://www.alarisworld.com/solutions/software/document-scanning-software/
capture-pro-software#Specifications 

Para completar la instalación, necesitará lo siguiente:

• El CD del controlador del escáner proporcionado por el fabricante del 
escáner, si va a conectar un escáner.

• El archivo PDF adjunto al correo electrónico de notificación de licencia que 
contiene el número de serie.

• La aplicación descargada del sitio web del software Capture Pro en 
www.kodakalaris.com/go/CaptureProDownload.

Antes de proceder con la instalación, compruebe las notas de la versión para 
obtener información adicional. Las notas de la versión están disponibles en el 
sitio web de Kodak Alaris: www.kodakalaris.com/go/kcsdownloads. Acceda 
a la sección Estación de trabajo/Software cliente del sitio web, que 
contiene un enlace a las notas de la versión más actualizadas.

Para iniciar la instalación, ejecute el instalador .exe que descargó.

• Si el equipo en el que se va a instalar el software Capture Pro no dispone de 
acceso a Internet, deberá descargar también la herramienta Administrador 
de licencias, que está disponible en el sitio web del software Capture Pro. 
En equipos con acceso a Internet, se instalará el Administrador de licencias.

• La llave de hardware opcional (llave USB), si la adquirió.

• Derechos de administrador en el equipo en el que va a instalar el software.

1. Instale los controladores del escáner. Para ello, introduzca el CD del 
controlador del escáner en la unidad de CD y siga las instrucciones que se 
indican. 

2. Conecte el escáner y compruebe la conexión mediante el uso de Scan 
Validation Tool. Para obtener más información, consulte la Guía del 
usuario del escáner.

La herramienta Scan Validation Tool se instalará automáticamente durante 
la instalación del controlador del escáner Kodak Alaris. Esta herramienta 
se puede utilizar para comprobar que el escáner está conectado 
correctamente y en funcionamiento.
NOTA: Siga las recomendaciones del fabricante para instalar y probar el 

escáner en el equipo.

https://www.alarisworld.com/solutions/software/document-scanning-software/capture-pro-software#Specifications
https://www.alarisworld.com/solutions/software/document-scanning-software/capture-pro-software#Specifications
http://www.kodakalaris.com/go/kcsdownloads
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3. Antes de proceder con la instalación, compruebe las notas de la versión 
para obtener información adicional. Las notas de la versión están 
disponibles en el sitio web de Kodak Alaris: www.kodakalaris.com/go/
kcsdownloads. Acceda a la sección Estación de trabajo/Software cliente 
del sitio web, que contiene un enlace a las notas de la versión más 
actualizadas.
Para iniciar la instalación, ejecute el instalador .exe que descargó.

4. Cuando aparezca la pantalla del menú de instalación, seleccione el idioma 
que desee y haga clic en la opción Install Capture Pro Software (Instalar 
el software Capture Pro).

5. Una vez que haya leído el Acuerdo de licencia, haga clic en I accept the 
terms of the license agreement (Acepto los términos del Acuerdo de 
licencia) y, a continuación, haga clic en Next (Siguiente). Se mostrará la 
pantalla de la llave de licencia de hardware.

6. Seleccione I will not be using a USB Hardware Key (No voy a utilizar 
una llave de hardware USB) y haga clic en Next (Siguiente). 

NOTA: Si adquirió la llave de hardware USB opcional, seleccione I have 
inserted my USB Hardware key (Ya inserté mi llave de hardware 
USB) y haga clic en Next (Siguiente).

Se mostrará la pantalla de tipo de instalación.

7. Haga clic en Next (Siguiente). Se mostrará la pantalla de número de serie 
del software.
NOTA: Seleccione Install as Capture Pro Network Edition Client 

(Instalar Capture Pro Network Edition como cliente) únicamente si 
adquirió el software Capture Pro Network Edition y lo está 
instalando como cliente.

8. Introduzca el número de serie del software y haga clic en Next (Siguiente). 
Se mostrará la pantalla de registro del producto.

9. Introduzca la ID de registro que figura en el correo electrónico de 
notificación de licencia que recibió. Si no tiene ninguna ID de registro, 
seleccione Register Now (Register Now) y finalice el registro. Haga clic 
en Next (Siguiente). Se mostrará la pantalla Get License (Obtener 
licencia) mientras se obtiene la licencia del servidor de licencias de Kodak 
Alaris.

NOTA: Si el equipo no dispone de acceso a Internet, consulte “Anexo A 
Administrador de licencias” para obtener más información acerca 
de cómo obtener una licencia. 

10. En la pantalla de tipo de configuración, seleccione Typical (Típica) y haga 
clic en Next (Siguiente). Se mostrará la pantalla de resumen de la 
instalación.

11. Haga clic en Next (Siguiente). Se mostrará la pantalla Ready to Install the 
Program (Listo para instalar el programa).

12. Haga clic en Install (Instalar) para iniciar la instalación. Se mostrarán 
varias pantallas de progreso. Siga las instrucciones que se indican en los 
mensajes emergentes.

13. Haga clic en Finish (Finalizar).

14. Si se le solicita, seleccione la opción para reiniciar el equipo.

http://www.kodakalaris.com/go/kcsdownloads
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Cómo iniciar el 
software Capture Pro

Si no está utilizando las ediciones de Index Only (Solo índice) o Auto Import 
(Importación automática), asegúrese de que el escáner está encendido y 
conectado correctamente al equipo. Si adquirió una clave de hardware 
opcional, asegúrese de haberla insertado en un puerto USB del equipo. 

• Haga clic con el botón secundario del ratón en el icono del software Capture 
Pro en el escritorio y seleccione Ejecutar como administrador.

NOTAS:

• Los clientes Network Edition le avisarán que están obteniendo una licencia.

• Los clientes del software Capture Pro Network Edition llevarán a cabo una 
sincronización inicial con el software Capture Pro Server.

• Haga doble clic en el icono del software Capture Pro en el 
escritorio o

• vaya a: Inicio > Programas > Kodak > Software Kodak 
Capture Pro.
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2   Configuración de trabajo

Función 
Configuración de 
trabajo

La función Configuración de trabajo permite configurar los parámetros de un 
trabajo. Este capítulo proporciona información sobre los procedimientos 
relacionados con la selección de las opciones de las pestañas Capture 
(Captura), Índice (Index) y Salida (Output), que permiten configurar un trabajo 
según sus necesidades de digitalización. Una vez que se configura un trabajo, 
usted puede seleccionar aquel que reúna los requisitos de digitalización 
y salida para un lote de documentos.

Si desea configurar trabajos para usarlos con el software Capture Pro, debe 
acceder al cuadro de diálogo Configuración de trabajo. En Configuración de 
trabajo, puede seleccionar un nombre de trabajo ya definido y utilizarlo como 
plantilla para personalizar los trabajos que quiera utilizar en su entorno. 

El software Capture Pro incluye tres trabajos predefinidos:

Ready to Scan (Listo para digitalizar): permite iniciar la digitalización de 
documentos sin aplicar ninguna configuración, mediante la configuración 
predeterminada. Este trabajo no tiene ningún índice definido y envía todas las 
imágenes digitalizadas a una estructura de carpeta en el directorio 
C:\ScanPro.

Scan to PDF (Digitalizar a PDF): es similar a Listo para digitalizar, excepto 
que, una vez digitalizados los documentos, se mostrará la primera página en 
el Visor de imágenes y se le solicitará que introduzca un nombre de archivo 
como dato de índice. Los datos de índice se utilizan como nombre de archivo 
para la salida de los documentos.

Scan to E-mail (Digitalizar a correo electrónico): es similar a Digitalizar a PDF, 
pero se crea un archivo PDF y se incluye como documento adjunto a un 
mensaje de correo electrónico. Al finalizar la digitalización, se abrirá la 
aplicación de software de correo electrónico con el adjunto digitalizado y listo 
para su envío a una dirección de correo de su cuenta de correo electrónico.

En función de la acción que desee llevar a cabo, puede seleccionar una de 
estas configuraciones de trabajo como punto de partida para configurar un 
trabajo.
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Acceso a una 
configuración de 
trabajo

• Haga clic en File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

Cuadro de diálogo 
Configuración de 
trabajo

La siguiente información es común a todas las pestañas del cuadro de diálogo 
Configuración de trabajo:

Job name (Nombre del trabajo): indica los trabajos predefinidos y otros 
trabajos configurados en la lista desplegable. 

El cuadro de diálogo Configuración de trabajo se compone de tres pestañas: 
Capture (Captura), Index (Índice) y Output (Salida). En las siguientes 
secciones, se proporciona información detallada sobre cómo utilizar estas 
pestañas.
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• La pestañaIndex (Índice) permite definir campos de índice en los niveles de 
documento y lote. La pestaña Database Lookup (Búsqueda en la base de 
datos) permite especificar la fuente de datos, definir el modo de realizar la 
búsqueda y el tipo de datos utilizados para completar campos de índice 
o validar su contenido. Consulte la sección “Configuración de trabajo: 
Pestaña Índice”, que aparece más adelante en este capítulo.

• La pestaña Output (Salida) permite configurar las opciones avanzadas y de 
destino de los trabajos. Consulte la sección “Configuración de trabajo: 
Pestaña Salida”, que aparece más adelante en este capítulo.

Iconos

Add (Agregar): permite agregar una nueva configuración de 
trabajo. 
1. Haga clic en el icono Add (Agregar).

2. Escriba un nombre para el nuevo trabajo y haga clic en Save 
(Guardar).

3. En las pestañas Capture (Captura), Index (Índice) y Output 
(Salida), configure los criterios de esta configuración de 
trabajo. Consulte las secciones a continuación para obtener 
información detallada sobre cada una de estas pestañas.

4. Haga clic en OK (Aceptar) cuando haya terminado.

NOTA: El último carácter del nombre de configuración de 
trabajo no puede ser un punto (.).

Rename (Cambiar nombre): permite cambiar el nombre de la 
configuración de trabajo seleccionada actualmente. No es 
posible cambiar el nombre de un trabajo abierto.
1. Seleccione la configuración de trabajo cuyo nombre quiera 

cambiar en la lista desplegable Job Name (Nombre del 
trabajo).

2. Haga clic en el icono Rename (Cambiar nombre). 

3. Escriba un nombre nuevo para la configuración de trabajo 
y haga clic en OK (Aceptar). 

NOTA: El último carácter del nombre de configuración de 
trabajo no puede ser un punto (.).

Delete (Eliminar): permite eliminar la configuración de trabajo 
seleccionada. No puede eliminar una configuración de trabajo si 
está abierta o hasta que todos los lotes se hayan procesado 
o eliminado.
1. Seleccione la configuración de trabajo que quiera eliminar 

en la lista desplegable Job Name (Nombre del trabajo).

2. Haga clic en el icono Delete (Eliminar). Se mostrará un 
cuadro de confirmación.

3. Haga clic en Yes (Sí) para confirmar la eliminación.



10 A-61993_es  Marzo de 2022
 

Export (Exportar): permite exportar la configuración de trabajo 
a una ubicación distinta y dejarla guardada también en el 
software Capture Pro.
1. Seleccione una configuración de trabajo en la lista 

desplegable Job Name (Nombre del trabajo).

2. Haga clic en el icono Export (Exportar). Se mostrará el 
cuadro de diálogo Export (Exportar).

3. Haga clic en Browse (Examinar) para ir a la carpeta de 
destino a la que quiera exportar la configuración de trabajo.

4. El nombre de exportación se rellenará con el nombre del 
trabajo que está exportando. Si desea cambiar el nombre, 
introduzca el nombre nuevo en el campo Export name 
(Nombre de exportación).

NOTA: Directory and Files (Directorio y archivos) es el único 
tipo de exportación disponible en este momento.

5. Haga clic en OK (Aceptar). Se mostrará un mensaje que 
indica que la exportación se realizó correctamente.
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Después de modificar todas las entradas de la configuración de trabajos, haga 
clic en:

More Output destinations (Más destinos de salida): este botón solo se 
muestra en la pestaña Output (Salida). Al hacer clic en él, aparecen destinos 
de salida menos frecuentes y de terceros.

SharePoint Index Setup Wizard (Asistente de configuración de indexación 
de SharePoint): proporciona una forma rápida y sencilla de configurar un 
trabajo del software Capture Pro para usarlo con un sitio de SharePoint que ya 
tenga. Para obtener más información, consulte la sección “Uso del asistente 
de configuración de indexación de SharePoint”, que aparece más adelante en 
este capítulo.

OK (Aceptar): cierra el cuadro de diálogo y guarda los cambios.

Cancel (Cancelar): permite cerrar el cuadro de diálogo sin guardar los 
cambios. 

Apply (Aplicar): guarda los cambios, pero el cuadro de diálogo permanece 
abierto.

Import (Importar): permite importar una configuración de trabajo 
al software Capture Pro desde otra ubicación. 
1. Haga clic en el icono Import (Importar). Se mostrará el 

cuadro de diálogo Import (Importar).

2. Haga clic en Browse (Examinar) para ir a una configuración 
de trabajo exportada que quiera importar. 

3. El nombre de importación se rellenará con el nombre del 
trabajo que está importando. Si desea cambiar el nombre, 
introduzca el nombre nuevo en el campo Import name 
(Nombre de importación).

NOTA: El único tipo de importación disponible en este 
momento es Directory and Files (Directorio 
y archivos).

4. Haga clic en OK (Aceptar). Se mostrará un mensaje que 
indica que la importación se realizó correctamente.

NOTA: Si está importando un trabajo que utiliza un modelo de 
escáner diferente del que usted usa, deberá volver 
a configurar los ajustes específicos del escáner 
(es decir, la configuración de impresora/contador).
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Configuración de 
trabajo: Pestaña 
Captura

La pestaña Capture (Captura) permite configurar los parámetros de 
configuración generales, de lote, código de barras, detección de marca 
y OCR, separación y escáner.

• General (General): permite definir el almacenamiento de las imágenes tras 
la digitalización.

• Batch Settings (Configuración de lote): permite definir el formato de 
nombre del lote de la configuración de trabajo y limita los números de los 
documentos del lote o las páginas del documento.

• Bar Code, OCR & Mark Detection (Código de barras, OCR y detección de 
marcas): permite crear y modificar las zonas de código de barras, OCR 
y detección de marcas, y configurarlas para su uso.

• Separation (Separación): permite definir separaciones de lote y 
documentos por recuento, página en blanco, zona de código de barras, 
zona de OCR o código de parche.

• Scanner (Escáner): permite crear configuraciones para la dirección de 
imagen y la impresión en escáneres con estas capacidades. Los ajustes de 
configuración del escáner, como dirección de imagen, impresora y parche, 
se debe realizar siempre en la pestaña Job Setup (Configuración de 
trabajo), y no en Page Setup (Configuración de página). Los valores en 
conflicto adoptarán los valores de Job setup (Configuración de trabajo) de 
forma predeterminada.

• Sort (Clasificación): permite identificar cómo desea que se clasifiquen las 
páginas y los documentos de un trabajo. La clasificación puede ser física 
(automática) en modelos de escáneres compatibles con varias bandejas de 
salida (p. ej., el escáner Kodak i5x50S) o puede ser manual. Se pueden 
añadir distintos conjuntos de reglas de clasificación para el trabajo. 
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Configuración general: 
pestaña Captura

Seleccione General (General) en la pestaña Capture (Captura) para crear 
o cambiar los siguientes parámetros de configuración:

Ubicación de la imagen digitalizada: muestra la ubicación actual en la que 
se almacenarán las imágenes digitalizadas del trabajo seleccionado. Si no 
desea que las imágenes se digitalicen en la ubicación que se muestra, haga 
clic en Browse (Examinar) para seleccionar otra.

Output image location (Ubicación de la imagen de salida): permite 
seleccionar el destino final de las imágenes de salida. Si no desea que las 
imágenes se envíen a la ubicación que se muestra, haga clic en Browse 
(Examinar) para seleccionar otra.

Description (Descripción): permite introducir cualquier nota importante como 
recordatorio de los parámetros de esta configuración de trabajo.

Page setup (Configuración de página): permite establecer la configuración de 
página predeterminada cuando se abre un nuevo lote. También se puede 
seleccionar la lista de configuraciones de página disponibles para el usuario 
durante la digitalización. Seleccione Setup (Configuración) para mostrar el 
cuadro de diálogo Select Page Setup (Seleccionar configuración de página). 
Utilice los botones Add Item (Agregar elemento) y Remove Item (Eliminar 
elemento) para crear una lista de Selected Page Setups (Configuraciones de 
página seleccionadas) desde la lista de Available Page Setups 
(Configuraciones de página disponibles). Cuando haya terminado, haga clic 
en OK (Aceptar). 

En la lista desplegable Page setup (Configuración de página), seleccione la 
configuración de página predeterminada que se utilizará cuando se abra un 
nuevo lote.

• Automatically close batch after scanning is finished (Cerrar lote 
automáticamente cuando acabe la digitalización): si esta opción está 
seleccionada, se cierra el lote en el explorador de lotes y el visor de 
imágenes cuando se detiene el transporte del escáner.

• Automatically output when batch is closed (Generar salida 
automáticamente al cerrar el lote): cuando esta opción está seleccionada, 
se procesa el lote para su salida inmediatamente después de cerrarlo. 
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• Keep batch after output (Mantener lote tras salida): cuando esta opción 
está seleccionada, se guarda el lote en la ubicación de la imagen 
digitalizada y se crea el lote de salida.

• Add scanned pages to the last document in the batch (Agregar páginas 
digitalizadas al último documento del lote): si se marca esta opción, 
se agregan todas las próximas páginas digitalizadas al último documento 
del lote.

Configuración de lote: 
pestaña Captura

Seleccione Batch Settings (Configuración de lote) en la pestaña Capture 
(Captura) para definir el formato de asignación de nombres a los lotes de este 
trabajo y establecer límites en el número de documentos del lote o de 
páginas del documento. Por ejemplo, si sabe que todos los lotes contienen 
100 documentos y establece límites, se emitirá una alerta si el número de 
documentos del lote no coincide con el esperado.

• Batch naming (Asignación de nombres a lotes): tiene las siguientes 
opciones:

- Batch name (Nombre de lote): seleccione un nombre de lote en la lista 
desplegable. El nombre de lote Standard (Estándar) es “LoteXXX”. 
Si quiere cambiar el nombre de lote a “Facturas” seguido de la fecha, 
haga clic en Setup (Configuración) para abrir el cuadro de diálogo 
Standard Setup (Configuración estándar). En este cuadro de diálogo, 
puede aplicar esa configuración. Para obtener información sobre los 
procedimientos, consulte “Modificación de la configuración de 
asignación de nombres a lotes”.

- Next batch number (Número del siguiente lote): introduzca el número 
que desee para el siguiente lote.
El número de lote actual se determina en el momento en que se crea el 
lote. No podrá introducir ningún valor si la opción Enable Job Level 
batch numbering (Activar numeración de lotes a nivel de trabajo) no 
está seleccionada. Consulte “Configuración de la estación de trabajo” 
en el capítulo 2 de la Guía del usuario del software Kodak Capture Pro.
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• Limits > Documents per Batch (Límites > Documentos por lotes): escoja 
entre las siguientes opciones.

- Numbers (Números): introduzca o seleccione el número mínimo 
y máximo de documentos que quiere permitir que haya en un lote.

- Warn (Avisar): introduzca un número de documentos que sirva como 
advertencia de que el lote se acerca al número máximo de documentos. 
Cuando la digitalización exceda este límite (en uno o dos documentos), 
se detendrá.

• Limits > Pages per Document (Límites > Páginas por documento): escoja 
entre las siguientes opciones.

- Numbers (Números): introduzca o seleccione el número mínimo y máximo 
de páginas que quiere permitir que haya en un documento.

- Warn (Avisar): introduzca un número de documentos que sirva como 
advertencia de que el documento se acerca al número máximo de 
páginas. Cuando la digitalización exceda este límite (en una o dos 
páginas), se detendrá.

• Reset document ID (Restablecer ID de documentos): seleccione esta 
casilla para restablecer el contador de documentos a 0.

Modificación de la 
configuración de asignación 
de nombres a lotes

Cuando seleccione Standard (Estándar) y Setup (Configuración) en el campo 
Batch naming (Asignación de nombres a lotes), se mostrará el cuadro de 
diálogo Standard Setup (Configuración estándar), donde puede agregar 
o eliminar valores al nombre del lote.

La lista Predefined values (Valores predefinidos) incluye valores que puede 
seleccionar para agregarlos a la fórmula de texto actualmente en uso. Puede 
agregar cualquier cantidad de elementos al nombre del lote seleccionando 
el elemento que quiera en la lista Predefined values (Valores predefinidos).

Por ejemplo, si quiere etiquetar un lote con el nombre de usuario, la fecha y la 
hora, debería introducir lo siguiente: 

Nombre de usuario, Fecha (dd), Fecha (aa), Hora24 (HHmmss) 
El resultado sería el siguiente: Juan Sánchez0409115503.

Para agregar un valor:

1. Seleccione el valor que quiere agregar en la lista Predefined values 
(Valores predefinidos).
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2. Haga clic en Add Item (Agregar elemento). El elemento se agregará a la 
fórmula.

NOTA: Cuando se especifica un nombre de ruta, el límite es de 
248 caracteres. 

3. Si quiere agregar más valores, repita los pasos 1 y 2.

NOTA: Los campos Add leading zeros (Agregar ceros delanteros) 
y Number length (Longitud del número) pasan a estar disponibles 
cuando se selecciona el valor Batch counter (Contador de lotes).

4. Si corresponde, haga clic en Add leading zeros (Agregar ceros 
delanteros) para agregar ceros a la izquierda de la secuencia numérica. 

5. Si corresponde, introduzca un valor en el campo Number length (Longitud 
del número) para limitar el número de valores predefinidos que se 
permiten en la fórmula de texto. 

6. Haga clic en OK (Aceptar) cuando haya terminado.

NOTAS:

• Si hace clic en Delete Item (Eliminar elemento), se eliminará el último valor 
predefinido de la fórmula de texto.

• Si hace clic en Delete Formula (Eliminar fórmula), se eliminará la fórmula 
de texto.

Cuando seleccione Daily Counter Reset (Restablecimiento del contador 
diario) y Setup (Configuración) en el campo Batch naming (Asignación de 
nombres a lotes), se mostrará el cuadro de diálogo Daily Counter Reset Setup 
(Configuración de restablecimiento del contador diario), donde puede agregar 
o eliminar valores al nombre del lote, así como seleccionar el valor de 
restablecimiento.
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La lista Predefined values (Valores predefinidos) incluye valores que puede 
seleccionar para agregarlos a la fórmula de texto actualmente en uso. Puede 
agregar cualquier cantidad de elementos al nombre del lote seleccionando el 
elemento que quiera en la lista Predefined values (Valores predefinidos). Para 
activar Daily Counter Reset (Restablecimiento del contador diario), debe 
seleccionar el valor predefinido Batch counter (Contador de lotes). Cuando la 
opción Batch counter (Contador de lotes) está seleccionada, el contador 
aumenta por cada lote nuevo. Cuando se selecciona Reset batch number 
every day (Restablecer número de lote a diario), el contador de lotes 
restablece el valor especificado en Reset value (Restablecer valor) al inicio de 
cada día.

NOTAS:

• Para evitar que se dupliquen los nombres de lotes, la fórmula de texto debe 
incluir al menos un valor que cambie diariamente. Por ejemplo, si quiere 
etiquetar un lote con la fecha y un número que vaya incrementándose, 
deberá introducir lo siguiente:

Fecha (aaaa), fecha (MM), fecha (dd), contador de lotes
Para el primer lote del día, el resultado sería: 20120528001
El segundo lote sería: 20120528002
El primer lote del día siguiente sería: 20120529001

• Al utilizar un escáner Kodak o Alaris con una impresora, el restablecimiento 
del contador diario también restablece el valor del contador del escáner a 1 
al inicio de cada día.

Para agregar un valor:

1. Seleccione el valor que quiere agregar en la lista Predefined values 
(Valores predefinidos).

2. Haga clic en Add Item (Agregar elemento). El elemento se agregará a la 
fórmula.

NOTA: Cuando se especifica un nombre de ruta, el límite es de 
248 caracteres.

3. Si quiere agregar más valores, repita los pasos 1 y 2.

NOTA: Los campos Add leading zeros (Agregar ceros adelante) y Reset 
batch number every day (Restablecer número de lote a diario) 
se habilitan cuando se selecciona el valor Batch counter 
(Contador de lotes).

4. Si corresponde, haga clic en Add leading zeros (Agregar ceros adelante) 
para agregar ceros a la izquierda de la secuencia numérica.

5. Si corresponde, introduzca un valor en el campo Number length (Longitud 
del número) para limitar el número de valores predefinidos que se 
permiten en la fórmula de texto.

6. Si corresponde, haga clic en Reset batch number every day 
(Restablecer número de lote a diario) para restablecer el número de 
secuencia a un valor específico al inicio de cada día.

7. Si corresponde, introduzca un valor en el campo Reset value (Restablecer 
valor) para especificar el número de secuencia inicial que se utilizará al 
comienzo de cada día.
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NOTAS:

• Si hace clic en Delete Item (Eliminar elemento), se eliminará el último valor 
predefinido de la fórmula de texto.

• Si hace clic en Delete Formula (Eliminar fórmula), se eliminará la fórmula 
de texto.

Configuración de código 
de barras, OCR y 
detección de marcas: 
pestaña Captura

Consulte la sección “4 Configuración de códigos de barras, OCR y detección 
de marcas” para obtener más información sobre cómo configurar el código de 
barras, OCR y detección de marcas.

Configuración de 
separación: pestaña 
Captura

La opción Separation (Separación) de la pestaña Capture (Capture) permite 
identificar cómo quiere separar lotes y documentos para un trabajo. Existen 
diversas formas de añadir separadores a los lotes. La siguiente lista ofrece las 
opciones que puede utilizar para crear la configuración de separación en el 
software Capture Pro:

• Con una zona de código de barras (consulte “4 Configuración de códigos de 
barras, OCR y detección de marcas”).

• Con una zona de OCR (consulte “4 Configuración de códigos de barras, 
OCR y detección de marcas”).

• Con códigos de parche 2, 3 o T (consulte “3 Configuración de parches”).

• Mediante el recuento de páginas automático en un documento de un lote 
(configure esta opción en By Count [Por recuento]).

• Con una página en blanco (configure esta opción en By Blank Page [Por 
página en blanco]). 

• Seleccionando Document > New (Documento > Nuevo) o Batch > Next 
(Lote > Siguiente).

• Pulsando Intro durante la digitalización.
• Haciendo clic con el botón secundario del ratón en un archivo de página en 

el explorador de lotes y haciendo clic en Split (Dividir).

Las siguientes secciones proporcionan información sobre los procedimientos 
para utilizar el software Capture Pro a fin de separar documentos o lotes 
automáticamente mediante el recuento de páginas y utilizar la separación por 
páginas en blanco.

Por recuento La configuración de separación By Count (Por recuento) de la pestaña 
Capture (Captura) permite introducir el número de documentos que contendrá 
cada lote, así como el número de páginas que contendrá cada documento. 
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1. Seleccione Batch Level (Nivel de lote) o Document Level (Nivel de 
documento).

2. Haga clic en Every (Cada) en Batch Level (Nivel de lote) e introduzca el 
número de documentos que debe contener un lote antes de crear uno 
nuevo.

3. Haga clic en Every (Cada) en Document Level (Nivel de documento) 
e introduzca el número de páginas que debe contener un documento 
antes de crear un documento nuevo.

Por página en blanco Durante la digitalización de imágenes, es posible insertar páginas en blanco 
para que actúen como separadores. El software Capture Pro puede reconocer 
las páginas en blanco y utilizarlas para empezar lotes o documentos nuevos, 
o crear archivos adjuntos a documentos.
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Para utilizar este método, active la opción By Blank Page (Por página en 
blanco) y seleccione la configuración que desee.

Cuando digitaliza de forma simultánea imágenes en blanco y negro y en color/
escala de grises, el software Capture Pro puede utilizar la imagen en blanco 
y negro o en color para determinar una página en blanco. Cuando el software 
detecta una página en blanco, las cuatro imágenes (anverso en color, reverso 
en color, anverso en blanco y negro, y reverso en blanco y negro) de la página 
se eliminan o se adjuntan al documento nuevo o actual, dependiendo de la 
configuración que haya creado.

El tamaño (en bytes) de las imágenes del anverso y el reverso de una página 
debe ser inferior al valor de bytes introducido para que el software Capture Pro 
identifique la página como en blanco. Si el software no reconoce la página 
como página en blanco, no la considerará como separador. 

NOTA: Es recomendable que pruebe estos valores para asegurarse de que el 
software detecte las páginas en blanco como separador. Para obtener 
información sobre los procedimientos, consulte la sección “Prueba de 
la configuración”.

Blank page separator when (Usar página en blanco como separador 
cuando): activa la función de separación por páginas en blanco.

• Image size (byte) is below (Tamaño de imagen [bytes] menor que): crea 
separaciones por páginas en blanco en función del tamaño (en bytes) de la 
imagen de la página en blanco. Especifique la cantidad máxima de datos 
(bytes) que puede contener una imagen para seguir considerándose en 
blanco y hágalo con cada tipo de imagen (blanco y negro, color/escala de 
grises) que vaya a digitalizar. 

El tamaño de la imagen se compara con la imagen sin procesar 
proveniente del escáner antes de realizar las operaciones. 

- Black & White (Blanco y negro): introduzca el tamaño máximo en bytes 
de la imagen en blanco y negro. De forma predeterminada, el tamaño 
sugerido para las imágenes en blanco y negro es 3000 bytes.
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- Color/Grayscale (Color/Escala de grises): introduzca el tamaño máximo 
en bytes de la imagen en color o escala de grises. El tamaño máximo de 
imagen que puede especificarse es 1 000 000 bytes (1 MB) para permitir 
la separación por páginas en blanco durante la digitalización en color. 
El tamaño recomendado es 100 000 bytes.

• Image content (%) is below (Contenido de la imagen [%] menor que): crea 
separaciones por páginas en blanco en función del porcentaje de contenido 
de imágenes de la página en blanco.

NOTA: Si las páginas que está digitalizando tienen distintos tamaños, una 
página pequeña puede quedar por debajo del recuento de bytes de 
imágenes en blanco aunque contenga datos. En ese caso, puede 
resultar útil describir una imagen en blanco especificando el campo 
% content (Porcentaje de contenido) en lugar del tamaño en bytes.

- Black & White (Blanco y negro): introduzca el porcentaje límite para 
imágenes en blanco y negro.

- Color/Grayscale (Color/Escala de grises): introduzca el porcentaje 
límite para las imágenes en color y en escala de grises.

Test (Probar): abre el cuadro de diálogo Test Image (Probar imagen), 
que permite digitalizar y probar la página en blanco que está utilizando como 
separador y que se considerará en blanco si se compara con el valor de 
configuración Image content (%) (Contenido de la imagen [%]). Utilice esta 
opción para verificar que el software considera que la página está en blanco. 
Para obtener más información, consulte “Prueba de la configuración”.

What to do if a page is blank (Qué hacer si una página está en blanco): 
seleccione una de las opciones como la siguiente acción que se llevará a cabo 
cuando el software reconozca una separación por páginas en blanco. 
• Create a new batch (Crear nuevo lote): crea un nuevo lote al detectar una 

página en blanco. 
• Create a new document (Crear nuevo documento): crea un nuevo 

documento al detectar una página en blanco.
• Next page stays in current document (La página siguiente se mantiene 

en el documento actual): elimina la página en blanco. 
• Delete page (Eliminar página): cuando esta opción esté seleccionada, 

la página en blanco no se incluirá en el lote o en el documento que esté 
separando. 
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Prueba de la configuración 1. Coloque en el escáner un documento que sirva para comprobar la 
separación por páginas en blanco.

2. Haga clic en Test (Probar) para mostrar el cuadro de diálogo Test Image 
(Probar imagen). 

3. Haga clic en el botón verde Scan (Digitalizar). Los resultados se 
mostrarán en el cuadro Test result (Resultado de la prueba).

• The image is (La imagen es): indica si la imagen es una imagen Blank 
(En blanco) o Not Blank (No en blanco).

• Image size is - bytes (El tamaño de la imagen es - bytes): el tamaño en 
bytes de la imagen de prueba.

• Content is - % (El contenido es - %): el porcentaje de contenido de la 
imagen de prueba.

4. Evalúe los valores mostrados en los campos Image size is - bytes 
(El tamaño de la imagen es - bytes) o Content is - % (El contenido es - %) 
del área Test result (Resultado de la prueba) y haga clic en Close (Cerrar).

5. Basándose en los resultados, reajuste los valores introducidos según sea 
necesario y haga clic en OK (Aceptar).

Configuración de 
clasificación: pestaña 
Captura

La opción Sort (Clasificar) de la pestaña Capture (Captura) en la pantalla Job 
Setup (Configuración de trabajo) permite identificar cómo quiere clasificar las 
páginas y los documentos de una configuración de trabajo. La clasificación 
puede ser física en modelos de escáneres compatibles con varias bandejas 
de salida (p. ej., el escáner Kodak i5x50S) o puede ser manual. 

La clasificación tiene como resultado un tratamiento distinto en la salida del 
escáner: 

• La página o el documento clasificado se envía a una bandeja distinta 
(para la clasificación física).

• El escáner se detiene y se muestran instrucciones al usuario para gestionar 
la página o el documento clasificado (para la clasificación manual).

La siguiente lista ofrece las opciones que puede utilizar para crear 
configuraciones de clasificación en el software Capture Pro:

1. Por alimentación múltiple

2. Por tamaño

3. Por código de parche
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4. Por código de barras

5. Por índice de documento

Si se establecen varias opciones de clasificación, se aplicará el orden de 
clasificación que se muestra anteriormente. Para todas las opciones de 
clasificación (excepto índice de documento), la clasificación se realiza por 
página. Para la clasificación por índice de documento, se clasifica el 
documento entero en la bandeja definida o se proporcionan instrucciones para 
la clasificación manual. 

Cuando el escáner es compatible con la clasificación física y la clasificación 
está configurada, la opción Default Destination (Bandeja de papel 
predeterminada) se debe definir en la página Sort > General (Clasificación: 
General). 

NOTA: El destino del papel (la bandeja de papel predeterminada) se activará 
únicamente cuando el modelo de escáner sea compatible con la 
clasificación física (p. ej., el escáner Kodak i5x50S). 

Las secciones que aparecen a continuación proporcionan información sobre 
los procedimientos para utilizar el software Capture Pro a fin de clasificar 
automáticamente páginas y documentos.
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By Multifeed (Por 
alimentación múltiple)

En el panel izquierdo de la pestaña Capture (Captura), seleccione Sort > 
By Multifeed (Clasificar > Por alimentación múltiple). Con esta opción de 
clasificación, la detección de alimentación múltiple debe estar activada en el 
controlador del escáner (consulte la documentación TWAIN o ISIS del 
escáner). 

Para activar la opción Sort by Multifeed (Clasificar por alimentación múltiple), 
seleccione el botón de opción Sort by Multifeed (Clasificar por alimentación 
múltiple). Si el escáner es compatible con la clasificación física (p. ej., el 
escáner Kodak i5x50S), el campo Destination (Destino) enumerará las 
bandejas admitidas por el escáner y el campo Message (Mensaje) estará 
oculto. Si el escáner no es compatible con la clasificación física, el menú 
desplegable Destination (Destino) contendrá las opciones Pause and 
Continue (Pausar y continuar) y Stop (Detener), y el campo Message 
(Mensaje) estará activado y visible. Si la opción Pause and Continue (Pausar 
y continuar) está seleccionada, debe definir cuántos Seconds (Segundos) 
desea que la digitalización permanezca en pausa antes de que el escáner la 
reinicie.

Durante la digitalización: Cuando la opción Sort by Multifeed (Clasificar por 
alimentación múltiple) esté activada y el escáner detecte una alimentación 
múltiple:

• En los escáneres compatibles con la clasificación física, la página se 
enviará a la bandeja de destino definida para la clasificación física y la 
digitalización continuará. 

• En la clasificación manual con el valor Pause and Continue (Pausar 
y continuar) en el campo Destination (Destino), la digitalización se 
detendrá y el mensaje configurado se mostrará durante la cantidad de 
segundos establecida; luego, se cerrará y la digitalización se reanudará.

• En la clasificación manual con el valor Stop (Detener) en el campo 
Destination (Destino), la digitalización se detendrá y el mensaje 
configurado se mostrará. Los botones de opción que se mostrarán son 
Continue scanning (Continuar digitalización) o Stop (Detener).
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By Size (Por tamaño) En el panel izquierdo de la pestaña Capture (Captura), seleccione Sort > 
By Size (Clasificar > Por tamaño). A fin de activar esta opción, seleccione el 
botón de opción Sort by Size if (Clasificar por tamaño si) y elija Add (Agregar) 
para configurar reglas de tamaño. En esta pantalla, cada fila de la tabla 
muestra a qué tamaño de página se aplica esa regla y dónde se enviará la 
página (en el caso de la clasificación física) o el mensaje que se mostrará y la 
acción que realizará el escáner (en el caso de la clasificación manual). 

Add (Agregar): muestra el cuadro de diálogo Add Size (Agregar tamaño) para 
permitir la definición de una regla de clasificación de tamaño. 

• Dimension (Dimensión): seleccione Length (Longitud) o Width 
(Anchura) si están disponibles. La opción para clasificar por Length 
(Longitud) es compatible con los escáneres que admiten clasificación 
física (p. ej., el escáner i5x50S).

• Comparison (Comparación): Less than (Menor que), Greater than 
(Mayor que) o Between (Entre). 

• Valor (Value): introduzca el valor en mm/in que activará la clasificación 
de la página. 
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• Destination (Destino), Message (Mensaje) y Seconds (Segundos): 
si el escáner es compatible con la clasificación física (p. ej., el escáner 
Kodak i5x50S), el campo Destination (Destino) enumera las bandejas 
admitidas por el escáner y el campo Message (Mensaje) está oculto. 
Si el escáner no es compatible con la digitalización física, el menú 
desplegable Destination (Destino) contendrá las opciones Pause and 
Continue (Pausar y continuar) y Stop (Detener), y el campo Message 
(Mensaje) estará activado y visible. Si la opción Pause and Continue 
(Pausar y continuar) está seleccionada, debe definir cuántos Seconds 
(Segundos) desea que la digitalización permanezca en pausa antes de 
que el escáner la reinicie.

• OK (Aceptar): permite añadir una regla y cerrar el cuadro de diálogo 
Add Size (Agregar tamaño).

• Cancel (Cancelar): permite cerrar el cuadro de diálogo Add Size 
(Agregar tamaño) sin añadir ninguna regla.

NOTA: En los escáneres compatibles con la digitalización física, es 
posible definir hasta dos reglas de tamaño de clasificación. 

Edit (Editar): abre la regla que desea editar en el cuadro de diálogo Add Size 
(Agregar tamaño).

Delete (Eliminar): elimina la regla seleccionada.

Move Up / Move Down (Desplazar hacia arriba/Desplazar hacia abajo): 
desplaza la regla seleccionada hacia arriba o hacia abajo en la lista. El orden 
es importante, pues se aplica la primera regla que se cumple. 

Durante la digitalización: cuando la opción Sort by Size (Clasificar por 
tamaño) esté activada y se cumpla una regla de tamaño, se aplicará la acción 
que aparece a continuación. Las páginas siguientes se evaluarán según las 
reglas de clasificación:

• En los escáneres compatibles con la clasificación física, la página se 
enviará a la bandeja Destination (Destino) definida para la clasificación 
física. La digitalización continuará. 

• En la clasificación manual con el valor Pause and Continue (Pausar 
y continuar) en el campo Destination (Destino), la digitalización se 
detendrá y el mensaje configurado se mostrará durante la cantidad de 
segundos establecida; luego, se cerrará y la digitalización se reanudará.

• En la clasificación manual con el valor Stop (Detener) en el campo 
Destination (Destino), la digitalización se detendrá y el mensaje 
configurado se mostrará. Los botones de opción que se mostrarán son 
Continue scanning (Continuar digitalización) o Stop (Detener).
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By Patch Code (Por código de 
parche)

En el panel izquierdo de la pestaña Capture (Captura), seleccione Sort > By 
Patch Code (Clasificar > Por código de parche). Para activar esta opción, 
seleccione Sort by Patch Code if (Clasificar por código de parche si). 
Seleccione Add (Agregar) para configurar reglas de código de parche. Las 
reglas de clasificación definen cómo tratar las páginas con códigos de parche. 
En esta pantalla, cada fila de la tabla muestra a qué código de parche se 
aplica esa regla, si se conserva la imagen del código de parche y dónde se 
enviará el código de parche (en el caso de la clasificación física) o el mensaje 
que se mostrará y la acción que realizará el escáner (en el caso de la 
clasificación manual). 

Add (Agregar): abre el cuadro de diálogo Add Patch Code (Agregar código 
de parche). 

• Código de parche (Código de parche): En el caso de los escáneres 
compatibles con la clasificación física, el menú desplegable Patch Code 
(Código de parche) contiene las opciones All (Todos), T, 1, 2, 3, 4 o 
Toggle (Alternar), 6, 10, 11, 12, 13, 14 y 15. En los escáneres que no 
son compatibles con la clasificación física, el menú desplegable 
contiene 1, 2, 3 y T. 

• Delete patch image (Eliminar imagen de parche): marque esta opción 
si desea que la imagen del código de parche se elimine. 
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• Destination (Destino), Message (Mensaje) y Seconds (Segundos): 
si el escáner es compatible con la clasificación física (p. ej., el escáner 
Kodak i5x50S), el campo Destination (Destino) enumera las bandejas 
admitidas por el escáner y el campo Message (Mensaje) está oculto. 
En los escáneres que no son compatibles con la clasificación física, el 
menú desplegable Destination (Destino) contendrá Pause and 
Continue (Pausar y continuar) y Stop (Detener), y el campo Message 
(Mensaje) estará activado y visible. Si la opción Pause and Continue 
(Pausar y continuar) está seleccionada, debe definir cuántos Seconds 
(Segundos) desea que la digitalización permanezca en pausa antes de 
que el escáner la reinicie.

• Sheets after the patch to sort (Hojas posteriores al parche para 
clasificar): permite seleccionar qué hojas de papel inmediatamente 
posteriores a la hoja con parche se enviarán al destino establecido. 
Esta característica solo se activa para la clasificación física (p. ej., 
Kodak i5x50S).

- None (Ninguna).

- Número especificado: permite seleccionar un número exacto de 
hojas entre 1 y 99.

- All Until This Patch (Todas hasta este parche): indica que todas 
las hojas de papel se envían al destino hasta que se detecte el 
próximo parche de esta regla.

NOTA: Utilice esta opción si el documento incluye un número 
desconocido de páginas consecutivas que desea clasificar. 
En este caso, obtenga dos hojas de parche con este tipo de 
parche y, a continuación, coloque una hoja de parche antes de 
las páginas que desea clasificar y la otra hoja de parche 
después de dichas páginas.

- All Following (Todas las siguientes): indica que todas las páginas 
de papel que siguen a la hoja de parche se enviarán al destino 
hasta que termine la sesión de digitalización.

NOTAS:

• La clasificación en curso continuará hasta que termine. Esto implica 
que, si ha establecido una regla para clasificar un número específico de 
páginas y se detecta una segunda regla de clasificación antes de que 
dicho número de páginas se haya clasificado, se ignorará la segunda 
regla. 

• Cualquiera de los siguientes eventos detendrá la clasificación: Stop 
scanning, Multifeed that stops scanning o Jam that stops scanning 
(Detener digitalización, Alimentación múltiple que detiene la 
digitalización o Atasco que detiene la digitalización)

Destination (Destino): se trata de la ubicación de salida a la que se envía 
cada página a la que se aplica esta regla de clasificación de parches.

NOTA: Esta opción está disponible únicamente cuando la opción Sheets after 
the patch to sort (Hojas para organizar después del parche) no es 
None (Ninguna).

OK (Aceptar): permite añadir una regla y cerrar el cuadro de diálogo Add 
Patch Code (Agregar código de parche).

Cancel (Cancelar): permite cerrar el cuadro de diálogo Add Patch Code 
(Agregar código de parche) sin añadir ninguna regla.
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Edit (Editar): abre la regla que desea editar en el cuadro de diálogo Add 
Patch Code (Agregar código de parche).

Delete (Eliminar): elimina la regla seleccionada.

Move Up / Move Down (Desplazar hacia arriba/Desplazar hacia abajo): 
desplaza la regla seleccionada hacia arriba o hacia abajo en la lista. 
Se aplicará la primera regla que se cumpla. 

Durante la digitalización: cuando la opción Sort by Patch Code (Clasificar 
por código de parche) esté activada y se cumpla una regla de tamaño, 
se aplicará la acción que aparece a continuación. Las páginas siguientes se 
evaluarán según las reglas de clasificación:

• En los escáneres compatibles con la clasificación física, la página se 
enviará a la bandeja Destination (Destino) definida para la clasificación 
física. La digitalización continuará. 

• En la clasificación manual con el valor Pause and Continue (Pausar 
y continuar) en el campo Destination (Destino), la digitalización se 
detendrá y el mensaje configurado se mostrará durante la cantidad de 
segundos establecida; luego, se cerrará y la digitalización se reanudará.

• En la clasificación manual con el valor Stop (Detener) en el campo 
Destination (Destino), la digitalización se detendrá y el mensaje 
configurado se mostrará. Los botones de opción que se mostrarán son 
Continue scanning (Continuar digitalización) o Stop (Detener).

By Bar Code (Por código de 
barras)

En el panel izquierdo de la pestaña Capture (Captura), seleccione Sort > By 
Bar Code (Clasificar > Por código de barras). Las reglas de clasificación 
definen cómo tratar las páginas con códigos de barras. 

Si el escáner es compatible con la clasificación física (p. ej., el escáner Kodak 
i5x50S), verá el siguiente cuadro de diálogo. 

Seleccione Sort by bar code type (Clasificar por tipo de código de barras). 
Se mostrará la interfaz de usuario del controlador TWAIN, lo que le permitirá 
establecer las reglas de clasificación por código de barras. 
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Si añade reglas de código de barras y selecciona OK (Aceptar) en el cuadro 
de diálogo TWAIN, la opción Sort by bar code type permanecerá activada 
y el texto que aparece junto al botón Settings (Configuración) dirá (Settings 
are configured) (La configuración está establecida). Si no guarda una regla de 
código de barras en el cuadro de diálogo TWAIN, el botón de opción Off 
(Desactivado) se seleccionará automáticamente, ya que no se ha aplicado 
ninguna configuración. El botón Settings (Configuración) se activa 
únicamente cuando se han guardado una o más reglas de clasificación por 
código de barras. Utilice el botón Settings (Configuración) para volver a entrar 
a la pestaña Clasificar por código de barras del controlador TWAIN. 

La clasificación por código de barras que configure en la interfaz de usuario de 
TWAIN se almacenará en la definición de la configuración de trabajo para el 
tipo de escáner.

Si el escáner no es compatible con la clasificación física, el siguiente cuadro 
de diálogo le permitirá establecer reglas de clasificación por código de barras.

Seleccione Sort by Bar Code Zone if (Clasificar por zona de código de barras 
si) para establecer reglas de clasificación manual basadas en una o más 
zonas de código de barras predefinidas. Seleccione Add (Agregar) para 
configurar reglas de clasificación por código de barras. Las reglas se guardan 
en la definición de configuración de trabajo para los escáneres que no son 
compatibles con la clasificación. En este cuadro de diálogo, cada fila de la 
tabla muestra a qué zona de código de barras se aplica la regla, la condición 
de clasificación y el mensaje que se mostrará. 

Add (Agregar): abre el cuadro de diálogo Add Bar code zone (Agregar zona 
de código de barras). 
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• Bar code zone (Zona de código de barras): muestra una lista de las 
zonas de código de barras definidas en la configuración de código de 
barras.

• Comparison (Comparación): seleccione una opción de la lista. Las 
opciones para el campo Value (Valor) que aparece después cambian 
en función de la opción seleccionada en Comparison (Comparación):

• Destination (Destino): Pause and Continue (Pausar y continuar) 
o Stop (Detener). 

• Message (Mensaje): introduzca un mensaje para mostrar al operador 
del escáner (p. ej., “Retirar página de código de barras”). 

• Seconds (Segundos): si el campo Destination (Destino) tiene la 
opción Pause and Continue (Pausar y continuar), debe definir cuántos 
Seconds (Segundos) desea que la digitalización permanezca en pausa 
antes de que el escáner la reinicie.

• OK (Aceptar): permite añadir una regla y cerrar el cuadro de diálogo 
Add bar code zone (Agregar zona de código de barras).

• Cancel (Cancelar): permite cerrar el cuadro de diálogo Add bar code 
zone (Agregar zona de código de barras) sin añadir ninguna regla.

Edit (Editar): abre la regla que desea editar en el cuadro de diálogo Add bar 
code zone (Agregar zona de código de barras).

Delete (Eliminar): elimina la regla seleccionada.

Move Up / Move Down (Desplazar hacia arriba/Desplazar hacia abajo): 
desplaza la regla seleccionada hacia arriba o hacia abajo en la lista. 
Se aplicará la primera regla que se cumpla. 

Durante la digitalización: cuando la opción Sort by Bar Code (Clasificar por 
código de barras) esté activada y se cumpla una regla de código de barras, 
se aplicará la acción que aparece a continuación. Las páginas siguientes se 
evaluarán según las reglas de clasificación:

• En los escáneres compatibles con la clasificación física, la página se 
enviará a la bandeja Destination (Destino) definida para la clasificación 
física. La digitalización continuará. 

Opción de Comparison (Comparación) Entrada de Value (Valor) 
Value between (Valor entre)

Length between (Longitud entre)
Controles para introducir 

un número mínimo 
y máximo de valores 

o longitudes
Value contains (Valor que contiene)

Value does not contain (Valor que no contiene)
Value starting with (Valor que empieza con)

Value ending with (Valor que termina en)

Cuadro de texto

Length equal to (Longitud equivalente a)
Length not equal to (Longitud no equivalente a)

Length less than (Longitud menor que)
Length greater than (Longitud mayor que)

Value equal to (Valor equivalente a)
Value not equal to (Valor no equivalente a)

Value less than (Valor menor que)
Value greater than (Valor mayor que)

Control para una longitud 
o valor
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• En la clasificación manual con el valor Pause and Continue (Pausar 
y continuar) en el campo Destination (Destino), la digitalización se 
detendrá y el mensaje configurado se mostrará durante la cantidad de 
segundos establecida; luego, se cerrará y la digitalización se reanudará.

• En la clasificación manual con el valor Stop (Detener) en el campo 
Destination (Destino), la digitalización se detendrá y el mensaje 
configurado se mostrará. Los botones de opción que se mostrarán son 
Continue scanning (Continuar digitalización) o Stop (Detener).

By Document Index (Por 
índice de documento)

En el panel izquierdo de la pestaña Capture (Captura), seleccione Sort By 
Document Index (Clasificar por índice de documento). Seleccione Add 
(Agregar) para configurar reglas de clasificación por índice de documento. 
En esta pantalla, cada fila de la tabla muestra a qué índice se aplica esa regla, 
la comparación que se realizará, el valor que se utilizará para la comparación 
y dónde se enviará el documento (en el caso de la clasificación física) o el 
mensaje que se mostrará y la acción que realizará el escáner (en el caso de la 
clasificación manual). 

Add (Agregar): abre el cuadro de diálogo Add Document Index (Agregar 
índice de documento). 

• Index (Índice): muestra una lista de los campos de índice de 
documento definidos.
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• Comparison (Comparación): seleccione una opción de la lista. Las 
opciones para el campo Value (Valor) que aparece después cambian 
en función de la opción seleccionada en Comparison (Comparación):

• Destination (Destino), Message (Mensaje) y Seconds (Segundos): 
si el escáner es compatible con la clasificación física (p. ej., el escáner 
Kodak i5x50S), el campo Destination (Destino) enumera las bandejas 
admitidas por el escáner y el campo Message (Mensaje) está oculto. 
En los escáneres que no son compatibles con la clasificación física, 
el menú desplegable Destination (Destino) contendrá Pause and 
Continue (Pausar y continuar) y Stop (Detener), y el campo Message 
(Mensaje) estará activado y visible. Si la opción Pause and Continue 
(Pausar y continuar) está seleccionada, debe definir cuántos Seconds 
(Segundos) desea que la digitalización permanezca en pausa antes de 
que el escáner la reinicie.

• OK (Aceptar): permite añadir una regla y cerrar el cuadro de diálogo 
Add Document Index (Agregar índice de documento).

• Cancel (Cancelar): permite cerrar el cuadro de diálogo Add Document 
Index (Agregar índice de documento) sin añadir ninguna regla.

Edit (Editar): abre la regla que desea editar en el cuadro de diálogo Agregar 
índice de documento.

Delete (Eliminar): elimina la regla seleccionada.

Move Up / Move Down (Desplazar hacia arriba/Desplazar hacia abajo): 
desplaza la regla seleccionada hacia arriba o hacia abajo en la lista. 
Se aplicará la primera regla que se cumpla. 

Durante la digitalización: cuando la opción Sort by Document Index 
(Clasificar por índice de documento) está activada y se cumple una regla de 
índice de documento:

• En los escáneres compatibles con la clasificación física, la página con el 
índice de documento se enviará a la bandeja Destination (Destino) definida 
para la clasificación física. La digitalización continuará. 

• En la clasificación manual con el valor Pause and Continue (Pausar 
y continuar) en el campo Destination (Destino), la digitalización se 
detendrá y el mensaje configurado se mostrará durante la cantidad de 
segundos establecida; luego, se cerrará y se digitalizará la siguiente página.

• En la clasificación manual con el valor Stop (Detener) en el campo 
Destination (Destino), la digitalización se detendrá y el mensaje 
configurado se mostrará. Los botones de opción que se mostrarán son 
Continue scanning (Continuar digitalización) o Stop (Detener).

Opción de Comparison 
(Comparación)

Entrada de Value (Valor) 

Is Empty (Está vacío)
Has Value (Contiene un valor)

El campo Value (Valor) no se 
muestra

Is Between (Entre) Introducir un valor mínimo y máximo
Equal To (Equivalente a)

Not Equal To (No equivalente a)
Is Less Than (Menor que)

Is Greater Than (Mayor que)
Contains (Contiene)

Introducir un valor
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NOTA: Para el resto de las opciones de clasificación, la página “clasificada” 
(enviada a la bandeja de destino) es la única página que cumple con 
la regla. Para la clasificación por índice de documento, la regla de 
clasificación afecta al documento entero (según de define en Capture 
Pro). El documento puede contener una o varias páginas. Las páginas 
se envían al destino hasta que se reconoce un índice de documento 
que NO cumple con la regla. En este punto, las páginas digitalizadas 
vuelven a enviarse al destino normal.

Configuración de 
trabajo: Pestaña 
Índice

La indexación permite agregar funciones de procesamiento de datos a la 
digitalización, captura y producción de imágenes a nivel de documento y de 
lote.

Puede configurar fórmulas de indexación que comprueben la precisión de los 
metadatos contenidos en las zonas de OCR, de código de barras y de 
detección de marcas. Si la lectura de OCR, códigos de barra o detección de 
marcas interpreta los datos de forma errónea, la fórmula de indexación puede 
detectar errores y detener la digitalización. 

También puede configurar fórmulas de indexación que envíen las imágenes 
generadas a distintas ubicaciones en función de los metadatos.

• Para obtener información sobre la creación de formatos de entrada, 
consulte el apartado “Formatos de entrada”, que aparece más adelante en 
esta sección.

• Para obtener información sobre la creación de formatos de salida, consulte 
el apartado “Formatos de salida”, que aparece más adelante en esta 
sección.

• Para obtener información sobre la configuración de indexación de salida a 
SharePoint, consulte el apartado “Uso del asistente de configuración de 
indexación de SharePoint”, que aparece más adelante en esta sección.

La pestaña Index (Índice) del cuadro de diálogo Job Setup (Configuración de 
trabajo) permite definir un campo de índice a nivel de Batch (Lote) y de 
Document (Documento). Los campos de índice se configuran del mismo 
modo en el nivel de lote y de documento.
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A continuación, se muestran descripciones de los campos de la pestaña Index 
(Índice): 

Action when audit fails (Acción cuando falla la auditoría): seleccione la 
acción que quiere que realice el escáner cuando falle una auditoría. 

• Continue scanning (Continuar digitalización): continúa digitalizando 
incluso cuando la auditoría encuentra valores de índice no válidos. 

• Stop scanning (Detener digitalización): detiene la digitalización y entra 
automáticamente en modo de edición de índice cuando la auditoría 
encuentra valores de índice no válidos. 

Bypass audit during navigation (Omitir auditoría durante la navegación): 
cuando esta opción está seleccionada, se desactiva la función de auditoría al 
navegar por los documentos en el explorador de lotes. El término “auditoría” 
se refiere al sistema de verificación que comprueba que todos los valores de 
índice respetan el formato de entrada/salida.

El campo Indexes (Índices) muestra los valores configurados para cada 
índice: Name, Type, Default Value, Input Format, Output Format, Read-
only y Hidden (Nombre, Tipo, Valor predeterminado, Formato de entrada, 
Formato de salida, Solo lectura y Oculto). Puede editar, eliminar, subir o bajar 
un valor en la lista, o añadir un nuevo valor mediante el uso de los siguientes 
botones:

• Add (Agregar): abre el cuadro de diálogo Document Add Index Field 
(Documento: Agregar campo de índice) para crear un nuevo campo de 
índice en un documento o el cuadro de diálogo Batch Add Index Field 
(Lote: Agregar campo de índice) para crear un nuevo campo en un lote.

• Edit (Editar): abre el cuadro de diálogo Document Edit Index Field 
(Documento: Agregar campo de índice) para modificar un campo de índice 
en un documento o el cuadro de diálogo Batch Edit Index Field (Lote: Editar 
campo de índice) para modificar un campo de índice en un lote.

• Delete (Eliminar): elimina el campo de índice seleccionado. 
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• Move up (Desplazar hacia arriba): mueve el campo de índice seleccionado 
una posición hacia arriba en la lista de índices. 

• Move down (Desplazar hacia abajo): mueve el campo de índice 
seleccionado una posición hacia abajo en la lista de índices.

Adición de un campo de 
índice de documento

Para agregar un campo de índice de documento:

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). Se 
mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione un trabajo en la lista desplegable Job Name (Nombre del 
trabajo) y abra la pestaña Index (Índice).

3. Abra la pestaña Document (Documento).

4. Haga clic en Add (Agregar). Se mostrará el cuadro de diálogo Document - 
Add Index Field (Documento: Agregar campo de índice).

5. Introduzca un nombre del índice en el campo Label (Etiqueta). 

6. Introduzca cualquier nota o comentario en el campo Description 
(Descripción).

7. Seleccione Single Value (Valor único), Drop-down list (Lista 
desplegable), Drop-down list, multiple selection (Lista desplegable de 
selección múltiple) o una API de índice (si está disponible) en el campo 
Type (Tipo). Single Value (Valor único) permite introducir cualquier valor. 
Drop-down list (Lista desplegable) permite configurar una lista fija de 
valores entre los que elegir (p. ej., si quiere proporcionar una lista de 
países entre los que elegir). Drop-down list, multiple selection (Lista 
desplegable de selección múltiple) es similar a Drop-down list (Lista 
desplegable), excepto que permite seleccionar varios valores de la lista.

NOTA: Si ha creado su propia API de índice, aparecerá en la lista 
desplegable Type (Tipo). Cuando seleccione una API de índice, el 
botón Setup (Configuración) pasará a estar disponible. Haga clic 
en el botón Setup (Configuración) para realizar cualquier cambio 
en la configuración. 
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8. Si ha seleccionado Single Value (Valor único), puede activar la opción 
Read only (Solo lectura) para que este índice no permita escritura. 
De esta forma, se protege la información importante para que los usuarios 
no puedan eliminarla.

9. Active la opción Required (Obligatorio) para que este índice sea un 
elemento de comprobación imprescindible.

10. Active Double Entry (Entrada doble) para permitir una entrada de datos 
adicional del campo de índice. Para obtener más información, consulte la 
sección “Entrada doble de datos”, que aparece más adelante en este 
capítulo. El parámetro de Field Type (Tipo de campo) debe ser Single 
Value (Valor único) y no se pueden seleccionar las opciones Read only 
(Solo lectura) ni Hidden (Oculto). Es posible configurar la indexación 
automática en la primera entrada de datos para especificar una zona de 
OMR, código de barras u OCR. 

11. Si ha seleccionado Single Value (Valor único), puede activar la opción 
Hidden (Oculto) para ocultar este índice a los usuarios. De esta forma, se 
protege la información confidencial.

12. Introduzca un número para definir la longitud mínima válida del campo de 
índice en el campo Minimum index field length (Longitud de campo de 
índice mínima). 

13. Marque la casilla Check field during scanning (Comprobar campo 
durante la digitalización) si quiere que el sistema compruebe los campos 
de índice durante la digitalización de páginas. 

14. Introduzca un valor predeterminado en el campo Default value 
(Valor predeterminado) o haga clic en Setup (Configuración) para mostrar 
el cuadro de diálogo de configuración de valor predeterminado 
y establecer sus propios valores. 

NOTA: Si ha creado una zona de OCR, código de barras o detección de 
marcas, se mostrará en la lista de valores predefinidos (p. ej., 
BC_[nombredezona] u OCR_[nombredezona]). Para utilizar una 
zona de código de barras/OCR para un campo de índice, debe 
asignar el valor BC_[nombredezona]/OCR_[nombredezona] 
adecuado como valor predeterminado del campo de índice. Puede 
que necesite desplazarse al final de la lista de valores 
predefinidos para ver los campos de índice de código de barras/
OCR/detección de marcas.

Utilice el cuadro de diálogo de configuración de valor predeterminado para 
crear o revisar una fórmula del valor predeterminado del campo de índice. 
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• Seleccione un valor predefinido en la lista Predefined Values 
(Valores predefinidos). La fórmula de valor predeterminado (si la hay) 
se mostrará en la parte derecha del cuadro.

• Haga clic en Add Item (Agregar elemento).

NOTA: Delete Item (Eliminar elemento) elimina el último valor 
predefinido que se agregó a la fórmula de valor 
predeterminado; Delete Formula (Eliminar fórmula) elimina la 
fórmula de valor predeterminado completa. 

• Haga clic en OK (Aceptar) cuando haya terminado. La fórmula revisada 
se completará en el cuadro de texto de valor predeterminado. 

15. Introduzca el formato de entrada. Para obtener más información, consulte 
la sección “Formatos de entrada”, que aparece más adelante en este 
capítulo. 

16. Introduzca el formato de salida. Para obtener más información, consulte la 
sección “Formatos de salida”, que aparece más adelante en este capítulo. 

17. Si quiere configurar la opción Substitute Characters (Sustituir 
caracteres), haga clic en Setup (Configuración) para definir pares de 
caracteres para su sustitución automática. Se mostrará el cuadro de 
diálogo Substitute Characters Setup (Configuración de Sustituir 
caracteres). 

• Columna Original (Original): muestra un listado de los caracteres 
antiguos que se van a sustituir. Seleccione un carácter original de la lista 
desplegable en la parte inferior de la columna. Seleccione el carácter 
que desee reemplazar. Puede seleccionar <Space> (Espacio), 
<Linefeed> (Salto de línea) o <Tab> (Tabulador). Un carácter original 
solo puede aparecer una vez en la columna Original (Original).

• Columna Substitute (Sustituir): muestra una lista de los caracteres 
nuevos que se pueden utilizar. Seleccione un carácter de sustitución en 
la lista desplegable de la parte inferior de la columna. Seleccione 
<Space> (Espacio), <Linefeed> (Salto de línea), <Tab> (Tabulación) 
o <Replace> (Reemplazar). Un carácter de sustitución puede aparecer 
más de una vez en la columna Substitute (Sustituir).

• Add (Agregar): haga clic para agregar el par de caracteres original y de 
sustitución que haya seleccionado en las dos listas desplegables. Si solo 
ha seleccionado un carácter original, el software Capture Pro utilizará 
<Replace> (Reemplazar) como carácter de sustitución predeterminado. 
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• Delete (Eliminar): elimina el par de caracteres original y de sustitución 
resaltados de las columnas Original (Original) y Substitute (Sustituir).

18. Si quiere definir una lista de valores para el campo de índice, haga clic en 
Setup (Configuración), junto al cuadro List (Lista). Se mostrará el cuadro 
de diálogo List Setup (Configuración de lista). 

Puede optar por introducir manualmente los valores de la lista o importar 
una lista de valores desde una fuente de datos compatible con ODBC 
o desde una biblioteca de SharePoint.

Introducción manual

• Introduzca el valor que desee en el cuadro de texto de la columna 
Value (Valor).

• Introduzca una descripción del valor en el cuadro de texto de la 
columna Description (Descripción).

• Haga clic en Add (Agregar) para añadir el valor y la descripción del par 
que ha introducido en los dos campos de texto. Si no ha creado una 
descripción, la fila de la columna Description (Descripción) quedará en 
blanco. 

Importación de una lista

• Haga clic en Import List (Importar lista).

• Cree una nueva conexión a SharePoint u ODBC, o seleccione una 
conexión existente.

• Haga clic en Next (Siguiente).
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• Seleccione la columna que se utilizará para completar el campo Value 
(Valor) y seleccione la columna que se empleará para completar el 
campo Description (Descripción).

• Haga clic en Import (Importar). Se importarán todos los valores únicos 
y sus descripciones asociadas si se han especificado. Si ya hay un 
valor coincidente en la lista, el valor importado no lo sustituirá. 
Los valores importados se adjuntarán a la lista.

NOTA: Haga clic en Delete (Eliminar) si desea eliminar un valor 
o haga clic en Delete All (Eliminar todo) para eliminar todas 
las entradas de la lista.

• Seleccione la opción Allow any value (Permitir cualquier valor) si no 
quiere especificar límites para los valores de los índices.

• Seleccione una Indexing action (Acción de indexación) en la lista 
desplegable: Use value only, Use description only o Use value and 
description (Utilizar solo valor, Utilizar solo descripción o Utilizar valor 
y descripción).

• Haga clic en OK (Aceptar) cuando haya terminado y vuelva al cuadro 
de diálogo Document - Add Index Field (Documento: Agregar campo de 
índice).

19. Haga clic en OK (Aceptar) en el cuadro de diálogo Document - Add Index 
Field (Documento: Agregar campo de índice). La nueva información de 
índice de documento aparecerá en la tabla de la pestaña Document 
(Documento). 

NOTA: Para ordenar la tabla en orden ascendente o descendente, haga 
clic en el encabezado de columna correspondiente. Si hace clic en 
el encabezado de la columna Value (Valor), la tabla se ordenará 
por el contenido de la columna Value (Valor). Si hace clic en el 
encabezado de la columna Description (Descripción), la tabla se 
ordenará por los valores de la columna Description (Descripción).

20. Haga clic en OK (Aceptar) para guardar y salir del cuadro de diálogo Job 
Setup (Configuración de trabajo).

Edición de un campo de 
índice de documento

Para editar un campo de índice de documento:

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.
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2. Seleccione un trabajo en la lista desplegable Job Name (Nombre del 
trabajo) y abra la pestaña Index (Índice).

3. Abra la pestaña Document (Documento).

4. Seleccione el campo de índice.

5. Haga clic en Edit (Editar). Se mostrará el cuadro de diálogo Document - 
Edit Index Field (Documento: Editar campo de índice).

6. Cambie la información del cuadro de diálogo según desee y haga clic en 
OK (Aceptar). 

Adición de un campo de 
índice de lote

Para agregar un campo de índice de lote:

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione un trabajo en la lista desplegable Job Name (Nombre del 
trabajo) y abra la pestaña Index (Índice).

3. Abra la pestaña Batch (Lote). 
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4. Haga clic en Add (Agregar). Se mostrará el cuadro de diálogo Batch - Add 
Index Field (Lote: Agregar campo de índice).

5. Complete la información en el cuadro de diálogo y haga clic en OK 
(Aceptar). Para obtener descripciones detalladas de cada campo, consulte 
la sección “Adición de un campo de índice de documento”, que aparece 
anteriormente en este capítulo.

6. Haga clic en OK (Aceptar) para guardar y salir del cuadro de diálogo Job 
Setup (Configuración de trabajo).

Propiedades de PDF La pestaña PDF Properties (Propiedades de PDF) le permite especificar un 
valor para cada marcador de documento o asignar valores de índice a los 
metadatos de propiedades de PDF.

NOTA: Para que esta función se aplique de forma eficaz, asegúrese de 
seleccionar Group by Multi-Page (Agrupar por varias páginas) en 
cada Batch (Lote) en el cuadro de diálogo PDF Setup (Configuración 
de PDF). Consulte la sección “Opciones de configuración para Archivo 
(1) y Archivo (2)”, que aparece más adelante en este capítulo.
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Las propiedades del PDF Title (Título), Subject (Asunto), Author (Autor) 
y Keywords (Palabras clave) se pueden asignar a valores del sistema, 
índices de documento o índices de lote. Utilice el botón Setup (Configuración) 
en cada campo para mostrar un cuadro de diálogo en el que podrá definir la 
asignación. 

Para definir las opciones Title, Subject, Author o PDF Bookmark 
(Título, Asunto, Autor o Marcador de PDF):

1. Haga clic en Setup (Configurar) para visualizar el cuadro de diálogo 
Set PDF Bookmark Value (Configurar valor de marcador de PDF).

2. Seleccione el valore predefinido deseado en la lista y haga clic en 
Add Item (Agregar elemento).

3. Haga clic en OK (Aceptar) cuando haya terminado.
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Para definir Keywords (Palabras clave):

1. Haga clic en Setup (Configurar) para visualizar el cuadro de diálogo Set 
PDF Keyword Values (Configurar valores de palabras clave de PDF).

2. Para añadir elementos a la fórmula de palabra clave destacada 
actualmente, seleccione los valores predefinidos deseados en la lista 
y haga clic en Add Item (Agregar elemento).

3. Haga clic en Delete Item (Eliminar elemento) para eliminar el valor 
predefinido al final de la fórmula destacada.

4. A fin de crear una fórmula para una nueva palabra clave, seleccione los 
valores predefinidos deseados de la lista y haga clic en New Keyword 
(Nueva palabra clave). 

5. Haga clic en Delete Keyword (Eliminar palabra clave) para eliminar la 
fórmula de palabra clave destacada de la lista. 

6. Haga clic en OK (Aceptar) cuando haya terminado.

7. Haga clic en Cancel (Cancelar) para anular los cambios y cerrar el cuadro 
de diálogo. 

Entrada doble de datos Double Entry (Entrada doble de datos) permite que dos operadores de 
indexación indexen los documentos de forma independiente para mejorar la 
precisión de los datos de índice.

Una vez finalizada la digitalización, el operador selecciona Index1 (Índice1) en 
el menú Index (Índice) a fin de indicar que el lote ya está listo para la primera 
operación de indexación.

El primer operador de indexación introduce los valores de índice del lote y de 
cada documento. Una vez finalizada la operación, el operador de indexación 
selecciona Index2 (Índice2) en el menú Index (Índice) a fin de indicar que el 
lote ya está listo para la segunda operación de indexación.

Configuración de entrada 
doble

Para utilizar la función Double Entry (Entrada doble), uno o más campos de 
índice de lote o documento deben configurarse como Double Entry (Entrada 
doble).

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione un trabajo en la lista desplegable Job Name (Nombre del 
trabajo) y abra la pestaña Index (Índice).

3. Abra la pestaña Batch (Lote) o Document (Documento).
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4. Seleccione el campo de índice que desee en la opción Double Entry 
(Entrada doble) y haga clic en Edit (Editar). Se mostrará el cuadro de 
diálogo Batch - Edit Index Field (Lote: Editar campo de índice) o Document 
- Edit Index Field (Documento: Editar campo de índice)

5. Active la casilla de verificación Double Entry (Entrada doble).

NOTAS:

• El campo Type (Tipo) debe ser Single Value (Valor único).

• El campo de índice no puede ser de solo lectura, por lo que la opción 
Read-only (Solo lectura) se desactiva.

• El campo de índice no puede estar oculto, por lo que la opción Hidden 
(Oculto) se desactiva.

• La única manera de establecer un valor predeterminado para un campo de 
entrada doble de datos consiste en utilizar un campo de índice 
automatizado, como un valor de código de barras u OCR. Si desea que se 
aplique un comportamiento de este tipo, seleccione la zona de OCR o la 
zona de código de barras en el cuadro de diálogo Default Value Setup 
(Configuración de valor predeterminado).

• Si alguna de las configuraciones anteriores no es correcta, se desactivará la 
casilla de verificación Double Entry (Entrada doble).

Funcionamiento de entrada 
doble

Los trabajos que tienen uno o más lotes o campos de índice de documentos 
configurados para la entrada doble de datos se utilizan del mismo modo que 
otros trabajos para digitalizar documentos.

Cuando se completa la digitalización del documento y el lote está preparado 
para la indexación, el operador selecciona Index > Index1 (Indexación > 
Índice1). Esto cambia el estado del lote de Available (Disponible) a Index1 
(Índice1), lo que indica que el lote está listo para la entrada del primer conjunto 
de valores de índice.
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Cuando el operador del primer índice introduzca los valores de índice de todos 
los documentos, seleccionará Index > Index2 (Índice > Índice2). Esto cambia 
el estado del lote de Index1 (Índice1) a Index2 (Índice2), lo que indica que el 
lote está ahora listo para la entrada del segundo conjunto de valores de 
índice.

El operador del segundo índice no verá los valores introducidos por el 
operador del primer índice.

Si el valor introducido por el operador del segundo índice coincide con el 
primer valor, no será necesaria ninguna acción y continuará la indexación.

Si el primer y segundo valor no coinciden, aparecerá el cuadro de diálogo 
Resolución de entrada y el operador seleccionará la entrada correcta.

NOTAS:

• Si el operador de digitalización también introduce el primer conjunto de 
valores de índice, tendrá que seleccionar Index > Index1 (Índice > Índice1) 
inmediatamente después de seleccionar Index > Index2 (Índice > Índice2) 
cuando se complete la digitalización y la operación del primer índice.

• La comparación de los valores de Index1 (Índice1) e Index2 (Índice2) 
distingue entre mayúsculas y minúsculas. Por ejemplo “MAYÚSCULAS” no 
coincide con “Mayúsculas”. Los ceros iniciales también son importantes. 
Por ejemplo, el valor 123 no coincide con 0123.

• Antes de guardar el valor, se eliminarán los espacios finales e iniciales de 
todos los campos de índice de entrada doble. 

Por ejemplo, si se introduce el valor “    Envío     ”, el valor se guarda como 
“Envío”. Esto significa que, si el Index1 (Índice1) se introduce como “     
Envío” e Index2 (Índice2) se introduce como “Envío     ”, los valores 
coincidirán.
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Resolución de entrada El cuadro de diálogo Entry Resolution (Resolución de entrada) se muestra 
cuando el valor del segundo índice coincide con el valor del primer índice.

El operador del índice tiene las siguientes opciones:

• Elegir la entrada realizada por el operador del primer índice al seleccionar 
Entry1 (Entrada1).

• Elegir su entrada al seleccionar Entry2 (Entrada2).

• Introducir un valor nuevo en el campo New Entry (Nueva entrada) si 
ninguna entrada es correcta.

• Cancelar y cerrar el cuadro de diálogo Entry Resolution (Resolución de 
entrada) si no desea realizar ninguna elección. Si decide no resolver el 
valor de índice que no coincide en uno o más campos de índice 
obligatorios, aparecerá el siguiente mensaje si se intenta generar el lote: 
Uno o varios campos de índice requieren entrada doble. No puede 
generar el lote en este momento. ¿Desea ingresar al modo Índice? 

Si ninguno de los campos de entrada doble es obligatorio, el cuadro de 
diálogo Entry Resolution (Resolución de entrada) se mostrará durante la 
generación. Todos los campos de índice de entrada doble con entradas 
no coincidentes se deben resolver antes de la generación.

NOTAS:

• Si un campo de entrada doble no es un campo obligatorio, una o ambas 
entradas de índice se pueden dejar en blanco y no se mostrará el cuadro de 
diálogo Entry Resolution (Resolución de entrada); no se producirán errores 
al generar.
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• Si se introducen ambos valores de entrada doble y no coinciden, el 
operador deber realizar una selección en el cuadro de diálogo Entry 
Resolution (Resolución de entrada) antes de la generación.

• Un campo de índice habilitado para entrada doble no se puede utilizar para 
realizar una búsqueda en la base de datos ni puede ser un campo 
verificado o rellenado por una búsqueda en la base de datos.

Formatos de entrada El campo Input Format (Formato de entrada) es una expresión de texto 
utilizada para comprobar una entrada de usuario en un campo de índice 
determinado. Su propósito es evitar que se introduzcan datos incorrectos en 
los campos de índice. La sintaxis del formato de entrada puede ser uno de los 
siguientes formatos o una combinación de ellos:
• Formatos de texto
• Formatos de número
• Formatos de fecha y hora 
• Formatos de cadena fija

Formatos de texto de 
entrada

#
#<longitudmáx>
#<longitudmín, longitudmáx>

#: se utiliza para representar un solo carácter del tipo especificado. # puede 
ser uno de los siguientes tipos de caracteres:

9: el conjunto válido de caracteres de entrada incluye “0”, “1”, ..., “9”.
Z: el conjunto válido de caracteres de entrada incluye “A”, “B”, ..., “Z”.
z: el conjunto válido de caracteres de entrada incluye “a”, “b”, ..., “z”.
A: el conjunto válido de caracteres de entrada incluye todos los caracteres 

de tipo Z y z.
C: el conjunto válido de caracteres de entrada incluye todos los caracteres 

de tipo Z y 9.
c: el conjunto válido de caracteres de entrada incluye todos los caracteres 

de tipo z y 9.
X: el conjunto válido de caracteres de entrada incluye todos los caracteres 

de tipo Z, z y 9.
?: el conjunto válido de caracteres de entrada incluye todos los caracteres.

Ejemplos
999999
Descripción: 6 caracteres numéricos.

Ejemplos de entrada válida
123456
888888

Ejemplos de entrada no válida
ABCDEF tipo de carácter erróneo
1234567 demasiado largo
12345 demasiado corto

ZZZ999?
Descripción: 7 caracteres, de los cuales los tres primeros son letras 
mayúsculas; los tres siguientes, números; y los tres últimos, cualquier carácter.
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Ejemplos de entrada válida
BAT001%
BOX123a

Ejemplos de entrada no válida
LOT12b3 el sexto carácter debe ser numérico
Lot123a el segundo y el tercer carácter deben ser caracteres alfabéticos 

en mayúscula
LOT12345 demasiado largo
#<longitudmáx>: se utiliza para representar un valor textual de longitud 
variable (con longitud máxima, pero no mínima).

• Si longitudmáx es 0, no habrá limitación a la longitud del valor de entrada.

• Si longitudmáx es mayor que 0, la longitud del valor de entrada debe ser 
inferior o igual a longitudmáx.

El valor de longitudmáx no puede ser inferior a 0.

Ejemplos
A<6>
Descripción: una cadena que puede contener, a lo sumo, 6 caracteres 
alfabéticos.

Ejemplos de entrada válida
A
ABCDEF

Ejemplos de entrada no válida
ABC123 los tres últimos caracteres deben ser caracteres alfabéticos
ABCDEFG demasiado largo

?<0>
Descripción: cualquier valor textual.

#<longitudmín, longitudmáx>: se utiliza para representar un valor de 
entrada de longitud fija o variable que puede tener una longitud máxima 
o mínima.

• Si longitudmín es 0, la cadena de entrada puede estar vacía.

• Si longitudmín es mayor que 0, la longitud del valor de entrada debe ser 
superior o equivalente a longitudmín.

• El valor de longitudmín no puede ser inferior a 0.

• Si longitudmín es igual que longitudmáx, el valor de entrada debe tener el 
número de caracteres especificados.

Ejemplos
X<2,10>
Descripción: un valor de entrada que contiene de 2 a 10 caracteres numéricos 
o alfabéticos, en mayúsculas o minúsculas.

Ejemplos de entrada válida
Batch0001
1234abcABC
A1
Ejemplos de entrada no válida
Batch-001 el carácter “-” no es un carácter “X” válido
A demasiado corto
1234abcdABCD demasiado largo
AB Inc el carácter de espacio no es un carácter “X” válido
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?<3,0>
Descripción: una cadena que contiene, como mínimo, 3 caracteres de 
cualquier tipo.

Ejemplos de entrada válida
ABC
+%=
ABC Company
sanchez@ABC.com
Ejemplos de entrada no válida
A1 demasiado corto

A<4,4>
Descripción: una cadena de exactamente 4 caracteres alfabéticos. El mismo 
formato que AAAA.

9<0,3>
Descripción: una cadena de, a lo sumo, 3 caracteres numéricos. La cadena 
puede estar vacía. 

A<3,2>
Descripción: formato de entrada no válido; longitudmáx debe ser superior o 
igual a longitudmín si longitudmáx es mayor que 0.

Formatos de número de 
entrada

#
#(mín, máx)
#(mín, máx]
#[mín, máx}
#[mín, máx]

#: se utiliza para representar uno de los siguientes tipos de números:

i: número entero que puede ser positivo o negativo, y que no tiene decimales.
n: cualquier número, positivo o negativo, y que puede tener decimales.

El rango de valores o la precisión del número quedan limitados en función del 
sistema operativo.

El rango de números válidos es normalmente:

i: de -2 147 483 648 a 2 147 483 648
n: 1,7 E ±308 (15 dígitos)
Los valores mínimo y máximo definen el rango del valor del número.
El valor mínimo y máximo debe ser coherente con el tipo de número. Por 
ejemplo, si el tipo de número es i, el valor tanto mínimo como máximo deben 
ser números enteros válidos.
El carácter * se puede utilizar en el lugar de mínimo o máximo, y representa 
un valor infinito o sin límite.
El valor máximo debe ser mayor o igual que el valor mínimo.
(: el valor de entrada debe ser mayor que el mínimo.
): el valor de entrada debe ser menor que el máximo.
[: el valor de entrada debe ser mayor o igual que el mínimo.
]: El valor de entrada debe ser menor o igual que el máximo.

Ejemplos
i
Descripción: cualquier número entero.

Ejemplos de entrada válida
123
-456
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Ejemplos de entrada no válida
123,456 debe ser un número entero. No se permiten valores decimales
-123, los valores enteros no pueden tener un separador decimal

n 
Descripción: cualquier número entero o decimal.

Ejemplos de entrada válida
123
123,456
-123.

#(mín, máx): se utiliza para especificar un valor que es mayor que el mínimo 
y menor que el máximo.

Ejemplos
i(-100, 100)
Descripción: cualquier número entero mayor que –100 y menor que 100.

Ejemplos de entrada válida
–99
0
99

Ejemplos de entrada no válida
–100 demasiado pequeño, debe ser mayor que –100
–99,9 debe ser un número entero (no se permiten valores 

decimales)
100 demasiado grande, debe ser menor que 100

#(mín, máx]: se utiliza para especificar un valor que es mayor que el mínimo 
y menor o igual que el máximo.

Ejemplos
i(-100, 100]
Descripción: cualquier número entero mayor que –100 y menor o igual que 
100

Ejemplos de entrada válida
–99
0
100

Ejemplos de entrada no válida
–100 demasiado pequeño, debe ser mayor que –100
–99,9 debe ser un número entero (no se permiten valores decimales)
101 demasiado grande, debe ser menor o igual que 100

#[mín, máx): se utiliza para especificar un valor que es mayor o igual que el 
mínimo y menor que el máximo.

Ejemplos
n[-100, 100)
Descripción: cualquier número mayor o igual que –100 y menor que 100.

Ejemplos de entrada válida
–100
-99.9
99,9999
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Ejemplos de entrada no válida
-100.1 demasiado pequeño, debe ser mayor que –100
100 demasiado grande, debe ser menor que 100

#[mín, máx]: se utiliza para especificar un valor que es mayor o igual que el 
mínimo y menor o igual que el máximo.

Ejemplos
n[-100, 100]
Descripción: cualquier número entero mayor o igual que –100 y menor 
o igual que 100.

Ejemplos de entrada válida
–100
0
100

Ejemplos de entrada no válida
–100,1 demasiado pequeño, debe ser mayor o igual que –100
100,001 demasiado grande, debe ser menor o igual que 100

i[100, *)
Descripción: cualquier número entero mayor o igual que 100.

Ejemplos de entrada válida
100
1000

Ejemplos de entrada no válida
99 demasiado pequeño, debe ser mayor o igual que 100
100,5 los valores enteros no pueden tener un separador decimal

i(-1,0, +1,0)
Descripción: no es un formato de entrada válido porque el mínimo y el máximo 
no son un número entero, como especifica “i”.

n(+1,0, -1,0)
Descripción: no es un formato de entrada válido porque el máximo es inferior 
al mínimo.

Formatos de fecha y 
hora de entrada

T<formatodefechayhora> 

La expresión formatodefechayhora es una expresión de cadena de texto del 
valor fecha/hora. La sintaxis puede ser uno de los siguientes elementos o una 
combinación de ellos:

yyyy año (1000-9999)
yy año (00-99, en el caso de 00-79 significa 2000-2079 y en el de 

80-99 significa 1980-1999)
MM mes (01-12)
dd día del mes (00-31, validar fecha cuando el año y el mes estén 

disponibles)
DDD día del año (001-366, validar fecha cuando el año y el mes estén 

disponibles)
HH hora (00-23)
hh hora (01-12)
mm minuto (00-59)
ss segundo (00-59)



A-61993_es  Marzo de 2022 53

Los siguientes elementos de fecha/hora no pueden repetirse en 
formatodefechayhora. Por ejemplo, si ha seleccionado yyyy para el formato 
del año, no puede usar yy ni otro yyyy en el formato de fecha. Esta limitación 
afecta a:
yyyy e yy
dd y DDD
HH y hh
HH, TT, T, tt y t

Ejemplos

T<yyyyMMdd>
Descripción: fecha completa.

Ejemplos de entrada válida
20051025
19000101

Ejemplos de entrada no válida
2005/10/25 carácter no esperado /
20051032 fecha no válida
20050229 fecha no válida (porque el año 2005 no fue un año bisiesto)
00990101 la fecha es anterior a 1000

T<MMdd>
Descripción: fecha sin año especificado.

Ejemplos de entrada válida
1201
1231
0229 

Ejemplos de entrada no válida
0001 mes no válido
0230 fecha no válida para febrero, aunque el año sea bisiesto
ABCDEF texto no válido

T<HH":"mm":"ss>
Descripción: hora que utiliza los dos puntos (:) como separador. 

Ejemplos de entrada válida
23:59:59
00:00:00

Ejemplos de entrada no válida
99:59:00 hora no válida
120000 no hay separador

T<hhmmsst>
Descripción: hora completa.

TT A. M./P. M.
T A/P
tt a. m./p. m.
t a/p
“texto” texto es una cadena de texto fijo.
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Ejemplos de entrada válida
010000a
120000p

Ejemplos de entrada no válida
010000A A debe estar en minúscula
000000a hora no válida
1355101 hora no válida; debe estar entre 00-12. 

T<HHmmssTT>
Descripción: no es un formato de entrada válido, puesto que HH representa de 
las 00 a las 23 horas y TT representa AM/PM, que no es válido en la cadena 
de 24 horas.

T<yyyyMMyyyy>
Descripción: se trata de un formato de entrada no válido porque aaaa se ha 
usado más de una vez en formato de fecha.

Formatos de cadena fija 
de entrada

“texto”
texto es cualquier cadena de texto. Puesto que el inicio y el final de la cadena 
de texto están definidos por el carácter “ (comillas dobles), no está permitido 
utilizar este carácter en la cadena de texto. El formato de cadena de texto se 
combina normalmente con otros formatos de entrada.

Ejemplos
999”-”99”-”999
Descripción: cadena fija (para definir un número de seguridad social de los 
EE. UU.). 

"ID"
Descripción: cadena fija.

Ejemplos de entrada válida
ID

Ejemplos de entrada no válida
XX no coincide con el formato del texto La entrada debe ser: ID

“Texto”ABC””
Descripción: este es un formato de entrada no válido porque incluye dos 
caracteres “ adicionales en el formato.

Formatos de entrada de 
combinación

Un formato de entrada puede componerse de varios formatos que se utilizan 
en combinación. Si desea utilizar varios formatos para definir un formato de 
entrada, solo tiene que conectar las expresiones de formato entre sí con o sin 
un espacio en blanco.

Ninguna expresión de formato puede seguir a un formato de longitud variable. 
Por ejemplo: A<1,0>”-Comentario” no es válido, ya que A<1,0> puede tener 
una longitud diferente. El formato “Comentario-“A<1,0> es válido, ya que el 
formato de longitud variable se encuentra al final del formato de entrada de la 
combinación.

A continuación, hay formatos de combinación válidos y no válidos.

Ejemplos
"ID"999999
Descripción: formatos combinados "ID" y 999999.

Ejemplos de entrada válida
ID123456
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Ejemplos de entrada no válida
IDabcdef las letras abcdef deben ser números

id123456 las dos primeras letras, id, no coinciden con el formato, 
que es ID

“FECHA”T<yyyyMMdd>
Descripción: formatos combinados “FECHA” y T<yyyyMMdd>..

T<“FECHA”yyyyMMdd> es equivalente al formato anterior.

Ejemplo de entrada válida

FECHA20051025

Ejemplos de entrada no válida
n?<0>
Descripción: no es un formato de entrada válido para el número especificado, 
pues n es una longitud variable y no puede ir seguido de formato adicional.

A<2,3>”XX”
Descripción: no es un formato de entrada válido porque A<2,3> especifica una 
longitud variable y no puede ir seguido de ningún formato adicional.

A<3,3>”XX”
Descripción: formatos combinados A<3,3> y “XX”.

Ejemplo de entrada válida

XYZXX

Ejemplos de entrada no válida
XXXXXX X inesperada al final de la cadena de texto

20051025 el texto FECHA debe preceder a la fecha

FECHA20051032 octubre no tiene 32 días

XXXXXXX demasiado largo. X adicional al final de la cadena

Especificación de 
valor predeterminado 
de índice

La expresión de valor predeterminado es una expresión de texto para 
establecer el valor predeterminado de un campo de índice determinado. 
En la expresión de valor predeterminado, es necesario definir el valor 
predeterminado usando una o más etiquetas predeterminadas (es decir, valor 
OCR/código de barras/detección de marca, sistema) o una cadena fija. 
Puede definir también varias opciones del valor predeterminado conectando 
etiquetas con la palabra clave OR. 
Etiquetas
<nombredeetiqueta>
<nombredeetiqueta:expresióndetransformación> 
nombredeetiqueta es una expresión de datos de la zona de código de 
barras, OCR o detección de marcas predeterminada por el sistema. Las 
expresiones de datos incluyen la fecha, la hora, el nombre e ID de la estación, 
el nombre de usuario y del trabajo, ruta del grupo de trabajo y lote, el ID de 
página y documento, y el último valor.
expresióndetransformación se utiliza para transformar el formato del valor 
OCR/código de barras o del sistema. Por ejemplo, si la fecha se expresa 
como MMddyy, la expresión de transformación puede cambiar el formato 
a MM/dd/yyyy. Consulte la siguiente sección para obtener una descripción de 
las expresiones de transformación.
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Active Double Entry (Entrada doble) para permitir una entrada de datos 
adicional del campo de índice. Para obtener más información, consulte la 
sección “Entrada doble de datos”, que aparece más adelante en este capítulo. 
No se puede introducir un valor predeterminado al utilizar Double Data Entry 
(Entrada doble de datos). Field Type (Tipo de campo) debe ser Single Value 
(Valor único) y no se pueden seleccionar las opciones Read only (Solo lectura) 
ni Hidden (Oculto).

NOTAS:

• El campo Type (Tipo) debe ser Single Value (Valor único).
• El campo de índice no puede ser de solo lectura, por lo que la opción 

Read-only (Solo lectura) se desactiva.
• El campo de índice no puede estar oculto, por lo que la opción Hidden 

(Oculto) se desactiva.
• El valor predeterminado debe quedar en blanco, por lo que la opción 

Default Value Setup (Configuración de valor predeterminado) estará 
desactivada.

• Si alguna de las configuraciones anteriores no es correcta, se desactivará la 
casilla de verificación Double Entry (Entrada doble).

Formatos de cadena fija “texto”
texto es una cadena de texto fijo. No está permitido utilizar el carácter 
delimitador de cadenas " (comillas dobles) en el formato. El formato de cadena 
de texto fijo se combina normalmente con otros formatos. 

Uso de varias etiquetas Un valor predeterminado puede incluir más de una expresión de etiqueta 
combinada. Por ejemplo, puede que desee que el valor predeterminado 
incluya la fecha, la hora y la ID de estación separados por guiones. Para ello, 
concaténelos.

Por ejemplo:
<sys.date:ddMMaa>"-"<sys.time:hhmmss> "-“ <sys.stationid>

Uso de la palabra 
clave OR

La palabra clave OR puede incluirse también en la expresión de valor 
predeterminado. Esta puede resultar útil cuando haya un valor que no esté 
siempre presente. Puede que desee establecer el valor predeterminado al 
valor de un código de barras que aparece en el documento.

Por ejemplo:
 <barcode.UPI ID Number>

Si no se encuentra un código de barras en el documento, el campo de índice 
estará vacío. La palabra clave OR puede usarse para proporcionar un valor 
alternativo.

Por ejemplo:
<barcode.UPI ID Number> OR “Código de barras no encontrado en el 
documento:” <app.documentid>

Puede utilizarse OR en todas las expresiones en las que sea necesario. 

Opción de valor predeterminado 1 OR Opción de valor predeterminado 
2 OR... OR Opción de valor predeterminado n
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El sistema comprobará el número de la opción de valor predeterminado de 
uno en uno y de izquierda a derecha, y utilizará el primer dato válido para 
iniciar los datos del índice.
Etiquetas disponibles: a continuación se muestran las etiquetas disponibles 
de valores predeterminados:

NOTA: Las zonas de código de barras/OCR/detección de marcas se 
mostrarán en la parte inferior de la lista de valores predeterminados.

Valor predeterminado 
con ÚLTIMOVALOR

Cuando últimovalor se selecciona como valor predeterminado, el software 
Capture Pro utiliza de forma automática el último valor asignado para un 
campo de índice del documento anterior (en el caso de índices de documento) 
o del lote anterior (en el caso de índices de lote) cada vez que se crea un 
nuevo documento o lote. Esto resulta útil, por ejemplo, en una aplicación de 
trabajo pendiente, cuando se digitalizan carpetas de documentos con la 
misma fecha. Cuando se inicia la digitalización en un nuevo lote y no se ha 
asignado ningún valor de índice, escriba la fecha una vez y se mantendrá 
igual para todos los documentos hasta que la modifique. 

últimovalor también es de utilidad cuando se realiza la indexación de códigos 
de barras, pero algunos documentos no contienen uno. Por ejemplo, una 
expresión de valor predeterminada:

<códigobarras.ID Paciente> OR <app.lastvalue>

significa que, al digitalizar un documento nuevo, se asigna el valor del campo 
de índice al valor de la zona del código de barras “ID de paciente” 
<códigobarras.ID Paciente>. No obstante, si el documento no dispone de 
código de barras, se asigna el campo de índice al valor del documento 
anterior OR <app.lastvalue>.

Expresiones de 
transformación

Una expresión de transformación es una expresión de texto para dar formato 
o transformar los datos de un campo determinado en un valor de salida 
o predeterminado. Las expresiones de transformación se utilizan para definir 
el formato de salida y los valores predeterminados de un campo de índice. 

Especificación de valor predeterminado: cuando se crea un nuevo lote 
o documento, el campo de índice se completa con un valor basado en la 
especificación del valor predeterminado. La especificación del valor 
predeterminado se introduce en la pestaña Index (Índice) y adquiere la forma 
de <nombredeetiqueta> o <nombredeetiqueta:expresióndetransformación>. 
La expresión de transformación se describe a continuación.
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Ejemplos: 
<sys.date:ddMMaa>
<sys.stationid:[1,5]>

Formato de salida: al generar el lote, se les volverá a dar formato a los datos 
del índice del lote y los documentos del lote según el formato de salida. Por 
ejemplo, un índice de fecha con el valor MMddyy puede cambiar al formato: 
MM/dd/yyyy.

El formato de salida se introduce en la pestaña Index (Índice) y adquiere la 
forma: 
expresión de transformación.

Ejemplos:
ddMMyy
[1, 5]

La sintaxis puede ser uno de los siguientes formatos o una combinación de 
ellos:

• Formatos de texto
• Formatos de número
• Formatos de fecha y hora
• Formatos de cadena fija

Formatos de texto de 
transformación

[inicio]
[inicio, fin]
[índice, ‘delimitador’]
[inicio, long]

Estos formatos se utilizan para extraer una subcadena del valor de índice 
original.

[inicio]: se utiliza para extraer una subcadena que comience en la posición de 
inicio hasta el fin del valor original.

• Si inicio es un número positivo, la posición de inicio se contará a partir del 
principio del valor original.

• Si inicio es un número negativo, la posición de inicio se contará a partir del 
final del valor original.

• Si inicio es 0 o *, la posición de inicio será el principio del valor original.

Ejemplos
[5]
Descripción: obtener la subcadena del quinto carácter hasta el final del valor 
original.

“ABCDEFGHIJKL”  “EFGHIJKL”

“1234567890”  “567890”

“1234”  “”

[*]
Descripción: obtener una cadena completa.

“ABCEDFG”  “ABCDEFG”

“1234567”  “1234567”

[inicio, fin]: se utiliza para extraer una subcadena que comience en la 
posición de inicio y finalice en la posición de fin del valor original.
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• Si fin es un número positivo, la posición de fin se contará a partir del 
principio del valor original.

• Si fin es un número negativo, la posición de fin se contará a partir del final 
del valor original.

• Si fin es 0 o *, la posición de fin será el final del valor original.

• Si la posición de inicio se encuentra después de la posición de fin, la 
subcadena tendrá el orden inverso del valor original.

Ejemplos
[1, 2]
Descripción: obtener la subcadena del primer carácter al segundo carácter del 
valor original.

“ABCDEFG”  “AB”

“123456”  “12”

[-4, -1]
Descripción: obtener la subcadena del cuarto carácter del último carácter al 
último carácter del valor original.

“ABCDEFGHIJK”  “HIJK”

“1234567890”  “7890”

[*, 5]
Descripción: obtener la subcadena del primer carácter al quinto carácter del 
valor original.

“ABCDEFGHIJK”  “ABCDE”

[5,2]
Descripción: obtener la subcadena del quinto carácter al segundo carácter en 
orden inverso al del valor original.

“ABCDEFGHIJK”  “EDCB”

“1234567890”  “5432”

[2, -2]
Descripción: obtener la subcadena del segundo carácter al penúltimo carácter 
del valor original.

“ABCDEFGHIJ”  “BCDEFGHI”

“1234567890”  “23456789”

“AB”  “BA”

“A”  “A”

[índice, ‘delimitador’]: se utiliza para extraer el elemento en la posición 
especificada por el índice en el que cada elemento de los datos del índice está 
separado por el carácter delimitador. El primer elemento es el índice 1.

NOTA: Esta expresión de transformación es especialmente útil cuando se 
asignan elementos de datos en un código de barras PDF417 en 
distintos campos de índice. También lo es cuando se asignan distintas 
líneas de resultados OCR de varias líneas a distintos campos de índice. 
El elemento delimitador del OCR de varias líneas es el carácter ^.

Ejemplos
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[2, ‘^’]
Descripción: obtener el segundo elemento en el OCR de varias líneas donde 
los elementos están separados por el carácter “^”.

“Francisco Pérez^Calle principal 123^Ciudad”  “Calle principal 123”

[3, ‘*’]
Descripción: obtener el tercer elemento del código de barras PDF417 en 
donde los elementos están separados por el carácter *.

“Francisco Pérez*Calle principal 123*Ciudad”  “Ciudad”

[inicio; long]: se utiliza a fin de extraer una subcadena de la posición de inicio 
para los caracteres de longitud.

Ejemplos
[2;3]
Descripción: obtener la subcadena del segundo carácter con una longitud de 
3 caracteres.

“ABCDEFGHIJ”  “BCD”

“1234567890”  “234”

“AB”  “B”

“A”  “”

Formatos de número de 
transformación

#<anchura, anchurafraccionaria>
#<anchura, anchurafraccionaria, relleno>
#<formatostexto, anchura, anchurafraccionaria>
#<formatostexto, anchura, anchurafraccionaria, relleno>
0anchura

# puede ser uno de los caracteres siguientes para definir el tipo de número 
deseado.
n: número genérico
N: número genérico con signo
p: número de porcentaje
P: número de porcentaje con signo
c: número de moneda
C: número de moneda con signo

El rango de valores o la precisión del número quedan limitados en función del 
sistema operativo. El rango de números válido es de 1,7E ±308 (15 dígitos).

#<anchura, anchurafraccionaria>: se utiliza para dar formato a un número 
que tiene, como máximo, el número de caracteres indicado por anchura y el 
número decimal de caracteres indicado por anchurafraccionaria.

anchura define el número total de dígitos que se incluirá en la cadena de 
salida.

• Si anchura es un número positivo, el texto de salida se alineará a la derecha 
con caracteres de relleno (si los hay) a la izquierda.

• Si, por el contrario, anchura es un número negativo, el texto de salida se 
alineará a la izquierda con caracteres de relleno (si los hay) a la derecha.

anchurafraccionaria define el número de dígitos que se mostrarán a la 
derecha del separador decimal.

El número 0 se utiliza para que no se muestre ningún separador decimal.
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El carácter * se utiliza para mostrar un valor predeterminado de 6 dígitos a la 
derecha del separador decimal.

Ejemplos
n<20,2>
Descripción: un número genérico con una anchura máxima de 20 caracteres y 
2 dígitos después del separador decimal. La cadena se alineará a la derecha.

Ejemplos
 “324,5”  “324,50”
“abcd”  “ 0,00”

p<-20, 2>
Descripción: un número expresado en forma de porcentaje con una anchura 
total de 20 caracteres y 2 dígitos después del separador decimal. La cadena 
se alineará a la izquierda.

Ejemplos
 “0,12abc” “12,00% “
“-43” ”-4300,00% “

c<20, 0>
Descripción: un número expresado en forma de moneda con una anchura 
total de 20 caracteres y sin separador decimal. La cadena se alineará a la 
derecha.

Ejemplos
 “12345,6”  “12.346”
“-12345,6”  “-12.346”

C<20, 2>
Descripción: un número expresado en forma de moneda con signo y con una 
anchura total de 20 caracteres y 2 dígitos después del separador decimal. 
La cadena se alineará a la derecha.

Ejemplos
 “12345,6”  “+12.345,60”
“-12345,6”  “-12.345,60”
“abc”  “ +0,00”
“-0,001”  “-0,00”
“-0,00”  “+0,00”

#<anchura, anchurafraccionaria, relleno>: se utiliza para dar formato a un 
número al que se le aplicará el carácter de relleno, hasta la anchura 
especificada y con el número de caracteres indicado por anchurafraccionaria 
tras el decimal. 

relleno define el carácter que rellenará el espacio si el texto formateado es 
menor que la anchura definida.

Ejemplo
P<20, 3, ‘#’>
Descripción: un número expresado en forma de porcentaje con signo, con una 
anchura total de 20 caracteres, 3 dígitos después del separador decimal y con 
el carácter ‘#’ utilizado para el relleno.

Ejemplos
 “0,12abc”  “############+12,0000%”
“-43”  “##########-4300,000%”
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#<formatostexto, anchura, anchurafraccionaria>: se utiliza para dar 
formato a un número extraído de una cadena mediante la aplicación de 
formatostexto.

formatostexto especifica el modo de extracción del número de la cadena de 
índice original. Consulte la sección Formatos de salida.

Ejemplo
N<[2], 20, 3>
Descripción: un número con signo y con una anchura total de 20 caracteres 
y 3 dígitos después del separador decimal. La extracción del número se 
efectuará comenzando por el segundocarácter de la cadena original.

Ejemplos
“A12345,6”  ” +12345,600”
“-12345,6”  “+12345,600”
“TT9000”  “ +0,000”
“—9999”  “ –9999,000”

N<[2, ‘^’], 20, 3>
Descripción: un número con signo y con un total de 20 caracteres y 3 dígitos 
después del separador decimal. La extracción del número se efectuará 
comenzando por el segundo elemento de la cadena donde los elementos 
están separados por el carácter “^”.

Ejemplo
“12345,6^45678,9”  “ +45678,900”

#<formatostexto, anchura, anchurafraccionaria, relleno>: se utiliza para 
dar formato a un número extraído de una cadena mediante la aplicación de 
formatostexto y rellenado con el carácter especificado.

Este formato es una extensión del formato #<formatostexto, anchura, 
anchurafraccionaria>, con la diferencia de que la cadena de salida se 
rellenará con el carácter especificado.

0anchura: se utiliza para aplicar un relleno de ceros a un número hasta 
alcanzar la anchura mínima especificada.

Ejemplos
 010 
Descripción: un número con relleno de ceros y con una anchura total de 
10 caracteres.

Ejemplos

“123”  “0000000123”
“0”  “0000000000”

03
Descripción: un número con relleno de ceros y con una anchura total de 
3 caracteres.

Ejemplo
“1”  “001”
“1234”  “1234”

Formatos de fecha y 
hora de transformación

#

#: puede ser uno de los siguientes formatos o una combinación de ellos:

yyyy año (1900-2099)
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Si se utilizan formatos de fecha y hora, se debe especificar el formato de fecha 
y hora de entrada para definir el contenido de la cadena a la que se va a dar 
formato en la salida.

Ejemplos
ddMMyyyy
Descripción: una fecha en formato día, mes y año.

Ejemplos
Formato de entrada: T<yyyyMMdd>, cadena “20051026”  “26102005”
Formato de entrada: T<yyyyMM>, cadena “102005”  “102005”

Formatos de cadena fija texto”

texto es cualquier cadena de texto. Puesto que el inicio y el final de la cadena 
de texto están definidos por el carácter “ (comillas dobles), no está permitido 
utilizar este carácter en la cadena de texto. El formato de cadena de texto se 
combina normalmente con otros formatos de entrada.

Ejemplos
"ID-"[*]"-XX"
Descripción: cadena de texto fijo de salida de “ID”.

Ejemplos 
"20051026" ==> "ID-20051026-XX"

yy año (00-99)
y año
MM mes (01-12)
M mes (1-12)
dd día del mes (01-31)
d día del mes (1-31)
D día de la semana (1: domingo, 2: lunes, etc.)
DDD día del año (001-365)
HH hora (00-23)
H hora (0-23)
hh hora (01-12)
h hora (1-12)
mm minuto (00-59)
m minuto (0-59)
ss segundo (00-59)
s segundo (0-59)
TT A. M./P. M.
T A/P
tt a. m./p. m.
t a/p
ww semana del año (01-53)
w semana del año (1-53)
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Combinación de 
formatos de 
transformación

Una expresión de transformación puede componerse de varios formatos que 
se utilizan combinados. Si desea utilizar varios formatos para definir una 
expresión de transformación, solo tiene que conectar las expresiones de 
formato entre sí con o sin un espacio en blanco.

Ejemplos
"Ingresos"c<20, 2>
Descripción: combinación con los formatos "Ingresos" y c<20, 2>.

Ejemplos
"123456" ==>"Ingresos 123.456,00"

yyyy"/"MM"/"dd"-"HH":"mm":"ss
Descripción: combinado con formatos: aaaa, "/", MM, "/", dd, "-", HH, ":", mm, 
":" y ss.

Ejemplos
"20051026080405PM" ==> "2005/10/26-20:04:05"
Formato de entrada: T<yyyyMMddhhmmssTT>

Formatos de salida Un formato de salida es una expresión de texto para dar formato a los datos 
de un campo de índice determinado en un valor de salida. Las expresiones de 
transformación se utilizan para definir el formato de salida de un campo de 
índice. 

Formato de salida: al generar el lote, se les volverá a dar formato a los datos 
del índice del lote y los documentos del lote según el formato de salida. Por 
ejemplo, un índice de fecha con el valor MMddyy puede cambiar al formato: 
MM/dd/yyyy.

La sintaxis puede ser uno de los siguientes formatos o una combinación de 
ellos:

• Formatos de texto: consulte Expresiones de transformación, Formatos de 
texto

• Formatos de número: consulte Expresiones de transformación, Formatos 
de número

• Formatos de fecha y hora: consulte Expresiones de transformación, 
Formatos de fecha y hora

• Formatos de cadena fija: consulte Expresiones de transformación, 
Formatos de cadena fija

• Formatos de combinación: consulte Expresiones de transformación, 
Combinación de formatos de transformación
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Pestaña Índice: 
Búsqueda en la base 
de datos

La opción Database Lookup (Búsqueda en la base de datos) se puede utilizar 
para completar o validar campos de índice de lote y de documento de fuentes 
de datos compatibles con ODBC (Open Database Connectivity). Se utiliza un 
asistente de configuración para especificar la fuente de datos, definir el modo 
en que se realizará la búsqueda y los datos que se van a utilizar para 
completar campos de índice o validar el contenido de los campos de índice. 
La configuración de un trabajo puede contener varias búsquedas. Cada 
búsqueda puede tener una fuente de datos distinta y se puede utilizar para 
completar o validar los campos de índice seleccionados. Las búsquedas 
pueden tener lugar durante la digitalización, cuando el valor de índice utilizado 
para la búsqueda es el resultado de la lectura de un código de barras o de una 
acción de OCR. Las búsquedas adoptan la siguiente forma: SELECT 
<columna de tabla 1>, <columna de tabla 2>, ... <columna de tabla n> FROM 
<fuente de datos> WHERE <columna de tabla x> = <valor de campo de 
índice> o seleccione: WHERE <columna de tabla x> = <valor de campo de 
índice> AND <columna de tabla y> = <valor de campo de índice>.

Configuración de la 
búsqueda en la base de 
datos

Para configurar la búsqueda en la base de datos, primero se debe definir el 
lote y los campos de índice de documento que se utilizarán en la búsqueda. 
Las búsquedas en la base de datos se configuran para cada trabajo.

NOTA: La definición de campos de índice en la configuración de trabajo no ha 
sufrido cambios con respecto a versiones anteriores del software 
Capture Pro.

Para agregar o editar una nueva búsqueda:

1. Haga clic en File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo). Se mostrará la configuración de trabajo.

3. Seleccione la pestaña Index (Índice).

4. Seleccione la pestaña Database Lookup (Búsqueda en la base de datos). 
Se mostrará la tabla Lookups (Búsquedas) con los siguientes campos para 
cada búsqueda: Name, Input Index Field, Output Index Field (Batch) 
y Output Index Field (Document) (Nombre, Campo de índice de entrada, 
Campo de índice de salida [lote] y Campo de índice de salida 
[documento]) para cada búsqueda. 
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5. Haga clic en Add (Agregar). Se abrirá la ventana Database Lookup Wizard 
(Asistente de búsqueda en la base de datos).

6. Introduzca un nombre para la búsqueda en el campo Lookup name 
(Nombre de la búsqueda).

7. Haga clic en Browse (Explorar) para abrir el cuadro de diálogo Select 
Data Source (Seleccionar fuente de datos).

• Seleccione entre las opciones File Data Source (Fuente de datos de 
archivo) o Machine Data Source (Fuente de datos de equipo), o haga 
clic en New (Nueva) para crear una nueva fuente de datos. 
Dependiendo del tipo de fuente de datos que haya seleccionado, se le 
solicitará información adicional. 

• Haga clic en OK (Aceptar) cuando haya introducido toda la información 
necesaria.

• Después de hacer clic en OK (Aceptar), se mostrará la ventana de 
inicio de sesión en SQL Server. Introduzca las credenciales y haga clic 
en OK (Aceptar).

8. En la lista desplegable Database table (Tabla de base de datos), 
seleccione la tabla o el archivo que contenga los datos que se vayan 
a usar para completar o validar los campos de índice.
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9. Haga clic en Next (Siguiente) para definir cómo quiere realizar la 
búsqueda de datos. 

• Seleccione Validate index fields from Lookup results (Validar campos 
de índice a partir de los resultados de búsqueda) en caso de que quiera 
comprobar si los valores de uno o varios campos de índice coinciden con 
la fuente de datos. Seleccione Create a document index to store the 
validation result (Crear índice de documento para almacenar resultado 
de validación) si desea almacenar los resultados de la búsqueda en un 
campo de índice para su uso en otros procedimientos, como Sort by 
Document Index (Clasificar por índice de documento).

• Seleccione Populate index fields from Lookup results (Completar 
campos de índice a partir de los resultados de búsqueda) si quiere 
completar uno o más campos de índice con datos de la búsqueda.

10. En la lista desplegable Lookup index field (Campo de índice de búsqueda), 
seleccione los campos de índice que se van a usar en la búsqueda para 
encontrar valores coincidentes en la base de datos seleccionada. Esta 
lista contiene todos los campos de índice de lote y de documento 
definidos. Si se utiliza un único campo de índice para la búsqueda, debe 
ser en la columna de la izquierda, antes de “And”. Si se indican dos 
campos de índice de búsqueda, solo se encontrarán los registros de la 
base de datos que contengan ambos valores. Al momento de la entrada 
de datos de índice, si no conoce uno de los valores, puede reemplazarse 
con un asterisco (*). Para obtener más información, consulte la sección 
“Uso de la búsqueda en la base de datos”, que aparece más adelante en 
este capítulo. 

11. En la lista desplegable Lookup table column (Columna de tabla de 
búsqueda), seleccione las columnas de la tabla en las que se van a buscar 
valores coincidentes con el campo de índice de búsqueda. Esta lista 
contiene todos los nombres de columna de la tabla incluidos en la tabla de 
base de datos seleccionada.

12. Para cada campo de índice de documento o de lote que quiera completar 
o validar, seleccione la columna de la base de datos que contenga los 
datos que desee. Haga clic en la columna a la derecha del nombre del 
campo de índice y seleccione la columna de la base de datos en la lista 
desplegable.
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13. Haga clic en Next (Siguiente) para seleccionar las opciones de búsqueda 
en la base de datos.

14. Seleccione las opciones de búsqueda que desee:

• Disable Lookup (Desactivar búsqueda): si se selecciona esta opción, 
no se realizarán búsquedas durante la digitalización. Esto puede 
mejorar el rendimiento con bases de datos remotas o de gran tamaño. 
Las búsquedas se realizarán en el modo Edit Index (Editar índice) 
y cuando se genere el lote.

• Display multiple lookup results if there is more than one result 
(Mostrar varios resultados de búsqueda si hay más de uno): cuando 
esta opción no está seleccionada, la tabla Multiple Lookup Results 
(Varios resultados de búsqueda) no se muestra durante la 
digitalización. Los resultados múltiples de la búsqueda se resolverán en 
el modo Edit Index (Editar índice), lo que permite que la digitalización 
prosiga de forma ininterrumpida.

• Lookup will overwrite existing index value (La búsqueda 
sobrescribirá el valor de índice actual): cuando esta opción esté 
seleccionada, la búsqueda completará constantemente un campo de 
índice con el valor de búsqueda de la base de datos, siempre y cuando 
la entrada de la base de datos tenga un valor (es decir, no esté vacía ni 
sea nula). Si quiere que los usuarios puedan introducir datos 
manualmente en un campo de índice completado por la búsqueda en la 
base de datos, esta opción debe estar desactivada.

NOTA: Las búsquedas en la base de datos nunca sobrescriben los 
datos durante la salida del lote. 

• Disable Lookup during Output (Desactivar búsqueda durante la 
salida): cuando esta opción esté seleccionada, no se realizarán 
búsquedas (completar o validar) durante la salida. Si no está 
seleccionada, los campos vacíos se completarán y se ignorarán los 
registros múltiples o que falten. La validación no se llevará a cabo 
correctamente si no se encuentra ningún registro coincidente.

• Maximum multiple results to display (Máximo de resultados 
múltiples que se van a mostrar): cuando se encuentren varios 
resultados, estos se mostrarán en una tabla en la que podrá 
seleccionar el resultado adecuado. El valor introducido limitará la 
longitud de la tabla.
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15. Haga clic en Next (Siguiente) para probar la búsqueda.

16. Haga clic en Test Query (Probar solicitud). Se mostrará el cuadro de 
diálogo Test Query (Probar solicitud).

17. Introduzca un valor válido en el parámetro utilizado para realizar la 
búsqueda. Si deja el valor en blanco, se mostrarán los primeros 25 
registros de la tabla.

18. Haga clic en OK (Aceptar).

Uso de la búsqueda en la 
base de datos

Después de configurar un trabajo para hacer una búsqueda en la base de 
datos, es importante comprender cuándo se realizará la búsqueda. Estas son 
las situaciones habituales:

Durante la digitalización: 
completar campos de índice

Cuando la opción Disable Lookup (Desactivar búsqueda) durante la salida no 
está activada, las búsquedas se realizan sobre la marcha durante la 
digitalización.

La búsqueda solo tiene lugar cuando el campo de índice que se está 
utilizando para la búsqueda tiene un valor que se completa durante la 
digitalización (es decir, como resultado de la lectura de una zona de código de 
barras, OCR o detección de marcas).
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Durante la digitalización: 
validar campos de índice

Cuando la opción Disable Lookup (Desactivar búsqueda) durante la captura 
no está activada, las búsquedas configuradas para la validación de campos 
de índice se realizarán sobre la marcha durante la digitalización.

La validación de la búsqueda solo tendrá lugar cuando el campo de índice que 
se esté validando tenga un valor que se complete durante la digitalización 
(es decir, como resultado de la lectura de una zona de código de barras, 
OCR o detección de marcas).

NOTA: Cuando la opción Disable Lookup (Desactivar búsqueda) no esté 
activada, las búsquedas en la base de datos siempre se realizarán 
durante la digitalización. La validación de la búsqueda en la base de 
datos se seguirá realizando incluso si la opción de configuración de 
campos de índice Check field during scanning (Comprobar campo 
durante la digitalización) está desactivada.

Modo editar indexación Después de haber realizado la digitalización y de que el usuario haya 
accedido al modo Index (Índice) mediante Index > Edit Index Fields (Índice > 
Editar campos de índice), la búsqueda siempre se realizará en un documento 
cada vez que se navegue hasta el documento mientras se esté en modo Index 
(Índice).

Si el campo de índice que se está utilizando para la búsqueda ya tiene un 
valor (p. ej., obtenido a partir de la lectura de una zona de código de barras, 
OCR o detección de marcas), la búsqueda de un documento se realizará 
automáticamente cuando se navegue hasta el documento.

Si los datos se están introduciendo manualmente en el campo de índice, la 
búsqueda se realizará cuando el usuario abandone el campo de índice. Si se 
usa la tecla Tabulación para salir del campo de índice que se acaba de 
introducir, los resultados de completar otros campos de índice se mostrarán 
para su verificación. Si se utiliza la tecla Entrar o alguna de las demás teclas 
de función del modo Index (Índice) (por ejemplo, F9, F10, F11) para navegar 
hasta otro documento, se realizará la búsqueda y se completará el resto de 
campos de índice. Sin embargo, no verá los resultados de la búsqueda, ya 
que el documento ha dejado de visualizarse en modo de indexación.

Si el campo de índice de búsqueda se completa utilizando OCR mediante las 
técnicas de arrastrar y soltar o de hacer, la búsqueda se realizará 
inmediatamente y los resultados de completar el resto de campos de índice se 
mostrarán para su verificación.

Si el valor que se utiliza para la búsqueda solo se conoce parcialmente, el 
carácter de asterisco ' * ' puede utilizarse para reemplazar los caracteres 
desconocidos. El carácter de asterisco debe ser el último carácter. Por 
ejemplo, si el valor de búsqueda es un número de teléfono, pero solo es 
posible leer los primeros cuatro dígitos, puede indicarse el valor “557-3*”. 
Todos los números telefónicos que comiencen con “557-3xx…” se 
recuperarán de la base de datos y usted podrá seleccionar el valor correcto.
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Cuando una búsqueda se basa en dos valores y solo conoce un valor, el 
carácter de asterisco puede utilizarse en lugar del valor desconocido. Por 
ejemplo, la búsqueda se basa en el apellido Y en el nombre, y se busca la 
dirección. Si solo conoce el apellido, lo indica en el campo índice “Apellido”, 
y el carácter de asterisco se ingresa en el campo índice “Nombre”. Si solo se 
halla un registro para el apellido indicado, se completarán el nombre y la 
dirección. Si se hallan varios registros para el apellido, el cuadro de diálogo 
Multiple Results (Múltiples resultados) se visualizará, y se podrá seleccionar la 
entrada correspondiente. 

Salida de lote La búsqueda en la base de datos solo se realizará a la salida si la opción 
Disable Lookup on Output (Desactivar búsqueda a la salida) está 
desactivada. Si hace clic en la herramienta Output (Salida) como parte de la 
validación de campos de índice, la búsqueda en la base de datos para 
completar y validar campos de índice se realiza inmediatamente antes de que 
el lote se ponga en cola para el procesamiento de salida. Si una búsqueda en 
la base de datos está completando los campos de índice, se ignorarán los 
errores. Si no se encuentra ningún registro o se encuentran varios, el valor 
actual del campo de índice no se modificará o se dejará vacío. Si la búsqueda 
en la base de datos está validando campos de índice, se generará un error si 
no se encuentra ningún registro coincidente. El lote no se enviará para su 
salida y se deberá corregir el error antes de poder enviar el lote 
correctamente.

Si se genera un lote desde la pantalla del administrador de lotes o si se genera 
automáticamente desde la configuración de trabajo, la búsqueda en la base 
de datos se realiza inmediatamente como parte del procesamiento de lotes en 
segundo plano. Si una búsqueda falla, el lote muestra el estado Index Error 
(Error de índice).

Cuando se abre un lote para corregir el error, se muestra automáticamente el 
documento que contiene el error de búsqueda y puede pasar al modo Index 
(Índice) para corregir el problema de indexación y reenviar el lote para su 
procesamiento de salida.
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Configuración de 
trabajo: Pestaña 
Salida

En la pestaña Output (Salida) es donde se configuran las opciones de salida 
para la configuración de trabajo.

• Destination (Destino): permite especificar la configuración del formato de la 
salida, el destino de la salida y el modo de indexarla. Las opciones de 
destino son las siguientes:

- Credentials (Credenciales): permite proporcionar credenciales de 
acceso de usuario para compartir archivos en un recurso compartido de 
red de destino.

- File (1) [Archivo (1)] y File (2) [Archivo (2)]: permite seleccionar el 
formato de archivo (TIFF, JPEG, PDF, PNG, etc.) y el tipo de salida 
(p. ej., blanco y negro, color/escala de grises).

- Sistema (1) [Sistema (1)] y Sistema (2) [Sistema (2)]: permite 
seleccionar el destino de salida del sistema para la configuración de 
trabajo.

- E-mail (Correo electrónico): permite configurar el software para enviar 
la salida por correo electrónico automáticamente. 

- Print (Imprimir): permite configurar el software para imprimir la salida.

• Advanced Options (Opciones avanzadas): permite aplicar las opciones de 
procesamiento de imágenes del software Capture Pro a la salida. 

• Invoke Other Program (Invocar otro programa): permite utilizar otra 
aplicación de software con la salida. 

Credenciales Seleccione Credentials (Credenciales) cuando la ubicación de salida 
Destination (Destino) sea un recurso compartido de red al cual es posible que 
el operador de Capture Pro no tenga acceso. 
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• Add (Agregar): muestra el cuadro de diálogo Credentials Setup 
(Configuración de credenciales). 

• Introduzca el nombre del servidor y del recurso compartido en el formato 
\\nombre_servidor\nombre_recurso. Puede indicar el nombre del equipo 
o la dirección IP del servidor.

• Remove (Eliminar): elimina las credenciales seleccionadas.

• Properties (Propiedades): muestra las propiedades de las credenciales 
seleccionadas. Puede modificar el nombre de usuario y la contraseña.

Las credenciales no se comparten entre configuraciones de trabajo. Si dos 
configuraciones de trabajo utilizan la misma información de recurso 
compartido de red, las credenciales se deben añadir a ambas configuraciones 
de trabajo. Esto permite que distintas configuraciones de trabajo accedan al 
mismo recurso compartido de red con diferentes credenciales.

Las credenciales siempre se utilizarán, incluso si el usuario actual tiene 
acceso al recurso compartido de red.

Las credenciales se pueden utilizar para las salidas Archivo (1), Archivo (2), 
Sistema (1) y Sistema (2). El uso de las credenciales es especialmente útil 
cuando Capture Pro Network Edition se utiliza con el servidor de salida remota 
(opcional). Debido a que el servicio de salida remota no tiene usuario, las 
credenciales se utilizan para proporcionar acceso a los recursos compartidos 
externos.

Opciones de destino: 
Archivo (1) y Archivo (2) 

Opción File 1 [Archivo (1)]: seleccione un formato de archivo (TIFF, PDF, 
JPEG,PNG, etc.) para la salida. La variedad de opciones de formato 
dependerá del tipo de salida:
• All (Todo) (blanco y negro y color/escala de grises)
• Black and white (Blanco y negro)
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• Color/Grayscale (Color/Escala de grises): cuando esta opción está 
seleccionada, se puede elegir una opción de filtro para generar solo 
imágenes en color o en escala de grises.

NOTA: Para obtener una descripción de los cuadros de diálogo de formato de 
archivo, consulte la sección “Opciones de configuración para Archivo 
(1) y Archivo (2)”, que aparece más adelante en este capítulo. 

• Location (Ubicación): muestra la ubicación de salida de Archivo (1). 
Para modificar la configuración, haga clic en Setup (Configuración) para 
abrir el cuadro de diálogo Location Setup (Configuración de ubicación). 
Para obtener más información sobre este cuadro de diálogo, consulte la 
sección “Creación de fórmulas de ubicación y de nombre de archivo 
mediante el cuadro de diálogo Configuración de ubicación”, que aparece 
más adelante en este capítulo.

• File Name (Nombre de archivo): muestra el nombre de archivo de 
Archivo (1).

Opción File (2) [Archivo (2)]: igual que Archivo (1). Puede seleccionar una 
configuración distinta para Archivo (2) o utilizar la misma configuración que en 
Archivo (1).

En las opciones File (1) [Archivo (1)] o File (2) [Archivo (2)], puede seleccionar 
la opción Index (Índice). Se mostrarán las opciones de indexación siguientes. 
• Archivo de índice de lote
• Archivo de índice de documento
• Archivo de índice de imagen

Opciones de 
configuración para 
Archivo (1) y Archivo (2) 

Cuando se selecciona un formato de archivo (p. ej., TIFF, PDF, JPEG, PNG, 
etc.) para la salida, las opciones de formato dependerán de cómo defina la 
configuración para dicho formato de archivo.
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• Haga clic en Options (Opciones) para el formato de archivo que quiera 
configurar. 

Cuando esté seleccionado el botón Options (Opciones), aparecerá un cuadro 
de diálogo del formato de archivo que haya seleccionado.

Selección de PDF como 
formato de archivo 

Si selecciona PDF como formato de archivo, se mostrará el cuadro de diálogo 
PDF Setup (Configuración de PDF).

1. Seleccione Single Page (Una página) o Multi-Page (Varias páginas) 
como modo para agrupar los archivos de imagen en la salida. Cada 
archivo de imagen de entrada (imagen digitalizada) será un archivo de 
salida independiente.

• Si selecciona Single Page (Una página), cada imagen que digitalice 
será un archivo de imagen independiente en la salida. Por lo tanto, 
si digitaliza una página, tendrá dos archivos de imagen independientes 
en la salida (uno para el anverso y otro para el reverso). Si utiliza la 
opción de digitalización en doble secuencia, habrá cuatro archivos de 
imagen en la salida.

• Si selecciona Multi-Page (Varias páginas), la lista desplegable 
For each (Para cada) estará disponible.

- Para cada: Page (Página): cada imagen de cada página digitalizada 
se convertirá en un archivo. Cuando abra un archivo, habrá dos 
imágenes, una para el anverso y otra para el reverso. Si está 
digitalizando en doble secuencia, tendrá cuatro imágenes.

- Para cada: Document (Documento): cada página digitalizada en un 
documento se convertirá en el contenido de un archivo. Puede haber 
varias (o muchas) imágenes en un archivo.
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- Para cada: Batch (Lote): todas las imágenes digitalizadas en el lote 
se convertirán en un archivo de salida. Puede haber muchas 
imágenes en el archivo de salida.

2. Puede seleccionar uno o varios Formatos PDF adicionales: Fast Web 
View, PDF BookMark, Long PDF o PDF-MRC (Vista web rápida, 
Marcador de PDF, PDF largo o PDF-MRC). 

• Seleccione Fast Web View (Vista web rápida) si desea configurar el 
archivo PDF para una visualización más rápida en el caso de que los 
archivos sean de gran tamaño y se descarguen de un sitio web. 

• Seleccione PDF BookMark (Marcador de PDF) cuando desee marcar 
cada documento en el archivo PDF. En la opción Group by (Agrupar 
por), debe seleccionar Multi-Page (Varias páginas) en cada Batch 
(Lote). Especifique el valor de cada marcador de documento en la 
pestaña PDF BookMark (Marcador de PDF), que se encuentra en la 
pestaña Index (Índice). Se pueden utilizar los valores del sistema o de 
índice para producir valores de marcador únicos.

• Seleccione Long PDF (PDF largo) si espera que las imágenes tengan 
más de 500 cm (200 in). La selección de este valor repercutirá sobre el 
rendimiento. PDF largo no está disponible para el formato de archivo 
PDF-MRC.

• Si selecciona PDF-MRC como uno de los formatos PDF adicionales, 
seleccione la opción de Image quality (Calidad de imagen) deseada: 
JBIG2/Group4, Draft, Good o Better (JBIG2/Group4, Borrador, Buena 
o Muy buena).

NOTA: Las opciones de PDF-MRC solo están disponibles si la 
instalación original de Capture Pro era la versión 5.5.1 o una 
anterior, y es posible utilizar dichas opciones después de 
actualizar el programa. Si la instalación inicial de Capture Pro 
correspondía a la versión 5.6 o una posterior, estas opciones no 
están disponibles.

NOTA: En general, JBIG2 producirá tamaños de archivo más pequeños 
y con menor calidad que Group4. JBIG2-Better, Group4-Draft, 
Group4-Good y Group4-Better (JBIG2-Muy buena, Grupo4-
Borrador, Grupo4-Buena y Grupo4-Muy buena) son formatos sin 
pérdidas.

• Si no selecciona ningún valor, el formato de PDF será PDF.

3. Seleccione una opción de compatibilidad PDF si necesita que el PDF sea 
compatible con una versión específica de Adobe Reader. Si va a proteger 
el PDF con una contraseña, seleccione una versión más reciente de PDF, 
ya que esto le proporcionará un algoritmo de cifrado más seguro. 
Se agregó la opción PDF/UA para tipos de archivo PDF y SPDF.
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4. Si desea cifrar el archivo PDF, introduzca la contraseña que será 
necesaria para abrir y ver el documento PDF en el campo Password 
(Contraseña). Si no desea cifrar el archivo, deje el campo Password 
(Contraseña) en blanco.

5. Cuando haya terminado, haga clic en OK (Aceptar).

Selección de TIFF como 
formato de archivo

Si selecciona TIFF como formato de archivo, se mostrará el cuadro de diálogo 
TIFF Setup (Configuración de TIFF).

1. Seleccione Single Page (Una página) o Multi-Page (Varias páginas) 
como modo para agrupar los archivos de imagen en la salida. Cada 
archivo de imagen de entrada (imagen digitalizada) será un archivo de 
salida independiente.

• Si selecciona Single Page (Una página), cada imagen que digitalice 
será un archivo de imagen independiente en la salida. Por lo tanto, 
si digitaliza una página, tendrá dos archivos de imagen independientes 
en la salida (uno para el anverso y otro para el reverso). Si utiliza la 
opción de digitalización en doble secuencia, habrá cuatro archivos de 
imagen en la salida.

• Si selecciona Multi-Page (Varias páginas), la lista desplegable 
For each (Para cada) estará disponible.

- Para cada: Page (Página): cada imagen de cada página digitalizada 
se convertirá en un archivo. Cuando abra un archivo, habrá dos 
imágenes, una para el anverso y otra para el reverso. Si está 
digitalizando en doble secuencia, tendrá cuatro imágenes.

- Para cada: Document (Documento): cada página digitalizada en un 
documento se convertirá en el contenido de un archivo. Puede haber 
varias (o muchas) imágenes en un archivo.

- Para cada: Batch (Lote): todas las imágenes digitalizadas en el lote 
se convertirán en un archivo de salida. Puede haber muchas 
imágenes en el archivo de salida.

2. Si la salida incluye imágenes en blanco y negro, la opción Black & White 
compression (Compresión en blanco y negro) estará disponible. 
Seleccione Group-4 (Grupo 4) o none (ninguna) en la lista desplegable.

3. Si la salida incluye imágenes en color o en escala de grises, las opciones 
Color/Grayscale compression (Compresión de color/escala de grises) 
y Color quality (Calidad de color) están disponibles.
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• Color/Grayscale compression (Compresión de color/escala de 
grises): seleccione JPEG, JAPED (TIFF 6) o none (ninguna).

• Color quality (Calidad del color): seleccione uno de los valores de 
configuración siguientes de la lista desplegable: Same as scanned, 
Draft, Good, Better, Best, o Superior (Igual que la digitalización, 
Borrador, Buena, Muy buena, Óptima o Superior). Se recomienda la 
opción Same as scanned (Igual que la digitalización).

4. Para verificar que una imagen de salida del software Capture Pro no haya 
sufrido alteraciones con respecto a la imagen capturada del documento de 
entrada, haga clic en Apply Digital Signature (Aplicar firma digital). 

Puede utilizar el software gratuito ImageVerifier para comprobar que una 
imagen

firmada digitalmente no se ha sufrido ninguna alteración. Para obtener 
más información acerca de las ventajas de la verificación de imágenes 
y para acceder al software ImageVerifier, póngase en contacto con su 
representante local de Kodak Alaris.

5. Cuando haya terminado, haga clic en OK (Aceptar).

Selección de PDF con 
capacidad de búsqueda como 
formato de archivo 

Si selecciona Searchable PDF (PDF con capacidad de búsqueda) como 
formato de archivo, se mostrará el cuadro de diálogo Searchable PDF Setup 
(Configuración de PDF con capacidad de búsqueda).

1. Seleccione Single Page (Una página) o Multi-page (Varias páginas) 
como modo para agrupar los archivos de imagen en la salida. Cada 
archivo de imagen de entrada (imagen digitalizada) será un archivo de 
salida independiente.
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• Si selecciona Single Page (Una página), cada imagen que digitalice 
será un archivo de imagen independiente en la salida. Por lo tanto, si 
digitaliza una página, tendrá dos archivos de imagen independientes en 
la salida (uno para el anverso y otro para el reverso). Si utiliza la opción 
de digitalización en doble secuencia, habrá cuatro archivos de imagen 
en la salida.

• Si selecciona Multi-page (Varias páginas), la lista desplegable For 
each (Para cada) estará disponible.

- Para cada: Page (Página): cada imagen de cada página digitalizada 
se convertirá en un archivo. Cuando abra un archivo, habrá dos 
imágenes, una para el anverso y otra para el reverso. Si está 
digitalizando en doble secuencia, tendrá cuatro imágenes.

- Para cada: Document (Documento): cada página digitalizada en un 
documento se convertirá en el contenido de un archivo. Puede haber 
varias (o muchas) imágenes en un archivo.

- Para cada: Batch (Lote): todas las imágenes digitalizadas en el lote 
se convertirán en un archivo de salida. Puede haber muchas 
imágenes en el archivo de salida.

NOTA: Los PDF con capacidad de búsqueda de varias páginas se 
limitan a 500 páginas por documento. Los resultados reales 
pueden variar según los ajustes y la configuración de trabajo.

2. Seleccione uno o varios Formatos PDF: Fast Web View, PDF BookMark 
o PDF-MRC (Vista web rápida, Marcador de PDF o PDF-MRC). 

• Seleccione Fast Web View (Vista web rápida) si desea configurar el 
archivo PDF para una visualización más rápida en el caso de que los 
archivos sean de gran tamaño y se descarguen de un sitio web. 

• Seleccione PDF BookMark (Marcador de PDF) cuando desee marcar 
cada documento en el archivo PDF. En la opción Group by (Agrupar 
por), debe seleccionar Multi-Page (Varias páginas) en cada Batch 
(Lote). Especifique el valor de cada marcador de documento en la 
pestaña PDF BookMark (Marcador de PDF), que se encuentra en la 
pestaña Index (Índice). Se pueden utilizar los valores del sistema o de 
índice para producir valores de marcador únicos.

• Si selecciona PDF-MRC como uno de los formatos PDF adicionales, 
seleccione la opción de Image quality (Calidad de imagen) deseada: 
JBIG2/Group4, Draft, Good o Better (JBIG2/Group4, Borrador, Buena 
o Muy buena).

NOTA: En general, JBIG2 producirá tamaños de archivo más 
pequeños y con menor calidad que Group4. JBIG2-Better, 
Group4-Draft, Group4-Good y Group4-Better (JBIG2-Muy 
buena, Grupo4-Borrador, Grupo4-Buena y Grupo4-Muy 
buena) son formatos sin pérdidas.

• Si no selecciona ningún valor, el formato de PDF será PDF.

3. Seleccione una opción de compatibilidad PDF si necesita que el PDF sea 
compatible con una versión específica de Adobe Reader. Si va a proteger 
el PDF con una contraseña, seleccione una versión más reciente de PDF, 
ya que esto le proporcionará un algoritmo de cifrado más seguro.

4. Si desea cifrar el archivo PDF, introduzca la contraseña que será 
necesaria para abrir y ver el documento PDF en el campo Password 
(Contraseña). 
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• Si no desea cifrar el archivo, deje el campo Password (Contraseña) en 
blanco.

5. Seleccione los parámetros adecuados de OCR Setting (Configuración de 
OCR) para equilibrar la velocidad y precisión según lo que necesite. 
Cuando mueve el control deslizante a la derecha, se utilizan las 
herramientas adicionales, como los diccionarios de idiomas y varios 
motores de OCR, para mejorar la precisión.

6. Cuando esté disponible, el OCR se aplicará para permitir la búsqueda de 
texto específico en los archivos de salida. Seleccione el idioma de OCR de 
los documentos digitalizados para que el reconocimiento de caracteres 
sea lo más preciso posible. Si dispone de un conjunto de documentos 
variados que puede contener varios idiomas, puede seleccionar uno 
o más idiomas secundarios.

7. Puede utilizar un diccionario personalizado para mejorar la precisión de 
reconocimiento de palabras únicas o inusuales que aparezcan en el 
conjunto de documentos. Haga clic en Browse (Examinar) para 
seleccionar un diccionario personalizado. Para obtener más información, 
consulte el Anexo D: Uso de diccionarios personalizados.

8. Cuando agrupe por varias páginas, seleccione All (Todo) o Images 
(Imágenes) como un modo de seleccionar imágenes específicas para su 
inclusión en el archivo de salida.

• Si selecciona All (Todo), todas las imágenes del grupo de páginas, 
documentos o lotes seleccionado se incluirán en el archivo de salida.

• Si selecciona Images (Imágenes), solo las imágenes especificadas del 
grupo de páginas, documentos o lotes seleccionado se incluirán en el 
archivo de salida. Por ejemplo, si ha seleccionado Multi-Page (Varias 
páginas), agrupar por Document (Documento), y ha especificado un 
rango de salida “1, 10”, solo la primera y la décima imagen de cada 
documento se incluirán en el archivo de salida. Si un documento 
contiene menos de 10 imágenes, solo se incluirá la primera en el 
archivo de salida.

9. Cuando haya terminado, haga clic en OK (Aceptar).

Selección de JPEG o 
JEPG2000 como formato de 
archivo (si el tipo de salida es 
Color/Escala de grises) 

Si selecciona JPEG2000 como formato de archivo, se mostrará el cuadro de 
diálogo JPEG2000 Setup (Configuración de JPEG2000).

1. Seleccione Good (Buena), Better (Muy buena) o Best (Óptima) como 
calidad de color.

NOTA: Si selecciona JPEG como formato de archivo, estarán disponibles 
las opciones de calidad de color adicionales Same as scanned, 
Draft y Superior (Igual que la digitalización, Borrador y Superior). 
Se recomienda la opción Same as scanned (Igual que la 
digitalización).

2. Cuando haya terminado, haga clic en OK (Aceptar).
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Selección de PNG como 
formato de archivo

Cuando se selecciona PNG como formato de archivo, no se requiere ningún 
tipo de configuración. El formato de archivo PNG es un formato sin pérdidas 
de una sola página que no requiere configuración.

Selección de texto como 
formato de archivo

Si selecciona Text (Texto) como formato de archivo para procesar la salida, se 
mostrará el cuadro de diálogo Text Setup (Configuración de texto).

1. Seleccione Single Page (Una página) o Multi-Page (Varias páginas) 
como modo para agrupar los archivos de imagen en la salida. Cada 
archivo de imagen de entrada (digitalizado) será un archivo de salida 
independiente.

• Si selecciona Single Page (Una página), cada imagen que digitalice 
será un archivo de imagen independiente en la salida. Por lo tanto, si 
digitaliza una página, tendrá dos archivos de imagen independientes en 
la salida (uno para el anverso y otro para el reverso). Si utiliza la opción 
de digitalización en doble secuencia, habrá cuatro archivos de imagen 
en la salida.

• Si selecciona Multi-Page (Varias páginas), la lista desplegable For 
each (Para cada) estará disponible.

- Para cada: Page (Página): cada imagen de cada página digitalizada 
se convertirá en un archivo. Cuando abra un archivo, habrá dos 
imágenes, una para el anverso y otra para el reverso. Si está 
digitalizando en doble secuencia, tendrá cuatro imágenes.

- Para cada: Document (Documento): cada página digitalizada en un 
documento se convertirá en el contenido de un archivo. Puede haber 
varias (o muchas) imágenes en un archivo.

- Para cada: Batch (Lote): todas las imágenes digitalizadas en el lote 
se convertirán en un archivo de salida. Puede haber muchas 
imágenes en el archivo de salida.
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2. Seleccione uno de los formatos siguientes de la lista desplegable: Text 
only, Formatted text, Text only – Unicode o Formatted text - Unicode 
(Solo texto, Texto formateado, Solo texto [Unicode] o Texto formateado 
[Unicode]).

3. Seleccione una opción en OCR Setting (Configuración de OCR) para 
equilibrar la velocidad y precisión según sus necesidades. Cuando mueve 
el control deslizante a la derecha, se utilizan las herramientas adicionales, 
como los diccionarios de idiomas y varios motores de OCR, para mejorar 
la precisión.

4. Cuando esté disponible, el OCR se aplicará para permitir la búsqueda de 
texto específico en los archivos de salida. Seleccione el idioma de OCR 
que contendrán los documentos digitalizados, de modo que el 
reconocimiento de caracteres sea lo más preciso posible. Si dispone de un 
conjunto de documentos variados que podría contener distintos idiomas, 
puede seleccionar uno o más idiomas secundarios.

5. Puede utilizar un diccionario personalizado para mejorar la precisión de 
reconocimiento de palabras únicas o inusuales que aparezcan en el 
conjunto de documentos. Haga clic en Browse (Examinar) para 
seleccionar un diccionario personalizado. Para obtener más información, 
consulte el Anexo D: Uso de diccionarios personalizados.

Cuando agrupe por varias páginas, seleccione All (Todo) o Images 
(Imágenes) como un modo de seleccionar imágenes específicas para su 
inclusión en el archivo de salida.

• Si selecciona All (Todo), todas las imágenes del grupo de páginas, 
documentos o lotes seleccionado se incluirán en el archivo de salida.

• Si selecciona Images (Imágenes), solo las imágenes especificadas del 
grupo de páginas, documentos o lotes seleccionado se incluirán en el 
archivo de salida. Por ejemplo, si ha seleccionado Multi-Page (Varias 
páginas), agrupar por Document (Documento), y ha especificado un 
rango de salida “1, 10”, solo la primera y la décima imagen de cada 
documento se incluirán en el archivo de salida. Si un documento 
contiene menos de 10 imágenes, solo se incluirá la primera en el 
archivo de salida.

6. Cuando haya terminado, haga clic en OK (Aceptar).
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Selección de RTF (sin 
formato) como formato de 
archivo

Si selecciona RTF (sin formato) como formato de archivo, se mostrará el 
cuadro de diálogo RTF (Unformatted) Setup (Configuración de RTF [sin 
formato]).

1. Seleccione Single Page (Una página) o Multi-Page (Varias páginas) 
como modo para agrupar los archivos de imagen en la salida. Cada 
archivo de imagen de entrada (imagen digitalizada) será un archivo de 
salida independiente.

• Si selecciona Single Page (Una página), cada imagen que digitalice 
será un archivo de imagen independiente en la salida. Por lo tanto, si 
digitaliza una página, tendrá dos archivos de imagen independientes en 
la salida (una para el anverso y otra para el reverso). Si utiliza la opción 
de digitalización en doble secuencia, habrá cuatro archivos de imagen 
en la salida.

• Si selecciona Multi-Page (Varias páginas), la lista desplegable For 
each (Para cada) estará disponible.

- Para cada: Page (Página): cada imagen de cada página 
digitalizada se convertirá en un archivo. Cuando abra un archivo, 
habrá dos imágenes, una para el anverso y otra para el reverso. 
Si está digitalizando en doble secuencia, tendrá cuatro imágenes.

- Para cada: Document (Documento): cada página digitalizada en 
un documento se convertirá en el contenido de un archivo. Puede 
haber varias (o muchas) imágenes en un archivo.

- Para cada: Batch (Lote): todas las imágenes digitalizadas en el 
lote se convertirán en un archivo de salida. Puede haber muchas 
imágenes en el archivo de salida.

2. Seleccione una opción en OCR Setting (Configuración de OCR) para 
equilibrar la velocidad y precisión según sus necesidades. Cuando mueve 
el selector a la derecha, se utilizan las herramientas adicionales, como los 
diccionarios de idiomas y varios motores de OCR, para mejorar la 
precisión.
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3. Cuando esté disponible, el OCR se aplicará para permitir la búsqueda de 
texto específico en los archivos de salida. Seleccione el idioma de OCR 
que contendrán los documentos digitalizados, de modo que el 
reconocimiento de caracteres sea lo más preciso posible. Si dispone de un 
conjunto de documentos variados que podría contener distintos idiomas, 
puede seleccionar uno o más idiomas secundarios.

4. Cuando agrupe por varias páginas, seleccione All (Todo) o Images 
(Imágenes) como un modo de seleccionar imágenes específicas para su 
inclusión en el archivo de salida.

• Si selecciona All (Todo), todas las imágenes del grupo de páginas, 
documentos o lotes seleccionado se incluirán en el archivo de salida.

• Si selecciona Images (Imágenes), solo las imágenes especificadas del 
grupo de páginas, documentos o lotes seleccionado se incluirán en el 
archivo de salida. Por ejemplo, si ha seleccionado Multi-Page (Varias 
páginas), agrupar por Document (Documento), y ha especificado un 
rango de salida “1, 10”, solo la primera y la décima imagen de cada 
documento se incluirán en el archivo de salida. Si un documento 
contiene menos de 10 imágenes, solo se incluirá la primera en el 
archivo de salida.

5. Cuando haya terminado, haga clic en OK (Aceptar).

Opciones de índice para 
Archivo (1) y Archivo (2)

Las opciones de índice para los destinos de salida File (1) (Archivo [1]) 
y File (2) (Archivo [2]) se configuran mediante la pestaña Output (Salida). 
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Hay tres opciones posibles de creación: Batch Index file (Archivo de índice 
de lote), Document Index file (Archivo de índice de documento) e Image 
Index file (Archivo de índice de imagen).

NOTA: Si desea generar un archivo de índice sin salida de archivo de imagen, 
seleccione el tipo de archivo de índice (lote, documento o imagen). 
Luego, seleccione el destino (Archivo [1] o Archivo [2]) y, por último, 
anule la selección de todos los tipos de salida (All, Black & White, 
Color/Grayscale [Todo, Blanco y negro, Color/Escala de grises]). La 
etiqueta File(1)/File(2) (Archivo [1]/Archivo [2]) cambiará a No images 
(Sin imágenes) para indicar que solo se generarán datos de índice.

Cada archivo de índice (es decir, de lote, de documento o de imagen) 
proporciona un botón Options (Opciones), un botón Setup (Configuración) 
y un botón Content (Contenido).

Options (Opciones): muestra el tipo de archivo de índice disponible:

• Capture Software 6.x (Software Capture 6.x): no se requiere configuración 
de propiedades. 

• Index to ODBC Database (Índice a base de datos ODBC): envía el lote 
seleccionado o las estadísticas de índice del documento a una base de 
datos compatible con ODBC.
- Batch index file (Archivo de índice de lote): un registro de la base de 

datos por lote que contiene las estadísticas de lote seleccionadas.
- Document index file (Archivo de índice de documento): un registro de la 

base de datos por documento que contiene las estadísticas de documento 
seleccionadas.
NOTA: Esta opción no está disponible para el índice de imagen.

• HVCS 16-bit Format (Formato HVCS de 16 bits): esta opción no está 
disponible para un archivo de índice de lote. El Formato HVCS de 16 bits 
permite definir el Client number (Número de cliente), que va del 1 al 999, 
y el Application number (Número de aplicación), que va del 1 al 9.

• Text (delimited) (Texto [delimitado]): permite seleccionar un formato de 
archivo de texto ASCII o Unicode.

• XML: no se requiere configuración de propiedades.

• Print Cover (Portada de impresión): permite agregar una portada al 
contenido del archivo durante la impresión.
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Setup (Configuración): muestra el cuadro de diálogo Location Setup 
(Configuración de ubicación), que permite crear un archivo de índice. Para 
obtener más información sobre este cuadro de diálogo, consulte la sección 
“Creación de fórmulas de ubicación y de nombre de archivo mediante el 
cuadro de diálogo Configuración de ubicación”, que aparece más adelante en 
este capítulo. 

Content (Contenido): muestra el cuadro de diálogo Index Content Setup 
(Configuración de contenido de índice), que permite definir el contenido del 
índice. Para obtener más información sobre este cuadro de diálogo, consulte 
la sección “Uso del cuadro de diálogo Configuración de contenido de índice”, 
que aparece más adelante en este capítulo.

Índice a base de datos ODBC Utilice este destino de salida del sistema si desea guardar los datos de índice 
en una fuente de datos compatible con ODBC, como SQL Server y 
Microsoft Access. En la salida, se utilizarán los campos de índice de 
documento y de lote para crear un nuevo registro para cada documento y se 
agregarán en la base de datos.

Se proporcionan tres campos de índice de documento adicionales que 
contienen la ruta de almacenamiento de las imágenes del documento. 
Si almacena todas las imágenes en una única ubicación, el campo Image 
Location – All (Ubicación de imágenes: todas) contendrá la ruta de las 
imágenes de cada documento. Si almacena imágenes en blanco y negro y en 
color/escala de grises en ubicaciones diferentes, los campos Image Location – 
Black & White (Ubicación de imágenes: blanco y negro) e Image Location – 
Color/Grayscale (Ubicación de imágenes: color/escala de grises) contendrán 
la ruta de los respectivos tipos de imágenes. Estos campos se pueden utilizar 
en la base de datos para asociar la imagen almacenada a los datos de índice 
de documento.

Supported Output files/Grouping (Archivos de salida compatibles/
Agrupación): varias páginas, por documento, todos los tipos de imagen.

Supported Channels (Canales compatibles): todo, blanco y negro, color/
escala de grises.

1. Acceda al destino de salida del sistema ODBC Database (Base de datos 
ODBC).
NOTA: Para obtener compatibilidad con Microsoft Access 2016, debe 

instalar MS Access Database Engine 2010 Redistributable desde 
la siguiente página web de Microsoft: https://www.microsoft.com/
en-us/download/details.aspx?id=13255

• Data Source name (Nombre de fuente de datos): acceda o cree una 
nueva fuente de datos de equipo o archivo.

• Database table (Tabla de base de datos): seleccione el control 
desplegable a fin de mostrar una lista de las tablas disponibles para la 
fuente de datos seleccionada. Seleccione la tabla en la que desea 
almacenar los datos de campos de índice.

2. Seleccione los campos que desee completar.
Comprobará que la columna izquierda de la cuadrícula de datos se ha 
completado con los nombres actuales de campos de índice de 
documento y lote. También hay tres campos de índice de documento 
adicionales: Image Location – All, Image Location – Black & White 
e Image Location – Color/Grayscale (Ubicación de imágenes: todas, 
Ubicación de imágenes: blanco y negro, y Ubicación de imágenes: color/
escala de grises).
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3. Para seleccionar un campo de índice que desee asignar a la tabla de la 
base de datos, haga clic en la columna derecha de la misma fila que el 
índice.

4. Haga clic en la flecha de control desplegable para mostrar una lista de los 
campos de tabla de datos disponibles y seleccionar un campo.

• Si ha seleccionado la casilla de verificación All (Todo) en la pestaña 
Output, System (1)/(2) (Salida, sistema [1]/[2]), el campo Image 
Location – All (Ubicación de imágenes: todo) contendrá la ruta de 
archivo y el nombre de la imagen. La ruta de archivo se creará 
agregando “\nombre de lote” y “\All” a la ruta de salida raíz. El nombre 
de la imagen será el número de secuencia del documento antecedido 
de ceros hasta alcanzar una longitud de ocho caracteres. La extensión 
del archivo estará determinada por el tipo de imagen seleccionado para 
la salida (tif, pdf, txt, etc.). Por ejemplo: 
“C:\BatchesPro\Lote001\All\00000001.tif”.

• Si seleccionó Black & White (Blanco y negro), la parte “\All” de la ruta 
de archivo se sustituirá por “\BW”.

• Si seleccionó Color/Grayscale (Color/Escala de grises), la parte “\All” 
de la ruta de archivo se sustituirá por “\CG”.

Varios registros por 
documento

Un documento puede contener varios elementos que se guardarán como un 
registro independiente en la base de datos. Por ejemplo, el siguiente 
documento contiene cuatro elementos.

Si desea guardar cuatro registros en la base de datos y cada uno de esos 
registros contiene tres campos: Description, Quantity y Price (Descripción, 
Cantidad y Precio):

1. Cree un campo de índice para cada campo de base de datos que se debe 
completar, por ejemplo, Descripción, Cantidad y Precio. Estos campos de 
índice se utilizarán para guardar los datos del primer conjunto de 
elementos.

2. Cree campos de índice para el resto de conjuntos de elementos. 
Los nombres de los campos de índice deben ser iguales a los del primer 
conjunto de elementos e ir seguidos de un número. Dichos números 
deben empezar en 1 y ser secuenciales. Por ejemplo:

Elemento de producto 2: “Descripción1”, “Cantidad1” y “Precio1”
Elemento de producto 3: “Descripción2”, “Cantidad2” y “Precio2”
Elemento de producto 4: “Descripción3”, “Cantidad3” y “Precio3”

Descripción Cantidad Precio
Elemento de producto 1 2 28,44
Elemento de producto 2 1 43,12
Elemento de producto 3 5 122,50
Elemento de producto 4 2 12,80
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3. Utilice el Asistente de búsqueda en la base de datos para asignar los 
nombres de los campos de índice del primer conjunto de elementos a los 
nombres de los campos de la base de datos. En el Asistente de búsqueda 
en la base de datos, solo se utilizan los nombres de los campos del primer 
conjunto de elementos.

Archivo de índice de lote Para configuración un archivo de índice de lote: 

1. Seleccione Batch Index file (Archivo de índice de lote).

2. Seleccione el tipo de archivo de índice que desee.

• Si selecciona Text (delimited) (Texto [delimitado]), haga clic en Options 
(Opciones) y en ASCII o Unicode. Luego, haga clic en OK (Aceptar).

3. Si lo desea, haga clic en Setup (Configuración) para mostrar el cuadro de 
diálogo Location Setup (Configuración de ubicación) y crear una ruta para 
el archivo de índice de lote generado. Consulte la sección “Creación de 
fórmulas de ubicación y de nombre de archivo mediante el cuadro de 
diálogo Configuración de ubicación”, que aparece más adelante en este 
capítulo.

4. Si lo desea, haga clic en Content (Contenido) para mostrar el cuadro de 
diálogo Index Content Setup (Configuración de contenido de índice) 
y definir el contenido del índice. De forma predeterminada, el archivo de 
índice de lote contendrá únicamente los índices de lote definidos para este 
trabajo. Utilice el botón Content (Contenido) para agregar o eliminar 
valores de índice o para reordenar índices en la salida. Consulte la 
sección “Uso del cuadro de diálogo Configuración de contenido de índice”, 
que aparece más adelante en este capítulo.

5. Cuando haya terminado, haga clic en OK (Aceptar).

Archivo de índice de 
documento

Para configurar un archivo de índice de documento: 

1. Seleccione Document Index file (Archivo de índice de documento).

2. Seleccione el tipo de archivo de índice que desee.

• Si selecciona Text (delimited) (Texto [delimitado]), haga clic en 
Options (Opciones) y en ASCII o Unicode. Luego, haga clic en OK 
(Aceptar).
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• Si selecciona HVCS 16-bit Format (Formato HVCS de 16 bits), haga 
clic en Options (Opciones) e introduzca los datos de Client number 
(Número de cliente), que va del 1 al 999, y de Application number 
(Número de aplicación), que va del 1 al 9. Luego, haga clic en OK 
(Aceptar).

3. Si lo desea, haga clic en Setup (Configuración) para mostrar el cuadro de 
diálogo Location Setup (Configuración de ubicación) y crear una ruta para 
el archivo de índice de documento generado. Consulte la sección 
“Creación de fórmulas de ubicación y de nombre de archivo mediante el 
cuadro de diálogo Configuración de ubicación”, que aparece más adelante 
en este capítulo.

4. Si lo desea, haga clic en Content (Contenido) para mostrar el cuadro de 
diálogo Index Content Setup (Configuración de contenido de índice) 
y definir el contenido del índice. De forma predeterminada, el archivo de 
índice de documento contendrá únicamente los índices de documento 
definidos para este trabajo. Utilice el botón Content (Contenido) para 
agregar o eliminar valores de índice o para reordenar índices en la salida. 
Consulte la sección “Uso del cuadro de diálogo Configuración de 
contenido de índice”, que aparece más adelante en este capítulo.

5. Cuando haya terminado, haga clic en OK (Aceptar).

Archivo de índice de imagen Para configurar un archivo de índice de imagen: 

1. Seleccione Image Index file (Archivo de índice de imagen).

2. Seleccione el tipo de archivo de índice que desee.

• Si selecciona Text (delimited) (Texto [delimitado]), haga clic en 
Options (Opciones) y en ASCII o Unicode. Luego, haga clic en OK 
(Aceptar).

• Si selecciona HVCS 16-bit Format (Formato HVCS de 16 bits), haga 
clic en Options (Opciones) e introduzca los datos de Client number 
(Número de cliente), que va del 1 al 999, y de Application number 
(Número de aplicación), que va del 1 al 9. Luego, haga clic en OK 
(Aceptar).

3. Si lo desea, haga clic en Setup (Configuración) para mostrar el cuadro de 
diálogo Location Setup (Configuración de ubicación) y crear una ruta para 
el archivo de índice de imagen generado. Consulte la sección “Creación 
de fórmulas de ubicación y de nombre de archivo mediante el cuadro de 
diálogo Configuración de ubicación”, que aparece más adelante en este 
capítulo.

4. Si lo desea, haga clic en Content (Contenido) para mostrar el cuadro de 
diálogo Index Content Setup (Configuración de contenido de índice) 
y definir el contenido del índice. De forma predeterminada, el archivo de 
índice de imagen contendrá únicamente los índices de imagen definidos 
para este trabajo. Utilice el botón Content (Contenido) para agregar 
o eliminar valores de índice o para reordenar índices en la salida. 
Consulte la sección “Uso del cuadro de diálogo Configuración de 
contenido de índice”, que aparece más adelante en este capítulo.

5. Cuando haya terminado, haga clic en OK (Aceptar).
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Creación de fórmulas de 
ubicación y de nombre 
de archivo mediante el 
cuadro de diálogo 
Configuración de 
ubicación

El cuadro de diálogo Location Setup (Configuración de ubicación) proporciona 
un listado de valores predefinidos y valores de índice configurados 
previamente, que permiten almacenar los archivos de salida en carpetas con 
nombres únicos que se puedan clasificar fácilmente.

Al hacer clic en Setup (Configuración) en la pestaña Salida: 
Destino\Archivo1 o Destino\Archivo2, se mostrará el cuadro de diálogo 
Location Setup (Configuración de ubicación). Utilice este cuadro de diálogo 
para confeccionar una fórmula que el software Capture Pro utilizará a la hora 
de crear y almacenar salidas.

• Para crear fórmulas de ubicación, abra la pestaña Location (Ubicación).

• Para crear fórmulas de nombre de archivo, abra la pestaña File name 
(Nombre de archivo) si aparece en este cuadro de diálogo. 

Los procedimientos para crear fórmulas de ubicación y fórmulas de nombre de 
archivo son iguales.

NOTA: Las opciones de las pestañas Location - Filename (Ubicación: Nombre 
de archivo) difieren en función del tipo de archivo de índice (es decir, 
lote, documento o imagen). No todas las opciones están disponibles 
para todos los tipos de archivo de índice.

1. Seleccione un valor predefinido en la lista de la parte izquierda de este 
cuadro de diálogo. La fórmula en uso actualmente se encuentra en el 
campo Filename Formula (Fórmula de nombre de archivo) de la parte 
derecha del cuadro de diálogo.

2. Haga clic en Add Item (Agregar elemento) para agregar el valor 
predefinido al final de la fórmula. Al especificar un nombre de ruta, el límite 
de longitud es de 248 caracteres.
NOTAS:
• Al hacer clic en Delete Item (Eliminar elemento), se elimina el valor 

predefinido al final de la fórmula.
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• Al hacer clic en Delete formula (Eliminar fórmula), se elimina la 
fórmula.

3. Si quiere definir dígitos de números secuenciales y agregar ceros a la 
izquierda de la secuencia numérica, active la opción Add leading zeros 
(Agregar ceros delanteros). Esta opción solo está disponible para valores 
numéricos.

4. Si ha activado la opción Add leading zeros (Agregar ceros delanteros), 
utilice el cuadro Number Length (Longitud de número) para indicar el 
número de dígitos (incluido cualquier cero delantero) del número de 
secuencia.

5. Si agrega <Image-side label> (<Etiqueta lateral de imagen>) al campo 
Filename Formula (Fórmula de nombre del archivo), se activan los 
cuadros de texto Front Color/Grayscale (Color/Escala de grises en primer 
plano), Front Black & White (Blanco y negro en primer plano), Back Color/
Grayscale (Color/Escala de grises en segundo plano) o Back Black & 
White (Blanco y negro en segundo plano). Si lo desea, introduzca 
etiquetas de texto en estos campos.

6. El área Duplicate file handling (Gestión de archivos duplicados) ofrece 
dos opciones. Seleccione una de estas opciones:

• Report an error and abort the output processing (Notificar un error 
y anular procesamiento de salida): genera un mensaje de error 
y detiene la salida del lote.

• Add a sequence number to the name (Agregar número de secuencia 
al nombre): añade un número de secuencia (p. ej., -001, -002) y sigue 
generando la salida del lote.

• Overwrite the file (Sobrescribir archivo): sobrescribe cualquier archivo 
existente en la carpeta de salida cuyo nombre esté duplicado. 
Los archivos existentes en la carpeta de salida que no se sobrescriban 
permanecerán en dicha carpeta.

7. Si selecciona Page Sequence Number (Número de secuencia de página) 
o Image Sequence Number (Número de secuencia de imagen), la opción 
Reset Feature (Restablecer función) estará disponible. Establezca el 
comportamiento de la numeración de secuencia para números de página 
y/o imagen.

• Comenzar por 1 para cada lote (disponible solo con Número de 
secuencia de página y Número de secuencia de imagen).

• Comenzar por 1 para cada documento (disponible solo con Número de 
secuencia de imagen).

• Continuar numeración de imágenes desde (disponible solo con 
Número de secuencia de imagen).

8. Haga clic en OK (Aceptar) para guardar la fórmula de salida.

NOTA: Multi-page formulas (Fórmulas de varias páginas): si seleccionó la 
salida de varias páginas para TIFF, PDF o Searchable PDF (PDF con 
capacidad de búsqueda), no puede agregar un número de secuencia 
de página o imagen, o una etiqueta lateral de imagen a la fórmula de 
ubicación o de nombre de archivo. De forma similar, si selecciona la 
salida de varias páginas a nivel de lote, no puede nombrar el archivo 
de salida con información más detallada que la información de nivel 
de lote.
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Uso del cuadro de 
diálogo Configuración de 
contenido de índice

1. Haga clic en Content (Contenido) para definir el contenido de índice del 
archivo de índice de salida. Se mostrará el cuadro de diálogo Index 
Content Setup (Configuración de contenido de índice).

Si está definiendo contenido de índice solo para el tipo de índice Text 
(delimited) (Texto [delimitado]), seleccione una entrada en los siguientes 
campos:

Las siguientes opciones solo se aplican al tipo de índice Text (delimited) 
(Texto [delimitado]):

2. Seleccione (tab) (tabulador) o (space) (espacio) en la lista desplegable 
Field delimiter (Delimitador de campos). También puede introducir 
manualmente otros caracteres como delimitador personalizado. 

3. Seleccione (none) (ninguno), single quote (') (comillas sencillas) 
o double quote (") (comillas dobles) en la lista desplegable Item delimiter 
(Delimitador de elementos).

4. Active la opción Include header record (Incluir registro de encabezado) 
si quiere incluir la información del encabezado del archivo de imagen en el 
archivo de índice de salida. 

Si está definiendo contenido de índice para el tipo de índice Text (delimited) 
(Texto [delimitado]) y para el tipo de índice XML, puede aplicar la siguiente 
opción: 

5. Seleccione cualquier elemento de la lista Available Indexes (Índices 
disponibles) y haga clic en Add (Agregar) para añadirlo a la lista Current 
Indexes (Índices actuales).

NOTAS: 

• Haga clic en Delete (Eliminar) para eliminar el elemento de índice 
seleccionado de la lista Current Indexes (Índices actuales). 

• Haga clic en Add All (Agregar todo) para mover todos los elementos de 
índice de la lista Available Indexes (Índices disponibles) a la lista Current 
Indexes (Índices actuales). 

• Haga clic en Remove All (Eliminar todo) para eliminar todos los elementos 
de índice de la lista Current Indexes (Índices actuales). 

• Haga clic en Move Up/Move Down (Desplazar hacia arriba/Desplazar 
hacia abajo) para mover el elemento de índice seleccionado un paso 
arriba/abajo en la lista Current Indexes (Índices actuales). 
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6. Cuando haya terminado, haga clic en OK (Aceptar).

Opciones Sistema (1) y 
Sistema (2)

Las opciones System (1) (Sistema [1]) y System (2) (Sistema [2]) permiten 
seleccionar un complemento de salida de lote para generar un lote con la 
estructura de archivo y el formato de archivo requeridos para muchos 
sistemas conocidos de gestión de contenido empresarial.

Opción System (1) (Sistema [1]): si se selecciona, active la casilla de 
verificación Send to (Enviar a) y, a continuación, seleccione un sistema 
(Destino de salida del sistema) en la lista desplegable. 

Para cambiar la configuración del sistema, haga clic en Setup (Configuración) 
y se mostrará un cuadro de diálogo específico para el destino de salida del 
sistema seleccionado. Para obtener información adicional sobre estos 
cuadros de diálogo, consulte la guía Destinos de salida del sistema (A-61638).

Para cambiar la ruta raíz de salida, haga clic en Setup (Configuración) y se 
mostrará el cuadro de diálogo Location Setup (Configuración de ubicación). 
Para obtener información adicional, consulte la sección “Creación de fórmulas 
de ubicación y de nombre de archivo mediante el cuadro de diálogo 
Configuración de ubicación”, que aparece anteriormente en este capítulo.

Seleccione un formato de archivo (TIFF, PDF, JPEG, PNG, etc.) para la salida. 
Las opciones de formato de archivo dependerán del tipo de salida Send to 
(Enviar a) que haya seleccionado. 

NOTA: Puede que las opciones All, Black & White y Color/Grayscale (Todo, 
Blanco y negro, y Color/Escala de grises) no estén disponibles para el 
destino de salida del sistema seleccionado. Si este es el caso, haga 
clic en el botón Setup (Configuración) para seleccionar las opciones 
de configuración.

Opción System (2) (Sistema [2]): si se selecciona, siga las mismas 
instrucciones que para Sistema (1).

More Output Formats (Más formatos de salida): ofrece una lista completa y 
enlaces a los destinos de salida del sistema Kodak Capture Pro y de sistemas 
de otros fabricantes que están disponibles en el sitio web de Kodak Alaris.
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Configuración de las 
opciones de correo 
electrónico

La opción E-mail (Correo electrónico) de la pestaña Output (Salida) permite 
configurar el software para enviar lotes de salida, con o sin datos de índice, 
por correo electrónico de forma automática.

1. Abra el cuadro de diálogo Job Setup (Configuración de trabajo) y haga clic 
en la pestaña Output (Salida).

2. Haga clic en la opción E-mail (Correo electrónico). Se abrirá el cuadro de 
diálogo Destination\E-mail (Destino\Correo electrónico).

3. Seleccione una aplicación de software de correo electrónico para el envío 
de correos electrónicos en la lista desplegable Aplicación de correo 
electrónico predeterminada.

4. Introduzca la información que quiere que aparezca como línea de asunto 
del correo electrónico en el campo Default title of e-mail (Título 
predeterminado de correo electrónico). A fin de seleccionar un valor 
predefinido para esta línea de asunto (p. ej., fecha, nombre, etc.), haga clic 
en Setup (Configuración). Se mostrará el cuadro de diálogode 
configuración del valor del campo de texto Título predeterminado de 
correo electrónico, donde puede seleccionar elementos adicionales para 
agregarlos al título del correo electrónico. 

• Seleccione los valores que quiera agregar al título del correo 
electrónico en la lista Predefined values (Valores predefinidos). 
Cada vez que añada un elemento, haga clic en Add Item 
(Agregar elemento).
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• Haga clic en OK (Aceptar) cuando haya terminado.

NOTA: Si quiere eliminar el último valor, haga clic en Delete Item 
(Eliminar elemento). Para eliminar toda la fórmula, haga clic 
en Delete Formula (Eliminar fórmula).

5. Introduzca el tamaño máximo permitido para un archivo adjunto al correo 
electrónico (en MB) en el campo Max size of attachments (Tamaño 
máximo de adjuntos).

6. Marque la opción Interactive (Interactivo) si quiere que se muestre una 
confirmación antes de enviar el correo electrónico.

NOTA: Si utiliza versiones más antiguas de Outlook Express como cliente de 
correo electrónico, debe activar esta opción; de no ser así, no se 
enviará el correo electrónico.

7. Introduzca una o varias direcciones de correo electrónico en los campos 
To (Para), CC y BCC, según corresponda. Las direcciones de correo 
electrónico deben ir entre comillas dobles (es decir, 
“CarlosGarcía@aol.com”).

8. Si lo desea, haga clic en Setup (Configuración) para agregar valores 
predefinidos a los nombres de los destinatarios de correo electrónico. 

9. Si va a incluir un adjunto, puede introducir el nombre de un adjunto 
o seleccionar valores predefinidos haciendo clic en Setup (Configuración). 
El nombre del adjunto debe ir entre comillas dobles (es decir, “Archivo del 
paciente”).

10. Active Include associated document index data (Incluir datos de índice 
de documento asociados) si quiere que los datos aparezcan de forma 
automática en el campo E-mail body (Cuerpo del correo electrónico). Para 
cambiar estos datos, haga clic en Setup (Configuración) y se mostrará el 
cuadro de diálogo de configuración del valor de campo de texto Cuerpo 
del correo electrónico.

• Introduzca el texto que quiere que aparezca en el correo electrónico. 
La información que introduzca debe ir entre comillas dobles (“ ”). 
También puede seleccionar cualquier valor de la lista Predefined values 
(Valores predefinidos) y hacer clic en Add Item (Agregar elemento). 

• Haga clic en OK (Aceptar) cuando haya terminado.
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11. Active la opción Save images to disk (Guardar imágenes en disco) si 
quiere guardar los archivos de la imagen de salida en el disco duro, 
además de enviar la salida del correo electrónico.

12. Haga clic en OK (Aceptar) cuando haya terminado.

NOTA: Si activa la opción Image (Imagen) en E-mail (Correo electrónico) en 
el lado izquierdo de la pestaña Output (Salida), puede activar las 
opciones de destino (TIFF, PDF, JPEG, PNG, etc.) en función del tipo 
de salida. 

Configuración de las 
opciones de impresión

La opción Print (Imprimir) permite imprimir la salida.

1. Haga clic en Print (Imprimir) en la pestaña Output (Salida) de la ventana 
Job Setup (Configuración de trabajo).

2. Seleccione la impresora que desee del cuadro desplegable Printer name 
(Nombre de impresora).
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3. Si quiere cambiar las propiedades de la impresora, haga clic en 
Properties (Propiedades). Se mostrarán las propiedades de la impresora 
seleccionada.

4. Cambie las propiedades de la impresora según lo desee y haga clic en OK 
(Aceptar).

5. Seleccione el número de copias que quiere imprimir en la lista desplegable 
y haga clic en OK (Aceptar).

Uso del asistente de 
configuración de 
indexación de 
SharePoint

La configuración de indexación de SharePoint proporciona una forma rápida 
y sencilla de configurar un trabajo del software Capture Pro para su uso con 
un sitio de SharePoint existente.

El asistente de configuración le indica cómo establecer conexión con el sitio 
de SharePoint, crear campos de índice para completar columnas de 
SharePoint y definir rutas para las imágenes.

El asistente distingue los tipos de datos de SharePoint y recomendará 
formatos de campo de índice para garantizar que la captura de datos tenga un 
formato adecuado y no quede fuera de rango. En el caso de las columnas de 
tipo “elección”, el asistente completará una lista desplegable con los valores 
de datos aceptados. 

El asistente de configuración de indexación de SharePoint consta de cuatro 
pasos:
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Paso 1. Configuración de 
SharePoint: creación, edición 
y selección de una conexión 
SharePoint

1. Seleccione una conexión al sitio de SharePoint donde desea colocar los 
datos y las imágenes de lote. En la conexión, se especifican los campos 
Host name (Nombre del host), Site name (Nombre del sitio) y Credentials 
(Credenciales) requeridos para acceder al sitio. Puede asignar un nombre 
explícito a la conexión para uso futuro.

Si no se han definido conexiones, se mostrará el cuadro de diálogo para crear 
una conexión a SharePoint.

1. Introduzca un nombre para la conexión. Este nombre se utilizará para 
referirse a este sitio de SharePoint específico.

2. Si va a acceder al sitio de SharePoint con su ID de inicio de sesión 
y contraseña de Windows, seleccione Use Windows login and password 
(Utilizar inicio de sesión y contraseña de Windows). 

3. Para acceder al sitio de SharePoint utilizando sus credenciales de 
SharePoint, seleccione Use SharePoint account (Utilizar cuenta de 
SharePoint) y complete los campos User Login (ID de inicio de sesión del 
usuario) y Password (Contraseña).

4. Complete el campo Host name (Nombre del host). Por ejemplo: 
https://my-SharePoint-host.

5. Complete el campo Site name (Nombre del sitio). Si el nombre del host 
y las credenciales son correctos, puede hacer clic en Browse (Examinar) 
para seleccionar los sitios disponibles.

NOTAS:

• Antes de desplazarse por un sitio de SharePoint, asegúrese de tener los 
permisos necesarios para acceder a todos los subsitios. Para comprobar el 
acceso, primero vaya a //<server>/_vti_bin/Lists.asmx. Si se muestran 
errores, verifique la configuración y los permisos de sitios de SharePoint.

• Para acceder a una cuenta de Office 365 SharePoint Online, seleccione 
SharePoint Online. 

• Antes de poder acceder a una cuenta de Office 365 SharePoint Online, 
debe instalar SharePoint Server 2013 Client Components SDK y Windows 
Identity Foundation. Ambos componentes están disponibles en el Centro de 
descargas de Microsoft.
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• Para determinar el nombre de host, utilice un navegador web y desplácese 
hasta su sitio O365. Anote la URL que aparece en la barra de direcciones 
del navegador. Normalmente, el nombre del host es la primera parte de la 
URL y termina antes de /_layouts/...

Paso 2. Creación de campos 
de índice de documento 
basados en las columnas de 
SharePoint existentes

Las columnas de SharePoint se mostrarán después de seleccionar tanto una 
de las listas disponibles de SharePoint encontradas en el sitio de SharePoint 
como la opción Document Type (Tipo de documento).

Se mostrará Column Type (Tipo de columna) y se activará la casilla de 
verificación Required (Obligatorio) si la lista de SharePoint necesita la 
columna.

De forma predeterminada, la casilla de verificación Create Index 
(Crear índice) estará activada para todos los tipos de columna que pueden 
completarse mediante los campos de índice creados y configurados 
automáticamente. Si no desea completar una columna determinada o si no 
desea que un nuevo campo de índice complete una columna determinada, 
desactive la casilla de verificación Create Index (Crear índice). Si desea crear 
un campo de índice para una columna de SharePoint que no está activada, 
active la casilla de verificación Create Index (Crear índice) y haga clic en Edit 
(Editar) para configurar el campo de índice. Más adelante, puede especificar 
los datos que se almacenarán en una columna.

Un ejemplo de cuándo anular la selección de la casilla de verificación Create 
Index (Crear índice) es si la columna de SharePoint Full Name (Nombre 
completo) debe contener el nombre de una persona con el formato “apellido, 
nombre”. Se utilizarán dos campos de índice existentes, “Nombre” 
y “Apellido”, para completar esta columna. La asignación de estos dos 
campos de índice se llevará a cabo más adelante. De momento, desactive la 
casilla de verificación Create Index (Crear índice) para la columna Full Name 
(Nombre completo), ya que no se necesita este campo de índice.

Se recomendará un tipo de Input Format (Formato de entrada) para cada 
nuevo campo de índice en función de los requisitos de la columna de 
SharePoint. No es necesario cambiar el formato recomendado, a menos que 
desee aplicar mayores restricciones al rango o al tipo de datos.



100 A-61993_es  Marzo de 2022
 

Se mostrará Default Value (Valor predeterminado) si se ha especificado 
alguno para la columna en SharePoint. Puede cambiar un valor existente 
o añadir un valor predeterminado si este no se muestra al seleccionar la lista 
desplegable. Se mostrará una lista de valores predefinidos, incluida cualquier 
zona de código de barras, OCR o detección de marcas que se haya definido. 
Si necesita un valor predeterminado más complejo, seleccione Edit (Editar). 
Puede definir el valor predeterminado utilizando una o varias etiquetas 
predeterminadas o cadenas fijas.

La columna Status (Estado) indicará si hay algún problema con la creación de 
un campo de índice. Si selecciona una fila con la indicación, se mostrará un 
mensaje de estado en el área debajo del botón Edit (Editar). Este símbolo 
indica que el campo de índice no se creará para esta columna de SharePoint. 
En la mayoría de los casos, esto se debe a que la aplicación no puede crear el 
tipo de columna automáticamente. Por ejemplo, el tipo de columna Calculated 
(Calculado) necesita referencias a otras columnas de SharePoint que la 
aplicación desconoce. Puede crear un campo de índice para esta columna 
seleccionando la opción Create Index (Crear índice).

Si selecciona una fila con la indicación , se mostrará un mensaje de estado 
en el área debajo del botón Edit (Editar). El mensaje de estado describe el 
problema y el modo en que se puede resolver. Este símbolo indica que hay un 
problema con la creación del campo de índice que debe solucionarse antes de 
continuar. Puede desactivar la casilla de verificación Create Index (Crear 
índice) si no se necesita el campo de índice. 

Para añadir o editar otros parámetros de campo de índice, como Output 
format (Formato de salida), , Substitute Characters (Sustituir caracteres) y List 
(Lista) (en el caso de los campos de índice desplegables), seleccione la fila 
del campo de índice correspondiente y haga clic en Edit (Editar).

Paso 3. Configuración de 
SharePoint: Selección de 
valores para rellenar las 
columnas de SharePoint

Una vez creados los campos de índice, puede utilizarlos junto con los valores 
del sistema (nombre del trabajo, nombre del lote, fecha, hora, etc.), los valores 
de la zona de OCR, código de barras o detección de marcas, o una 
combinación de estos valores para completar las columnas de SharePoint.
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Las columnas de SharePoint que requieren un valor se muestran en la parte 
superior. De forma predeterminada, el campo de índice creado en el paso 2 se 
utiliza para completar la columna. Para establecer un valor diferente, 
seleccione la columna SharePoint y, a continuación, el icono de control de 
cambio. Puede seleccionar uno o varios elementos de la lista, incluidas 
cadenas de texto fijo entre comillas dobles, por ejemplo, "Creado: 
"<FECHA_DDMMYY>.

Las columnas de SharePoint que no se hayan incluido en el paso 2 (casilla de 
verificación Create Index [Crear índice] desactivada) no mostrarán ningún 
valor predeterminado. Esto se debe a que no se ha creado un campo de 
índice para esta columna. Puede definir un valor para esta columna mediante 
otros campos de índice, valores del sistema, valores de zonas de código de 
barras, de detección de marcas y de OCR, o mediante una combinación de 
estos valores.

NOTA: La columna SharePoint Name definirá el nombre del archivo 
almacenado en SharePoint. En el paso 4, se describe cómo agrupar 
imágenes.

Si las agrupa con la opción Multi-Page (Varias páginas) para cada documento 
especificado, cada uno de ellos deberá tener un nombre único. Por ejemplo, 
Name (Nombre) puede ser <DOCUMENTO_NÚMERODESECUENCIA>.

Si las agrupa con la opción Single page (Una página), cada imagen debe 
tener un nombre único. Esto significa que la columna Name (Nombre) debe 
contener un valor único para cada imagen. Por ejemplo, Name (Nombre) 
puede ser <IMAGEN_NÚMERODESECUENCIA_DOCUMENTO>.

Paso 4. Configuración de 
SharePoint: definición de 
rutas y opciones de 
almacenamiento

El último paso consiste en especificar el formato de las imágenes y la 
ubicación donde desea almacenarlas en SharePoint.

La ruta en Starting Folder (Carpeta de inicio) es la ruta a una carpeta existente 
en el sitio de SharePoint actual. Las rutas de imágenes que se especifiquen 
para All (Todo), Black & White (Blanco y negro) y Color/Grayscale (Color/
Escala de grises) comenzarán en esta carpeta. Puede seleccionar Setup 
(Configuración) para ver las carpetas disponibles.
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Si tiene imágenes en blanco y negro y en color/escala de grises, y todas las 
imágenes se van a almacenar en la misma ubicación con el mismo formato de 
imagen, active la casilla de verificación All (Todo).

Seleccione el tipo de archivo (Texto, TIFF, PDF, etc.) para la salida. Seleccione 
Options (Opciones) para configurar el formato de archivo del tipo de archivo 
seleccionado. Para obtener una descripción de los cuadros de diálogo de 
formato de archivo, consulte la sección “Opciones de configuración para 
Archivo (1) y Archivo (2)” en Configuración de trabajo: pestaña Captura”, que 
aparece más adelante en este capítulo.

Puede especificar la ubicación de la carpeta de imágenes en el cuadro debajo 
del tipo de archivo. Seleccione Setup (Configuración) para crear la ubicación 
de carpeta desde los valores de índice de campo y de sistema disponibles.

NOTA: Los botones de configuración le permiten especificar la ruta y el 
nombre de la carpeta donde desea almacenar las imágenes 
(documentos de SharePoint). Cada documento debe tener un nombre 
y una ruta únicos para evitar que se sobrescriba. Si se ha configurado 
el control de versiones, puede que se produzca un error de nombre de 
archivo duplicado. Compruebe que el campo Name (Nombre) de 
SharePoint que elija en el paso 3 sea compatible con la ruta y la 
selección de agrupamiento de imágenes.

Si solo tiene imágenes en blanco y negro o color/escala de grises, o si desea 
tener distintos tipos de archivo para las imágenes en blanco y negro o color/
escala de grises, seleccione las casillas de verificación Black & White 
(Blanco y negro) y Color/Grayscale (Color/Escala de grises).

Para proteger documentos en una biblioteca de documentos de SharePoint 
que tiene la función de control de versiones activada, seleccione la casilla de 
verificación Check in after uploading (Proteger tras la carga). Si la lista de 
SharePoint no tiene activado el control de versiones, aparecerá una 
advertencia y se desactivará la casilla. Puede proteger documentos con un 
número de versión principal (1.0) o con un número de versión secundario 
(0.1). Si SharePoint no está configurado para permitir números de versión 
secundarios, se mostrará una advertencia y se seleccionará el número de 
versión principal.

NOTA: Cuando la función de control de versiones de SharePoint esté 
activada, es posible que deba configurar SharePoint de modo que la 
función Require check out (Requerir desprotección) esté activada.

Durante la protección, puede incluir un Check In Comment (Comentario de 
protección). El comentario puede ser un mensaje de texto fijo o puede hacer 
clic en Setup (Configuración) para crear un comentario mediante los valores 
de índice y del sistema. Por ejemplo: <NOMBRE_ESTACIÓN>": " 
<NOMBRE_USUARIO>.

El índice predefinido Image Sequence number (batch) (Número de 
secuencia de imagen [lote]) se puede iniciar en un número específico si se 
activa la casilla de verificación Continuous image numbering from 
(Numeración de imágenes continua desde) y se proporciona un valor inicial.

NOTAS:

• Al activar la casilla de verificación Continuous image number from 
(Numeración de imágenes continua desde), no se cambia el valor de inicio 
del número de secuencia de imagen (documento).

• Antes de iniciar el asistente, es recomendable crear las zonas de códigos 
de barras, detección de marcas y OCR que desee incluir en la salida 
a SharePoint.
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Inicie el asistente de configuración de indexación de SharePoint de la 
siguiente manera:

• Seleccione File > Job Setup (Archivo > Configuración de trabajo) y, 
a continuación, seleccione el botón SharePoint Index Setup Wizard 
(Asistente de configuración de indexación de SharePoint) en la parte 
inferior del cuadro de diálogo Configuración de trabajo.

Autenticación 
moderna de 
SharePoint

Esta función permite activar la autenticación moderna para SharePoint Online 
desde el asistente de configuración de indexación de SharePoint.

NOTA: Esta función se inhabilita cuando está marcada la opción Use 
Windows login and password (Utilizar inicio de sesión y contraseña 
de Windows). 

Para crear una conexión de SharePoint Online:

1. Haga clic en el botón de opción para activar Use SharePoint account 
(Utilizar cuenta de SharePoint) y marque la casilla SharePoint Online.

2. Marque la casilla Modern Authentication (Autenticación moderna), lo que 
iniciará la autenticación de dos factores basada en la web para completar 
la configuración de SharePoint Online.

3. En la ventana emergente de inicio de sesión, introduzca el nombre de 
usuario de su cuenta de SharePoint Online.
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4. Cuando el sistema confirme la validez del nombre de usuario, introduzca 
la contraseña de SharePoint Online para completar el primer factor de 
autenticación.

5. Introduzca el código de verificación que recibirá en su teléfono para 
completar el segundo factor de autenticación.

6. Tras iniciar sesión correctamente en SharePoint Online, aparecerá un 
mensaje que confirma la conexión cuando haga clic en Test Connection 
(Probar conexión).
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Si la sesión no se inicia correctamente, aparecerá un mensaje de error.

7. Después de iniciar sesión correctamente en SharePoint Online, aparecerá 
una ventana emergente que le permitirá elegir la opción Yes (Sí) para 
mantener activa la sesión de SharePoint o la opción No (No) para cerrar la 
sesión cuando finalice. Si elige Yes (Sí), la ventana emergente de inicio de 
sesión no se mostrará cuando intente conectarse a SharePoint en el 
futuro.

NOTA: Si selecciona la salida de lote, se utiliza el mismo proceso de 
autenticación de dos factores para iniciar la conexión, y los archivos 
se cargan en el sitio de SharePoint Online tras iniciar sesión 
correctamente.

Opciones avanzadas Cuando seleccione Advanced Options (Opciones avanzadas), estarán 
disponibles las opciones que figuran a continuación. 

Auto-Deletion (Eliminación automática): elimina una imagen del anverso o el 
reverso cuando el tamaño de la imagen es inferior a los valores especificados 
en el cuadro de diálogo Auto-Deletion (Eliminación automática).

Auto-Orientation (Orientación automática): analiza el contenido de los 
documentos y orienta cada documento, de modo que se lea correctamente. 

Background Color Smoothing (Suavizado de color de fondo): si se utiliza 
esta opción para documentos o formularios con color de fondo, ayudará a 
producir imágenes con un color de fondo uniforme.

Image Edge Fill (Relleno de bordes de imagen): rellena los bordes blancos 
o negros no deseados en una imagen, lo que produce una imagen más limpia.

Image Stamping (Sello de imagen): sella el número de la imagen en el 
anverso o el reverso de cada imagen. 

Rotate (Girar): rota todas las imágenes de un lote 0º, 90º, 180º o 270º según 
la selección.

Stitch (Fusionar): fusiona todas las imágenes de un documento en un único 
archivo de salida. Las imágenes deben tener la misma anchura y todas 
(excepto la última imagen) deben tener la misma longitud.
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Split (Dividir): convierte la imagen del anverso y del reverso en varias 
imágenes. Las imágenes deben ser del mismo tipo (color/escala de grises 
o blanco y negro).

Para acceder a las opciones de procesamiento de imágenes:

1. Haga clic en Image Processing (Procesamiento de imágenes) en la 
sección Advanced Options (Opciones avanzadas) de la pestaña Output 
(Salida). 

2. Seleccione la opción de procesamiento de imágenes deseada 
y configúrela como sea necesario. 

NOTA: Las secciones siguientes proporcionan información detallada sobre 
cada opción.

Eliminación automática La opción Auto-Deletion (Eliminación automática) permite configurar opciones 
para eliminar de forma automática una imagen sin contenido o con páginas 
con gran cantidad de contenido (p. ej., el reverso de un formulario que 
contenga mucho texto explicativo). Los valores de eliminación automática se 
especifican de forma independiente para las imágenes del anverso y del 
reverso. 
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Si va a digitalizar tipos de imágenes tanto en color como en escala de grises 
y en blanco y negro, la configuración de eliminación automática también se 
especifica de forma independiente. Por lo tanto, puede seleccionar que se 
elimine solo el tipo de imagen seleccionado.

Cuando se utiliza Auto-Deletion (Eliminación automática), es recomendable 
utilizar la opción Test (Probar) para digitalizar algunos documentos 
representativos que considere que están en blanco o casi en blanco. 
Los resultados de la opción Test (Probar) le ayudarán a determinar si debería 
especificar configurar los valores de eliminación automática mediante la 
opción Image size (byte) is (Tamaño de la imagen [bytes]) o la opción Image 
content (%) (Contenido de la imagen [%]). 

• Image size (byte) is Above (Tamaño de la imagen [bytes] superior a): 
seleccione esta opción si quiere eliminar páginas con una gran cantidad de 
contenido recargado y explicativo. Por ejemplo, si está digitalizando el 
anverso y el reverso de documentos con contenido similar (como 
formularios de seguros) y el anverso incluye contenido que necesita 
conservar, pero el reverso contiene instrucciones sobre cómo presentar una 
reclamación (que no necesita conservar), introduzca el número de bytes por 
encima del que el software Capture Pro debe eliminar cualquier archivo de 
imagen. Cualquier imagen con un valor superior a este se considerará 
demasiado grande y se eliminará. 

• Image size (byte) is Below (Tamaño de la imagen [bytes] inferior a): 
seleccione esta opción si quiere eliminar páginas en blanco o con poco 
contenido. Introduzca el número de bytes que el software Capture Pro 
considerará como el tamaño de imagen en blanco. Cualquier imagen con 
un valor inferior a este se considerará que está en blanco y se eliminará.

• Image content (%) is Above (Contenido de la imagen [%] superior a): esta 
opción es similar a la opción Image size (byte) Above (Tamaño de la 
imagen [bytes] superior a), excepto por el hecho de que el usuario introduce 
un valor porcentual por encima del cual el software Capture Pro considerará 
que la imagen tiene demasiado contenido. Cualquier imagen con un 
contenido superior a este valor se eliminará. 
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• Image content (%) is Below (Contenido de la imagen [%] inferior a): esta 
opción es similar a la opción Image size (byte) Below (Tamaño de la 
imagen [bytes] inferior a), excepto por el hecho de que introduce un valor 
porcentual por el que el software Capture Pro considerará que la imagen 
está en blanco o tiene poco contenido. Cualquier imagen con un valor 
inferior a este se considerará que está en blanco y se eliminará. Utilice este 
ajuste cuando haya páginas en blanco. 

NOTAS:

• Cuando seleccione la opción Image size (byte) (Tamaño de la imagen 
[bytes]), otros factores como la resolución, la compresión, etc. afectarán al 
tamaño de la imagen. 

• La opción Image content (%) (Contenido de la imagen [%]) solo se fija en 
el porcentaje de información en la imagen y, por tanto, es una opción más 
coherente y fiable para usar cuando puede variar de tamaño, la resolución, 
la compresión, etc. de la imagen.

Never (Nunca): haga clic en Never (Nunca), si no desea eliminar ninguna 
imagen.

Keep blank images (Mantener imágenes en blanco): cuando esta opción está 
activada (marcada), las imágenes se resaltan en lugar de eliminarse.

Para marcar las imágenes en blanco, es posible hacer clic en Mark as blank 
(Marcar como imagen en blanco) en el menú Tools (Herramientas) 

o hacer clic con el botón secundario en las imágenes seleccionadas y elegir 
Mark as blank (Marcar como imagen en blanco). 

Esta opción está activada solamente cuando se seleccionan imágenes y están 
resaltadas con un borde rojo en el visor de imágenes.

NOTAS:

• Los archivo de índice de imagen se completan con la etiqueta 
“<IMG_MARKBLANK>” cuando Image marked as blank (Imagen marcada 
como imagen en blanco) se agrega a la columna Current indexes: (Índices 
actuales:) en el cuadro de diálogo Index Content Setup (Configuración de 
contenido de índice). 

• <IMG_MARKBLANK> = 1 si una imagen se marca como imagen en blanco; 
de lo contrario, el valor = 0.

Orientación automática Esta opción analiza el contenido de los documentos y orienta cada documento 
para que se lea correctamente. 
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La orientación automática no funciona con todos los conjuntos de caracteres. 
Se recomienda digitalizar algunos documentos de prueba para asegurarse de 
que el documento estará bien orientado.

• Puede seleccionar Enable auto-orientation on front (Activar orientación 
automática en el anverso) o Enable auto-orientation on back (Activar 
orientación automática en el reverso).

NOTA: La orientación automática se realizará durante el proceso de 
creación de salida.

Suavizado de color de fondo Esta opción se puede utilizar para documentos o formularios con un color de 
fondo o para ayudar a producir imágenes con un color de fondo uniforme. 

Las opciones de suavizado se pueden aplicar al anverso o al reverso de una 
página.

Antes del suavizado de 
color de fondo

Después del suavizado de 
color de fondo
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Puede seleccionar los siguientes tipos de suavizado:

None (Ninguno): no se realizará ningún suavizado de fondo; la imagen no 
cambiará.

Automatic (Automático): los colores de fondo se seleccionarán y se 
suavizarán de forma automática.

Change to White (Cambiar a blanco): identifica hasta tres colores de fondo 
y sustituye cada uno de ellos por blanco. Si selecciona esta opción, el cuadro 
desplegable Apply to (Aplicar a) estará disponible para que pueda seleccionar:

• Predominant (Predominante): solo el color de fondo más habitual cambiará 
a blanco.

• Neutral (Neutro): solo el color de fondo neutro cambiará a blanco.

• All (Todos): los colores de fondo cambiarán a blanco.

Aggressiveness (Agresividad): controla la cantidad de variabilidad que se 
puede corregir en los colores de fondo. Seleccione un valor entre 1 y 20.

Preview (Vista previa): abre el cuadro de diálogo Vista previa de suavizado 
del color de fondo, que permite comparar la imagen original con la imagen 
modificada, además de modificar la configuración.

Relleno de bordes de imagen La opción Image Edge Fill (Relleno de bordes de imagen) permite rellenar 
y limpiar los bordes no deseados de una imagen digitalizada para cubrir el 
área en Black (Negro) o White (Blanco), según se seleccione. Esta opción se 
puede aplicar al anverso o al reverso de una imagen.

Es posible que le interese utilizar esta opción si tiene páginas con agujeros de 
perforadora o con imágenes irregulares que desee limpiar.

Original: perforadora de tres 
agujeros sin relleno de bordes 

de imagen

Imagen de 37centésimas de 
pulgada que rellena la mitad 
del agujero. El valor no es 

suficiente.

Imagen de 62centésimas de 
pulgada que rellena el agujero 

y conserva todo el texto. 
El valor es aceptable.

Imagen de 150: rellena todo el 
agujero Y parte del texto. 

El valor es demasiado grande. 
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•  Seleccione un valor en las áreas Top (Superior), Left/Right (Izquierda/
Derecha) o Bottom (Inferior) de cada lado de la imagen digitalizada para 
rellenarla en centésimas de pulgada, o seleccione All sides match (Todos 
los lados iguales) para rellenar la misma cantidad en todos los lados.

NOTA: Cuando utilice la opción Image Edge Fill (Relleno de bordes de 
imagen), asegúrese de no introducir un valor muy alto, ya que puede 
rellenar los datos de las imágenes que desea mantener. 

Sello de imagen La opción Image stamping (Sello de imagen) inserta información como la hora, 
la fecha, varios números de secuencia y el nombre del lote o del trabajo en la 
imagen digitalizada. El cuadro de diálogo Image Stamping (Sello de imagen) 
permite colocar esta información en varias ubicaciones del anverso o el 
reverso de la página. El anverso y el reverso de una página se pueden 
configurar por separado. 

Front/Back (Anverso/Reverso): Stamp String (Cadena de sellos): haga clic 
en Setup (Configurar) para visualizar el cuadro de diálogo de configuración de 
cadena de sellos. Puede combinar uno o varios elementos de la lista para 
elaborar una fórmula de cadena de sellos. Para obtener más información, 
consulte el apartado “Creación de fórmulas de ubicación y de nombre de 
archivo mediante el cuadro de diálogo Configuración de ubicación” en la 
sección “Opción de configuración para Archivo (1) y Archivo (2)”, que aparece 
anteriormente en este capítulo. 

Location (Ubicación): Top (Arriba) o Bottom (Abajo): coloca el sello en la 
parte superior o inferior de la imagen, según se seleccione. 

Location (Ubicación): Left (Izquierda), Middle (Centro) o Right (Derecha): 
coloca el sello a la izquierda, en el centro o a la derecha de la imagen, según 
se seleccione.

Margin (Margen): seleccione un tamaño de margen en centésimas de 
pulgada para indicar a qué distancia del margen superior, inferior, izquierdo 
o derecho desea que se coloque el sello.
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Font Size (Tamaño de fuente): seleccione el tamaño de fuente del sello: 
16 o 18 puntos.

Bold (Negrita): active esta casilla de verificación para la impresión en negrita.

Copy front to back (Copiar anverso en reverso): si desea establecer en el 
reverso la misma configuración que en el anverso, active esta casilla de 
verificación.

Configuración de una cadena 
de sellos

Para configurar una cadena de sellos de imagen, realice los siguientes pasos:

1. Haga clic en Setup (Configurar) en la sección Front (Anverso) o Back 
(Reverso). Se mostrará el cuadro de diálogo Stamp String Setup 
(Configuración de secuencia de sello).

2. Seleccione los elementos en la lista de fórmulas disponibles de cadenas 
de sellos que desee incluir en la cadena de sellos. Para cada elemento 
que seleccione, haga clic en Add Item (Agregar elemento).

NOTAS:

• Los campos Add leading zeros (Agregar ceros delanteros) y Number 
length (Longitud del número) pasan a estar disponibles cuando se 
selecciona lo siguiente: Document ID, Page Sequence Number, 
Image Sequence Number, Image Address Level 1, Image Address 
Level 2 o Image Address Level 3 (ID de documento, Número de 
secuencia de página, Número de secuencia de imagen, Nivel 1 de 
dirección de imagen, Nivel 2 de dirección de imagen o Nivel 3 de 
dirección de imagen). Cuando seleccione Page Sequence Number 
(Número de secuencia de página) o Image Sequence Number 
(Número de secuencia de imagen), también tendrá la posibilidad de 
especificar cuándo debe restablecerse el número de secuencia de 
página o de imagen, así como el valor al que debe restablecerse.

• Para eliminar un elemento de la fórmula de cadena de sellos, haga clic 
en Delete Item (Eliminar elemento).

• Para eliminar una fórmula completa de la fórmula de cadena de sellos, 
haga clic en Delete Formula (Eliminar fórmula).

3. Cuando haya terminado de definir la cadena de sellos, haga clic en OK 
(Aceptar).
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4. Defina la ubicación de la cadena de sellos especificando la colocación del 
sello de imagen en cada lado de la página. Margin (Margen) define el 
tamaño del borde entre el texto y los bordes de página adyacentes 
(el borde derecho o izquierdo horizontalmente y el borde superior o inferior 
verticalmente). Si selecciona Middle (Centro), el margen solo se aplica 
a la dimensión vertical.

5. Seleccione el tamaño de fuente que desee: 16 o 18.

6. Si desea negrita, haga clic en Bold (Negrita).

7. Seleccione Copy front to back (Copiar anverso en reverso) si desea 
duplicar la misma cadena de sellos especificada en el anverso en ambos 
lados; de lo contrario, siga configurando la cadena de sellos del reverso.

8. Cuando haya terminado, haga clic en OK (Aceptar).

NOTA: El software Capture Pro no intenta ajustar el texto a la región de sello 
de imagen. Si un sello de imagen es más grande que la región 
asignada para ello, se truncará el texto que sobra. El tamaño del sello 
de imagen es difícil de predecir y depende de la complejidad de la 
fórmula, del tamaño de la fuente, de los márgenes asignados y de la 
cadena en sí. Se recomienda realizar una digitalización de prueba 
para asegurarse de que la cadena especificada no sea demasiado 
grande para ajustarse a la región de sello.

Girar La opción Rotate (Girar) permite seleccionar la rotación deseada de 0º, 90º, 
180º o 270º. El grado de rotación se aplica a todas las imágenes del lote.

Unir Cuando la opción Stitch (Unir) está seleccionada, todas las imágenes del 
documento se fusionan en un único archivo continuo. 
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NOTA: Para utilizar esta función de forma eficaz, todas las imágenes deben 
tener la misma anchura y longitud. Se puede utilizar una configuración 
de página para modificar la anchura de imagen. Todas las imágenes, 
excepto la última, deben tener la misma longitud.

Dividir Cuando la opción Split (Dividir) está seleccionada, la imagen del anverso y del 
reverso se convierten en varias imágenes (hasta 6). Las imágenes deben ser 
del mismo tipo (color/escala de grises o blanco y negro). 

Split Page or Image (Dividir página o imagen): marque esta casilla 
verificación para activar la opción Split (Dividir).

Number of resultant images (Número de imágenes resultantes): seleccione 
en la lista desplegable las imágenes que quiera dividir, de 2 a 6.
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Split image if width is between (Dividir imagen si la anchura está entre): 
utilice las dos listas desplegables para seleccionar un intervalo de anchuras 
para la página o la imagen. Si la anchura de página está dentro de este 
intervalo, entonces se dividirá. Si el anverso o el reverso de lapágina quedan 
fuera de rango, no se dividirá ninguna de las dos caras.

Front (Anverso) o Back (Reverso): active esta casilla para activar la división 
de anverso o reverso. Aparecerá un gráfico que muestra su selección. 
Por ejemplo, si activa las dos casillas de verificación, los dos iconos de libro 
aparecerán con un símbolo “X” de color rojo en cada página:

NOTA: Si utiliza un escáner solo símplex, seleccione solamente Front 
(Anverso). Si se selecciona Front (Anverso) y Back (Reverso), no se 
producirá ninguna división. 

Output order (Orden de salida): en este campo se muestra el orden de 
página. Haga clic en cada segmento de imagen en el que orden en el que 
desea que aparezcan las imágenes durante la salida. Al hacer clic en un 
segmento de imagen, el símbolo “X” rojo desaparece.

Cualquier segmento de imagen que todavía esté marcado con el símbolo “X” 
rojo se eliminará y no se enviará a la salida. Esta opción puede resultar útil 
para la última página de un panfleto que siempre está en blanco.

Reset Order (Restablecer orden): cualquier orden especificado originalmente 
se eliminará y podrá volver a ordenar las imágenes.
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Opción Invocar otro 
programa

La opción Invoke Other Program (Invocar otro programa) de la pestaña Output 
(Salida) permite utilizar una aplicación distinta del software Capture Pro para 
realizar cambios en la salida. Seleccione la casilla de verificación para activar 
esta opción.

Program Name (Nombre de programa): introduzca el nombre de la 
aplicación. Si es necesario, haga clic en Browse (Examinar) para buscar la 
aplicación.

Parameters (Parámetros): los parámetros pueden ser cualquier combinación 
de cadenas de texto literales y valores variables que se determinan en el 
momento de generar el lote. Los valores variables se definen al hacer clic en 
Select (Seleccionar).

Las cadenas de texto literales se pueden escribir en el cuadro de texto 
Parameters (Parámetros) o en la ventana de fórmulas de parámetros del 
cuadro de texto Configuración de parámetros. Las cadenas literales deben 
separarse por espacios. Las cadenas literales que incluyen espacios deben 
incluirse entre comillas dobles. 

Para agregar un parámetro variable:
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1. Haga clic en Select (Seleccionar) para visualizar el cuadro de diálogo 
Parameter Setup (Configuración de parámetros) y poder configurar los 
parámetros variables.

2. Seleccione el parámetro que desee agregar en la lista Available 
parameters (Parámetros disponibles). 

3. Haga clic en Add Item (Agregar elemento).

NOTAS:

• Haga clic en Delete Item (Eliminar elemento) para eliminar un parámetro de 
la fórmula de parámetros, o haga clic en Delete Formula (Eliminar fórmula) 
para eliminar toda la fórmula de parámetros. 

• También puede introducir cadenas literales en el cuadro de diálogo 
Parameter Formula (Fórmula de parámetros). Los parámetros variables se 
añaden a la fórmula incluidos entre las marcas <> (por ejemplo, 
<NOMBRE_LOTE>). 

Cuando se envía el lote, se sustituye el valor actual y el valor pasa como un 
parámetro.

Por ejemplo, la fórmula de parámetro <NOMBRE_LOTE> uno dos “tres 
cuatro” produce los cuatro parámetros siguientes:

/BATCH_NAME=Batch99999
one
two
three four

Omit “/tagname=” identifiers on parameters (Omitir identificadores “/
nombredeetiqueta=” en los parámetros): de forma predeterminada, los 
parámetros se pasarán a la aplicación invocada precedidos de una cadena en 
el formato “/nombredeetiqueta=” en donde nombredeetiqueta identifica el tipo 
de parámetro (p. ej., /NOMBRE_LOTE=Lote001). Si se selecciona esta 
opción, se omitirá este identificador y el programa tendrá que conocer el 
número y secuencia de parámetros aprobados para interpretarlos 
adecuadamente.

Por ejemplo, si se ha seleccionado Omit “/tagname=” identifiers on 
parameters (Omitir identificadores “/nombredeetiqueta” en los parámetros), 
la fórmula: <BATCH_NAME> one two "three four" produciría los siguientes 
parámetros:

Batch99999
one
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two
three four

Create output file and send its path as parameter (Crear un archivo de 
salida y enviar su ruta como parámetro): si selecciona esta opción, se genera 
un archivo XML que contiene los parámetros. La ruta de este archivo pasará al 
programa invocado como el único parámetro. 

Location (Ubicación): haga clic en Setup (Configuración) para especificar la 
fórmula de la ruta y el nombre del archivo para el archivo de salida. 

En el archivo XML, los literales de cadena estarán en un elemento 
PARAM_LIST que contiene un elemento PARAM por literal.

Los parámetros variables estarán presentes en elementos que identifican el 
tipo de parámetro (como <BATCH_NAME>).

Se puede utilizar el archivo de esquema KCCustomApplication.xsd 
(ver anexo D) para validar los archivos XML resultantes y como referencia 
durante el desarrollo de códigos. 

Por ejemplo, la fórmula de ubicación y nombre de archivo 
<RUTA_EXPORTACIÓN>"\"<NOMBRE_LOTE>"\" y Parameters.XML ha 
generado el parámetro C:\BatchesPro\Lote001033841\Parameters.XML.

El archivo Parameters.XML tenía el siguiente contenido:

<?xml version="1.0" encoding="UTF-8" standalone="no" ?> 
<KCCustomApplication xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="KCCustomApplication.xsd">

<LISTA_PARÁM>
 <PARÁM>uno</PARÁM> 
 <PARÁM>dos</PARÁM> 
 <PARÁM>tres cuatro</PARÁM> 
 </LISTA_PARÁM>
 <NOMBRE_LOTE>Lote001033841</NOMBRE_LOTE> 

</KCCustomApplication>
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Salida remota (solo 
Network Edition)

La opción Remote Output (Salida remota) le permite transferir lotes a un 
servidor de salida remota para su procesamiento. Es muy útil para procesar 
trabajos de alta intensidad que podrían ralentizar las operaciones de captura, 
como los trabajos que generan archivos PDF con capacidad de búsqueda. 
La configuración del servidor de salida remota se encuentra en un mapa de 
servidor que se ha configurado como parte de la instalación del software 
Capture Pro (consulte la Guía del administrador de Network Edition).

Puede haber uno o varios servidores de salida remota opcionales en una 
configuración de Network Edition.

Se puede establecer una configuración de trabajo para que siempre envíe los 
lotes a un servidor de salida en particular (selección manual) o distribuya los 
trabajos por turnos entre varios servidores de salida (selección automática).

• Si se selecciona la opción Auto Select (Selección automática), los lotes se 
asignarán mediante rotación a los servidores de salida disponibles. No se 
producirá un equilibrio de carga.

• Si se selecciona la opción Manual Select (Selección manual) y el servidor 
está inactivo, se producirá un error en la aplicación y el usuario deberá 
seleccionar manualmente otro servidor o cambiar la configuración de 
trabajo a la opción Auto Select (Selección automática). 

Cuando seleccione servidores de salida remota, es importante tener en 
cuenta que los servidores se deben configurar adecuadamente para procesar 
cualquier trabajo que se les envíe. La instalación de Network Edition no 
abarca la configuración del servidor. Por ejemplo, si un trabajo utiliza la opción 
Invoke Other Program (Invocar otro programa), el programa invocado debe 
estar instalado y configurado en el servidor de salida. Esto se aplica a todos 
los tipos de salida, incluidos los que dependen de bases de datos externas 
u otros destinos de salida del sistema.
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Configuración de 
trabajo: 
configuración 
específica del 
escáner

No todos los escáneres tienen una configuración específica. Esta sección se 
aplica únicamente a escáneres con funciones de impresión, dirección de 
imagen, lote y parche. Si el escáner necesita una configuración específica, 
aparecerá una opción KODAK Scanner: iXXX (Escáner KODAK: iXXX) en el 
lado izquierdo de la pestaña Capture (Captura). 

Opciones del escáner Los escáneres Kodak de las series i3000/S3000/i4000/i5000/i1800 y los 
escáneres Kodak S2085f e i2900 disponen del cuadro Scanner Options 
(Opciones del escáner), que permite acceder a la fuente de datos TWAIN 
y ajustar la configuración de mensajes y otras opciones (p. ej., impresión, 
dirección de imagen, lote, parche, etc.). 

NOTA: Las opciones impresión, dirección de imagen, lote y parche se 
describen detalladamente en la Guía de configuración de digitalización 
de su escáner. Para obtener una copia de la Guía de configuración de 
digitalización, visite www.alarisworld.com/go/support y seleccione su 
escáner.

Opciones del escáner

Message Configuration (Configuración de mensaje): muestra el cuadro de 
diálogo de configuración de mensaje. Este cuadro permite especificar el texto 
personalizado que se va a incluir en la cadena de impresión. El número 
máximo de caracteres permitidos es 20. Puede tener hasta seis mensajes 
únicos por cadena. La opción Printer (Impresora) de la fuente de datos TWAIN 
debe estar activada y configurada antes de configurar mensajes 
personalizados en el software Capture Pro. Consulte la siguiente sección para 
conocer los procedimientos de personalización de la cadena de impresión.

New batch starts with counter equal to (Nuevo lote empieza con contador 
igual a): introduzca el número con el que quiera empezar un lote nuevo.

Personalización del texto para 
la cadena de impresión

NOTA: La configuración de la impresora establecida en el software Capture 
Pro sobrescribirá cualquier configuración de impresora establecida en 
la fuente de datos TWAIN.

Si hace clic en este icono, aparecerá la fuente de datos TWAIN, 
que le permite configurar las opciones de impresión, dirección de 
imagen, lote y parche. Para obtener información sobre los 
procedimientos para utilizar la fuente de datos TWAIN, consulte la 
ayuda en línea de la fuente de datos TWAIN.
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1. Haga clic en Message Configuration (Configuración de mensaje). 
Se mostrará el cuadro de diálogo Message Configuration (Configuración 
de mensaje).

2. Haga clic en Setup (Configuración) para cada mensaje que quiera 
configurar. Se mostrará el cuadro de diálogo Message Setup 
(Configuración de mensaje). 

3. Seleccione un valor de la lista Predefined values (Valores predefinidos) 
y haga clic en Add Item (Agregar elemento).

4. Haga clic en OK (Aceptar) cuando haya terminado.

NOTA: Haga clic en Delete Item (Eliminar elemento) para eliminar el último 
valor de la fórmula o haga clic en Delete Formula (Eliminar fórmula) 
para eliminar la fórmula entera.
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Escáneres Kodak de la 
serie i5850 e i1850S

Además de las opciones del escáner descritas anteriormente, los escáneres 
Kodak de la serie i5850 e i1850S ofrecen las siguientes opciones.

Opciones de dirección de imagen

• Delete level 3 pages (Eliminar las páginas de nivel 3): este contador está 
asociado con la parte numérica del nombre del lote. Cada vez que se 
digitaliza una página de nivel 3, el software Capture Pro creará 
automáticamente un nuevo lote y descartará la página de nivel 3. 

• Delete level 2 pages (Eliminar las páginas de nivel 2): este contador está 
asociado con el número de documento del lote actual. Cada vez que se 
digitaliza una página de nivel 2, el software Capture Pro crea 
automáticamente un documento nuevo. 

• Set image address on new batch (Establecer dirección de imagen en 
nuevo lote): define el valor de dirección de imagen cuando se crea 
manualmente un nuevo lote en el software Capture Pro. Esta opción no 
afecta a la dirección de imagen cuando se crean lotes automáticamente en 
el software Capture Pro (p. ej., separación por páginas en blanco 
o separación por código de barras). Por defecto, el valor predeterminado de 
dirección de imagen de un nuevo lote será el siguiente: 

- Fixed field (Campo fijo): el valor predeterminado se define en este 
cuadro de diálogo.

- Level 3 (Nivel 3): la parte de número de lote del nombre de lote del 
software Capture Pro (p. ej., un valor 19 si el nombre del lote es 
Lote019). 

- Level 2 (Nivel 2): número de documento del software Capture Pro para 
el primer documento del lote. 

- Level 1 (Nivel 2): 0 si el formato de dirección de imagen es de nivel 2 
o de nivel 3. 
1 si el formato de dirección de imagen es de nivel 1. 
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• Set image address on scanner start (Establecer dirección de imagen al 
iniciar el escáner): vuelve a sincronizar automáticamente la dirección de 
imagen del escáner con el lote de digitalización actual del software Capture 
Pro cada vez que se inicia el escáner. El valor de dirección de imagen se 
establece como el valor que debe tener la dirección de imagen para la 
siguiente página digitalizada. Esta opción solo está disponible cuando 
Set image address on new batch (Establecer dirección de imagen en 
nuevo lote) está activada.

Cuando se vuelve a sincronizar la dirección de imagen del escáner, los 
campos de dirección de imagen del escáner se establecen de la siguiente 
forma: 

- Fixed field (Campo fijo): el valor actual del escáner no cambiará. 
- Level 3 (Nivel 3): la parte de número de lote del nombre de lote del 

software Capture Pro. 

- Level 2 (Nivel 2): el número de documento actual del software Capture 
Pro.

- Level 1 (Nivel 1): el número de páginas en el documento actual si el 
formato de dirección de imagen es de nivel 2 o 3. Número de páginas del 
documento actual + 1 si el formato de dirección de imagen es de nivel 1.
NOTA: La opción Set image address at scanner start (Establecer 

dirección de imagen al iniciar el escáner) no se recomienda 
cuando se realiza una digitalización simultánea. Esto se debe 
a que el software Capture Pro no mantiene correctamente el 
número de páginas del documento actual cuando realiza la 
digitalización simultánea. Como resultado, la parte de nivel 1 de 
la dirección de imagen puede perder fácilmente la sincronización.

Fixed field value (Valor de campo fijo): se trata de un campo estático que 
contiene texto ASCII que no aumenta ni cambia durante la digitalización. 
Introduzca el texto en el campo o haga clic en Setup (Configuración), que 
muestra el cuadro de diálogo Configuración del valor del campo fijo. 

OK (Aceptar): guarda los valores y cierra el cuadro de diálogo Job Setup 
(Configuración de trabajo).



124 A-61993_es  Marzo de 2022
 



A-61993_es  Marzo de 2022 125

3   Configuración de parches

Acerca de los 
códigos de parche 

El software Capture Pro le permite separar las páginas y documentos en el 
escáner con páginas que contienen códigos de parche. También le permite 
crear datos adjuntos a sus documentos. Para poder utilizar separadores de 
código de parche, debe establecer previamente la configuración de trabajo 
para que reconozca los códigos de parche.

El software Capture Pro es compatible con tres tipos de códigos de parche: 

Puede definir el método de separación de cada uno de los códigos de parche. 
Esto resulta útil para trabajos existentes en los que los códigos de parche 2 se 
utilizan como páginas de separación de documentos en lugar de los códigos 
de parche T. También puede definir un código de parche para crear datos 
adjuntos. En el caso de nuevos trabajos y por motivos de compatibilidad, se 
recomienda que utilice los códigos de parche de la forma en que se diseñaron.

• Para obtener más información sobre la lectura de códigos de parche 
durante la digitalización en color o escala de grises, consulte la sección 
“Uso de separadores durante la digitalización en color” del capítulo 4.

• Para obtener más información sobre el uso de los códigos de parche en los 
escáneres Kodak de la serie i800 e i1800, consulte “Configuración de 
trabajo: configuración específica del escáner”. Cuando se activa la lectura 
de códigos de parche en un escáner Kodak de la serie i800/i1800, no se 
permite la lectura de códigos de parche con el software Capture Pro. Por el 
contrario, cuando se activa la lectura de códigos de parche con el software 
Capture Pro, no se permite la lectura de códigos de parche en los 
escáneres Kodak de la serie i800/i1800.

Tipo de parche Función ¿Se conserva 
el parche?

Parche 2 Separa las páginas en documentos. Sí
Parche 3 Separa los documentos en lotes. No
Parche T 
(programable)

Separa las páginas en documentos.
Separa los documentos en lotes.
Crea datos adjuntos. 

No
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Configuración de 
códigos de parche
Separación por código 
de parche 2, 3 o T 

Los valores de configuración de separación de parche 2, 3 o T de la pestaña 
Capture (Captura) del cuadro de diálogo Job Setup (Configuración de trabajo) 
permiten configurar el software Capture Pro para que reconozca los códigos 
de parche como separadores entre lotes o documentos en el escáner. Cada 
parche tiene su propia ventana, pero los comandos son idénticos para las tres 
ventanas. Puede configurar el sistema para que reconozca los tres códigos de 
parche o solo códigos específicos.

NOTAS: 

• Si las casillas de verificación de Detect patch (Detectar parche) están 
desactivadas en las tres ventanas de código de parche, el lector de parches 
se desactiva.

• Si activa Detect patch (Detectar parche) en cualquiera de los cuadros de 
diálogo Separation by Patch (Separación por parche), el software Capture 
Pro busca el tipo de código de parche seleccionado en todas las páginas.

Detect patch (Detectar parche): cuando esta opción está seleccionada, se 
activa la opción Detect patch (Detectar parche).

• Alternatively search on 180 rotated images (Buscar alternativamente en 
imágenes giradas 180º): si la lectura de códigos de parche no se completa 
con éxito, esta opción gira la imagen y vuelve a buscar el código de parche. 
Esta opción ayuda a evitar un error de lectura de código de parche en caso 
de que una página se haya digitalizado al revés.

NOTA: El software siempre busca códigos de parche en los primeros 
10 cm (4 in) de la parte superior de la imagen después de los 
procesos de rotación, enderezamiento y recorte (si los hay). 
Si existe un parche vertical, la imagen se debe girar con la opción 
Software rotation (Giro de software), que se define en el cuadro 
de diálogo Page Setup (Configuración de página). 
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• Alternatively search on back (Buscar alternativamente en el reverso): si la 
lectura de códigos de parche no se completa con éxito, esta opción busca el 
parche en el reverso del documento. Si el software detecta un código de 
parche en el anverso, no buscará un código en el reverso.

What to do if patch code is detected (Qué hacer si se detecta un código de 
parche): seleccione una de estas opciones:

• Batch separation (Separación de lote): crea un lote nuevo con un código 
de parche.

- El parche 3 se utiliza normalmente para crear un lote nuevo.
- Generalmente, la página que contiene un código de parche para la 

separación de lote no debería tener ningún contenido. Por lo tanto, 
el software descarta la página de código de parche. La siguiente página 
digitalizada se convierte en la primera página del primer documento 
del lote.

• Document separation (Separación de documento): crea un documento 
nuevo con un código de parche.

- El parche 2 se utiliza normalmente para crear un documento nuevo 
y conservar la imagen de la página que contiene el código de parche.

- El parche T se utiliza normalmente para crear un documento nuevo 
y eliminar la imagen de la página que contiene el código de parche.

• Create attachment (Crear adjunto): crea un archivo adjunto mediante un 
código de parche.

• Delete page (Eliminar página): elimina la página que contiene el código de 
parche con el que se inició el documento nuevo o el adjunto. Esta opción es 
de gran ayuda cuando se utilizan inserciones como separadores de 
documentos que no contienen ninguna otra información.

• Rotate document based on patch (Girar documento según el parche): gira 
la imagen que contiene el código de parche, de manera que el código se 
coloca horizontalmente en la parte superior de la página. Todas las 
imágenes del documento se girarán. Esta opción solo funciona cuando la 
opción Alternatively search on 180 rotated images (Buscar 
alternativamente en imágenes giradas 180º) está activada. 

- La opción Rotate document based on patch (Girar documento según el 
parche) no funciona cuando se descarta la página de separación por 
código de parche. 

OK (Aceptar): cierra el cuadro de diálogo y guarda la configuración.

Creación de datos 
adjuntos con códigos de 
parche

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. En la lista desplegable Job Name (Nombre del trabajo), seleccione un 
trabajo que requiera una separación de código de parche.

3. Abra la pestaña Capture (Captura) y seleccione Separation > Patch Code 
(Separación > Código de parche). 

4. Seleccione el tipo de parche que desee definir: Patch 2, Patch 3 o Patch 
T (Parche 2, Parche 3 o Parche T). Se mostrará la ventana Patch Code 
(Código de parche).

5. Haga clic en Detect patch (Detectar parche).
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6. En What to do if a patch code is detected (Qué hacer si se detecta un 
código de parche), marque la opción Create Attachment (Crear adjunto).

7. Active todas las demás opciones que desee en la ventana Patch Code 
(Código de parche). 

8. Haga clic en OK (Aceptar). 

Separación de lotes o 
documentos con 
códigos de parche

El software Capture Pro puede reconocer los códigos de parche como 
separadores entre lotes o documentos en el escáner. 

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. En la lista desplegable Job Name (Nombre del trabajo), seleccione un 
trabajo que requiera una separación de código de parche.

3. Abra la pestaña Capture (Captura) y seleccione Separation > By Patch 
Code (Separación > Por código de parche). 

4. Seleccione el tipo de parche que desee definir: Patch 2, Patch 3 o Patch 
T (Parche 2, Parche 3 o Parche T). Se mostrará la ventana Patch Code 
(Código de parche). Puede activar todos los tipos de código de parche que 
necesite.

5. Haga clic en Detect patch (Detectar parche).

6. Si lo desea, active una o las dos opciones siguientes: Alternatively 
search on 180 rotated images (Buscar alternativamente en imágenes 
giradas 180º) o Alternatively search on back (Buscar alternativamente 
en el reverso). 

7. En What to do if a patch code is selected (Qué hacer si se detecta un 
código de parche), marque la opción Document Separation (Separación 
de documento) o la opción Batch Separation (Separación de lote).

8. Marque cualquier otra opción que desee. 

9. Haga clic en OK (Aceptar). 



A-61993_es  Marzo de 2022 129

4   Configuración de códigos de barras, OCR y detección de marcas

Descripción general Para utilizar zonas de códigos de barras, OCR o detección de marcas para 
indexar en la configuración de trabajo, siga estos pasos:

• Seleccione la configuración de página que se utilizará cuando digitalice en 
este tipo de trabajo.

• Edite la configuración de trabajo.

• Digitalice una página y utilícela como plantilla para definir la zona de código 
de barras, OCR o detección de marcas.

• Defina la ubicación de la zona de código de barras, OCR o detección de 
marcas en la imagen de plantilla.

• Especifique cómo se reconocerá un valor correcto de código de barras, 
OCR o detección de marcas.

• Indique la página o páginas en las que desea aplicar las zonas.

Además de utilizar zonas de OCR y códigos de barras para la separación en 
su configuración de trabajo, debe hacer lo siguiente:

• Establecer las acciones asociadas a dicha zona de OCR o código de barras 
(p. ej., crear un nuevo lote, crear un nuevo documento dentro del lote 
actual, o completar uno o varios campos de índice).

Este capítulo explica estos pasos, excepto cómo completar campos de índice. 
La información sobre cómo completar campos de índice se puede encontrar 
en el capítulo 2: Configuración de trabajo.

Uso de códigos de 
barras

La codificación mediante barras es un método de codificación de datos 
legibles por máquina basado en la disposición paralela de elementos claros 
y oscuros. Los elementos claros se conocen como “espacios”, mientras que 
los elementos oscuros se denominan “barras”. Las barras y los espacios son 
anchos o estrechos. La combinación de barras y espacios anchos y estrechos 
constituye un código de barras. Cada código de barras empieza con un 
carácter “de inicio” y finaliza con un carácter “de finalización”. Los códigos de 
barras se utilizan en el sector para proporcionar entradas de datos más 
exactas y eficaces de lo que sería posible utilizando la introducción manual de 
los datos.

La configuración de código de barras permite definir lo siguiente:
• El nombre del código de barras
• La máscara o la sintaxis de los datos
• La ubicación física en la que se encontrará el código de barras (en una 

zona o en cualquier otro lugar de la imagen)
• El tipo de código de barras (anchura, altura, calidad y nivel de fiabilidad)
• El nivel en el que se puede encontrar el código de barras (lote, documento 

o página)

• La fuente para la captura del código de barras
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Siga estas sugerencias para maximizar el rendimiento del software Capture 
Pro:

• Seleccione el nombre de la configuración de página que utilizará para 
digitalizar antes de definir una zona de código de barras.

• Asegúrese de que todas las superficies de cristal (las guías de cristal o el 
cristal situado sobre el área de la cámara) del transporte del escáner estén 
limpias. Las superficies sucias provocan velocidades bajas de lectura.

• Utilice una resolución mayor para obtener mejores velocidades de lectura 
(300 dpi en lugar de 200 dpi).

• Compruebe la colocación de la zona situada alrededor del código de barras, 
ya que puede afectar el nivel de seguridad del código. Deje al menos 1/4 de 
pulgada (6,35 mm) de espacio en blanco alrededor de un código de barras 
para garantizar que el código de barras completo coincida siempre con la 
zona. Mueva la zona situada alrededor del código de barras hasta alcanzar 
la mayor tasa de fiabilidad posible.

• La especificación de altura mínima del código de barras es de 40 píxeles. 
A 200 dpi, 40 píxeles equivalen a 20 centésimas de pulgada; a 300 dpi, 
40 píxeles equivalen a 13 centésimas de pulgada. En códigos de barras 
inferiores a 40 píxeles de altura, especifique una altura de código de barras 
en el cuadro de diálogo Configuración de zona de código de barras.

• Verifique que se ha seleccionado el tipo y la orientación de código de barras 
correctos en el cuadro de diálogo de configuración de zona de código de 
barras.

• Si los códigos de barras se incluyen en documentos con fondos en color, 
puede que necesite establecer un valor de umbral inferior en el cuadro de 
diálogo de configuración de zona de código de barras para obtener 
velocidades de lectura mejoradas.

• Si es posible, utilice códigos de barras de densidad media o baja. Los 
códigos de barras de alta densidad pueden requerir un valor de umbral más 
bajo en el cuadro de diálogo de configuración de zona de código de barras.

• Para lograr mejores velocidades de lectura con códigos de barras más 
difíciles, reduzca el nivel del campo Quality (Calidad) en el cuadro de 
diálogo de configuración de zona de código de barras.

• Cuando utilice zonas de código de barras con la opción Anywhere 
(Cualquier lugar), utilice un equipo con un procesador de 2,8 GHz o 
superior. De este modo, se garantiza la capacidad del software Capture Pro 
de digitalizar a la velocidad nominal del escáner cuando la lectura de 
códigos de barras esté activada.

Ventana Código de 
barras, OCR y 
detección de marcas

La ventana Bar Code, OCR & Mark Detection (Código de barras, OCR 
y detección de marcas) le permite digitalizar y manipular una imagen, y crear 
una zona de código de barras, OCR o detección de marcas.

Para acceder a la ventana Bar Code, OCR & Mark Detection (Código de 
barras, OCR y detección de marcas):

1. Abra el cuadro de diálogo Job Setup (Configuración de trabajo).
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2. Haga clic en Bar Code, OCR & Mark Detection (Código de barras, 
OCR y detección de marcas) en la pestaña Capture (Captura).

NOTA: No defina más de siete zonas de código de barras para un trabajo, 
ya que puede afectar negativamente a su velocidad de digitalización.

Image (Imagen): si lo desea, seleccione una imagen previa en la lista 
desplegable. La lista desplegable Image (Imagen) contiene todas las 
imágenes que se han digitalizado para la configuración de código de barras. 
Debe tener al menos una imagen en esta lista antes de poder definir una zona 
de código de barras, OCR o detección de marcas.

NOTA: Para las configuraciones de trabajo típicas que utilizan zonas de 
código de barras, de OCR o de detección de marcas, solo se necesita 
una imagen. Por el contrario, es necesario contar con varias imágenes 
para las configuraciones de trabajo que tengan hojas de encabezado 
de lote y documento, cada una de estas con información de código de 
barras, OCR o detección de marcas. 

Zones (Zonas): muestra el nombre de una zona de código de barras, OCR 
o detección de marcas. Al hacer clic en una de las zonas incluidas en la lista, 
la imagen del área de visualización resaltará la zona de ubicación en la 
imagen. Cualquier zona de código de barras, OCR o detección de marcas que 
defina se mostrará en la imagen actual, incluso si ha definido estas zonas con 
una imagen diferente.
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Iconos

Start/Scan (Iniciar/Digitalizar): abre el cuadro de diálogo para 
digitalizar una imagen, que permite introducir el nombre de una 
imagen y digitalizar una imagen que contenga códigos de 
barras, segmentos de texto OCR o áreas de marcas.
NOTA: El software Capture Pro utilizará la configuración 

de página que esté seleccionada cuando seleccione 
Start/Scan (Iniciar/Digitalizar).

Draw region (Dibujar región): permite dibujar un rectángulo 
alrededor de un segmento de texto OCR, código de barras 
o zona de marcas en la imagen digitalizada y, a continuación, 
muestra el cuadro de diálogo de configuración de zona de 
código de barras, configuración de zona de OCR o 
configuración de zona de detección de marcas.
Magnify (Aumentar): amplía una parte de una imagen. Para 
ampliar cualquier parte de la imagen, coloque la herramienta 
Magnify (Aumentar) sobre la imagen y mantenga pulsado el ratón.
Pan (Desplazar): permite mover la imagen cuando esta es mayor 
que la ventana de código de barras, OCR y detección de marcas.

Zoom in (Acercar): agranda la imagen.

Zoom out (Alejar): reduce la imagen.

Fit window (Ajustar a la ventana): cambia la visualización de la 
imagen para que se ajuste a la ventana de código de barras, 
OCR y detección de marcas.
Actual size (Tamaño real): muestra la imagen a tamaño real. 
Un píxel digitalizado equivale a un píxel en la ventana de código 
de barras, OCR y detección de marcas.
Test selected bar code, OCR or Mark Detection zone 
(Probar zona de código de barras, OCR o detección de marcas 
seleccionada): abre el cuadro de diálogo de valores de código 
de barras, OCR y detección de marcas, que permite ver los 
resultados de la prueba en una zona seleccionada.
Test all selected bar code, OCR or Mark Detection zones 
(Probar todas las zonas seleccionadas de código de barras, 
OCR o detección de marcas): abre el cuadro de diálogo de 
valores de código de barras, OCR y detección de marcas, que 
permite ver los resultados de la prueba en todas las zonas 
seleccionadas.
Create barcode (Crear código de barras): permite crear una 
zona de código de barras a partir de la imagen visualizada en la 
ventana de código de barras, OCR y detección de marcas.
Create OCR zone (Crear zona de OCR): permite crear una 
zona de OCR a partir de la imagen visualizada en la ventana de 
código de barras, OCR y detección de marcas.
Create mark detection zone (Crear zona de detección de 
marcas): permite crear una zona de detección de marcas 
a partir de la imagen visualizada en la ventana de código de 
barras, OCR y detección de marcas.
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OK (Aceptar): cierra el cuadro de diálogo y guarda la configuración.

Menú contextual de 
las ventanas de 
código de barras, 
OCR y detección de 
marcas

Si hace clic con el botón secundario sobre una imagen en la ventana de 
código de barras, OCR y detección de marcas, se mostrará un menú 
contextual. Si no ha seleccionado ninguna zona de código de barras, 
OCR o detección de marcas, se mostrará un menú más limitado.

Cut (Cortar): elimina la zona de código de barras, OCR o detección de marcas 
seleccionada. Si lo desea, puede pegar esta zona de código de barras, OCR 
o detección de marcas en otra ubicación de la misma imagen; para ello, haga 
clic con el botón primario en dicha zona y arrástrela a una nueva ubicación.

Zone properties (Propiedades de zona): abre el cuadro de 
diálogo de configuración de zona de código de barras, 
configuración de zona de OCR o configuración de zona de 
detección de marcas, que permite ver las propiedades de la 
zona de código de barras, OCR o de detección de marcas 
seleccionada.
Select pages to apply for all zones (Seleccionar páginas para 
aplicar a todas las zonas): abre el cuadro de diálogo de 
configuración de páginas de zona, que permite seleccionar la 
página o páginas a las que se aplicarán las zonas de OCR, 
código de barras y detección de marcas definidas. Para obtener 
más información, consulte la sección “Cuadro de diálogo 
Configuración de páginas de zona”, que aparece más adelante 
en este capítulo.
Delete selected zone (Eliminar zona seleccionada): permite 
eliminar una zona de código de barras, OCR o detección de 
marcas. Aparecerá un cuadro de confirmación para que 
verifique su selección.
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Copy (Copiar): copia la zona de código de barras, OCR o detección de 
marcas seleccionada. La función para copiar también resulta útil cuando se 
requieren varias zonas de código de barras, OCR o detección de marcas con 
exactamente las mismas propiedades (excepto la ubicación). Una vez que se 
ha definido la primera zona, utilice la opción de copiar para duplicarla. Una vez 
que se ha creado cada zona duplicada, muévala. Para ello, haga clic con el 
botón primario en la zona y arrástrela a la ubicación deseada. 

Paste (Pegar): pega la zona de código de barras, OCR o detección de marcas 
copiada o cortada en la imagen actual. La opción de pegar solo aparece en 
este menú si ya ha copiado una imagen o cadena de texto en el portapapeles. 
Cuando pegue una zona de código de barras, OCR o detección de marcas, 
las coordenadas de la zona guardada se utilizarán para determinar la 
ubicación de la zona. Si la zona pegada está en una ubicación incorrecta, 
haga clic con el botón primario en la zona y arrástrela a la ubicación deseada.

La función de pegar resulta útil si se utiliza junto con la de copiar para copiar 
las propiedades de una zona de código de barras a otra imagen que contiene 
códigos de barras en el trabajo.

Test Zone (Probar zona) y Test All Zones (Probar todas las zonas): intenta 
buscar un valor en todas las zonas de código de barras, OCR o detección de 
marcas seleccionadas. Se mostrará el cuadro de diálogo de calores de OCR, 
código de barras y detección de marcas. 

Este cuadro de diálogo proporciona la siguiente información:

• Label (Etiqueta) indica el nombre asignado a la zona de código de barras, 
OCR o detección de marcas en el cuadro de diálogo de zona de código de 
barras (OCR/detección de marcas).

• Type (Tipo) indica el tipo de código de barras detectado en la zona. Si la 
zona es de OCR, el campo Type (Tipo) será OCR. Si la zona es una zona 
de detección de marcas, Type (Tipo) será Mark Detection (Detección de 
marcas).

• Confidence level (Nivel de fiabilidad): porcentaje de fiabilidad del valor de 
código de barras detectado.

• Orientation (Orientación): disposición de la zona del código de barras, 
OCR o detección de marcas
0º representa una zona de código de barras, OCR o detección de marcas 
horizontal con la parte derecha hacia arriba.
90º representa una zona de código de barras, OCR o detección de marcas 
vertical con la parte superior a la izquierda.
180º representa una zona de código de barras, OCR o detección de marcas 
horizontal dada vuelta.
270º representa una zona de código de barras, OCR o detección de marcas 
vertical con la parte superior a la derecha.

• Value (Valor): el valor de la zona del código de barras, OCR o detección de 
marcas.

• Zone X (Zona X) y Zone Y (Zona Y): coordenadas de la esquina superior 
izquierda de la zona de código de barras, OCR o detección de marcas. Las 
coordenadas se muestran en centésimas de pulgada y representan la 
distancia desde la zona hasta la esquina superior izquierda de la imagen.
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• Zone Width (Anchura de la zona) y Zone Height (Altura de la zona): 
valores de anchura y altura de código de barras, OCR o detección de 
marcas en centésimas de pulgada.

NOTA: Si no se encuentra el valor de código de barras, OCR o detección de 
marcas para una zona, esta seguirá incluyéndose en la lista de valores 
mostrando únicamente las coordenadas de etiqueta y zona.

Zone properties (Propiedades de zona): permite definir las propiedades de la 
zona de código de barras, OCR o detección de marcas seleccionada 
actualmente. Se mostrará el cuadro de diálogo de valores de código de barras 
(OCR/detección de marcas). Para obtener más información, consulte las 
secciones “Cuadro de diálogo Configuración de zona de código de barras”, 
“Cuadro de diálogo Configuración de zona de OCR” o “Cuadro de diálogo 
Configuración de zona de detección de marcas”, que aparecen más adelante 
en este capítulo.

General Properties (Propiedades generales): permite definir las propiedades 
que se aplicarán a todas las zonas de código de barras, OCR y detección de 
marcas. Esta opción resulta útil cuando se utilizan hojas de encabezado de 
código de barras para la separación e indexación de documentos que tienen 
menos contenido que el resto de las páginas del documento. Esta opción 
puede aumentar el rendimiento de la digitalización en la aplicación de código 
de barras/OCR/detección de marcas. 

Cuando seleccione esta opción, se mostrará el cuadro de diálogo de 
propiedades generales de códigos de barras y OCR. 

1. Seleccione la casilla de verificación Extract bar codes/OCR from images 
between (Extraer códigos de barras/OCR de imágenes entre) para activar 
esta opción. 

2. Introduzca un valor en el campo minimum bytes (Cantidad mínima de 
bytes), cuyo valor predeterminado es 1000 bytes, y el campo maximum 
bytes (Cantidad máxima de bytes), cuyo valor predeterminado es 
100 000 bytes. Los valores que introduzca en estos campos limitarán las 
imágenes de las que se leerán los códigos de barras o el texto de OCR 
o detección de marcas a únicamente aquellas cuyo tamaño se incluya 
entre estos valores.

3. Haga clic en OK (Aceptar).

Rename Image (Cambiar nombre de imagen): se le solicita que cambie el 
nombre de la imagen mostrada actualmente. Cuando nombre o cambie el 
nombre de una imagen, seleccione un nombre único en el software Capture 
Pro. No se requiere una extensión de archivo.

NOTA: El nombre de la imagen no debe contener ninguno de los siguientes 
caracteres especiales: “ ? * . < > \ / .

Delete Image (Eliminar imagen): elimina la imagen actual del trabajo. Antes 
de eliminar la imagen, se mostrará un cuadro de confirmación para que 
verifique su selección. Si quedan otras imágenes en la lista de imágenes, 
el lugar de la imagen eliminada lo ocupará la imagen que la precedía. 
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Las definiciones de zona de código de barras, OCR y detección de marcas no 
se verán afectadas cuando elimine una imagen siempre y cuando haya otras 
imágenes en la lista de imágenes. Sin embargo, si la imagen que va 
a eliminarse es la última de la lista, se mostrará el siguiente mensaje: Esta es 
la última imagen. Si elimina esta imagen, también eliminará todas las 
zonas de código de barras, OCR o detección de marcas. ¿Desea eliminar 
esta imagen?

Si hace clic en Yes (Sí), todas las definiciones de zona de código de barras, 
OCR y detección de marcas del trabajo se eliminarán también. Debe haber 
una imagen en la lista de imágenes para definir zonas de código de barras, 
OCR o detección de marcas. Si elimina la última imagen, también se 
eliminarán todas las zonas de código de barras, OCR y detección de marcas.

Delete Zone (Eliminar zona): elimina la zona de código de barras, OCR 
o detección de marcas seleccionada. Aparecerá un cuadro de confirmación 
antes de eliminar la zona.

Delete All Zones (Eliminar todas las zonas): elimina todas las zonas de 
código de barras, OCR y detección de marcas que haya definido para ese 
trabajo. Aparecerá un cuadro de diálogo de confirmación antes de eliminar las 
zonas. 

Digitalización de una 
imagen para la 
configuración de 
códigos de barras

El software Capture Pro le permite separar las páginas y documentos en el 
escáner con páginas que contienen códigos de barras. También permite crear 
datos adjuntos a sus documentos mediante estos separadores de código de 
barras. 

Antes de utilizar los códigos de barras como separadores deberá:

• Digitalizar una imagen que contenga códigos de barras con el software 
Capture Pro.

• Dibujar y seleccionar las zonas de los códigos de barras. 

• Configurar el trabajo para la separación por zonas de código de barras.

El software Capture Pro permite digitalizar imágenes de códigos de barras 
directamente en la ventana de código de barras para su visualización, 
definición y edición.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job name 
(Nombre del trabajo).
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3. Abra la pestaña Capture (Captura) y seleccione Separation > By Bar 
Code Zones (Separación > Por zonas de código de barras). Se mostrará 
la ventana de código de barras.

4. Seleccione el botón verde Start/Scan (Iniciar/Digitalizar). Se mostrará el 
cuadro de diálogo para digitalizar imágenes.

5. Coloque el documento original en el alimentador y haga clic en Start/Scan 
(Iniciar/Digitalizar). La imagen se mostrará en el cuadro de diálogo. 
Digitalice la imagen lo más enderezada posible. El escáner utilizará los 
parámetros de la configuración de página actual del software Capture Pro.

NOTAS: 
• La configuración de rotación automática, enderezamiento y recorte 

automático de la plantilla actual también se aplicarán a la imagen 
digitalizada antes de que se visualice.
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• Si la imagen es aceptable, introduzca un nombre en el campo Image 
name (Nombre de la imagen). El nombre de la imagen no debe contener 
ninguno de los siguientes caracteres especiales: : “? * . < > \ / . 

• Para descartar la imagen, haga clic en Cancel (Cancelar).

6. Para guardar la imagen, haga clic en OK (Aceptar). 

NOTAS:

• Antes de definir un código de barras, es necesario guardar al menos una 
imagen en la lista desplegable Image (Imagen).

• También puede transferir una imagen del visor de imágenes a la ventana de 
código de barras. Consulte la sección “Transferencia de una imagen a la 
ventana Código de barras”, que aparece más adelante en este capítulo.

Creación y selección de 
una zona de código de 
barras

Antes de poder utilizar una imagen de código de barras para indexar o separar 
documentos o lotes, deberá crear y seleccionar una zona de código de barras. 
Las zonas de código de barras se crean para indicar dónde se debe buscar un 
código de barras que reúne las propiedades de la zona de código de barras.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo).

3. Abra la pestaña Capture (Captura) y seleccione Separation > By Bar 
Code Zones (Separación > Por zonas de código de barras). Se mostrará 
la ventana de código de barras.

4. Seleccione una imagen de la lista desplegable Image (Imagen). Si tiene 
que digitalizar la imagen, haga clic sobre el icono verde Start/Scan 
(Iniciar/Digitalizar) de la ventana de código de barras. 

NOTAS:

• Coloque el cursor del ratón en la esquina superior izquierda del área de 
la imagen en la que desea definir la ubicación para esta zona de código 
de barras.

• Las zonas de código de barras son específicas de un trabajo en 
concreto, no de una imagen concreta. Por ello, cuando cree una nueva 
imagen, el software Capture Pro mostrará las zonas que haya definido 
utilizando imágenes anteriores.

• Cuando dibuje la ubicación de una zona de código de barras, deje un 
área de borde de aproximadamente un cuarto de pulgada alrededor del 
código de barras. Este borde a menudo es necesario para poder realizar 
la lectura de código de barras correctamente. Las ubicaciones de zonas 
de códigos de barras se pueden superponer.

5. Haga clic con el botón primario del ratón y arrastre el cursor para dibujar 
un rectángulo alrededor del área del código de barras. Los códigos de 
barras definidos con la posición Zone (Zona) seleccionada en el cuadro de 
diálogo de configuración de zona de código de barras estarán dentro de 
un cuadro rojo, mientras que los definidos como Anywhere (Cualquier 
lugar) estarán dentro de un cuadro azul. Cuando haya dibujado el 
rectángulo, se mostrará el cuadro de diálogo de configuración de zona de 
código de barras. 

6. En el campo Zone name (Nombre de zona), introduzca un nombre para la 
nueva zona de código de barras. Deberá poner un nombre para guardar la 
zona.
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7. Después de introducir el resto de valores de configuración, haga clic en 
OK (Aceptar) para cerrar el cuadro de diálogo y volver a la ventana de 
código de barras. Para obtener descripciones detalladas de los campos, 
consulte la sección “Cuadro de diálogo Configuración de zona de código 
de barras”.

8. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de trabajo. 

Cuadro de diálogo 
Configuración de zona 
de código de barras

Utilice este cuadro de diálogo para asignarle un nombre a su zona de código 
de barras, describir cómo reconocer un código de barras válido para esta zona 
y especificar cualquier separación por código de barras.

Zone name (Nombre de zona): introduzca el nombre de la nueva zona de 
código de barras. Este nombre identifica el código de barras y aparece en la 
configuración de indexación como BC_[nombredezona] en la lista de valores 
predeterminados. El campo Label (Etiqueta) del código de barras (del cuadro 
de diálogo de valores de código de barras y OCR) no define ni identifica 
ningún campo de índice del software Capture Pro.

Side (Cara): Front (Anverso) o Back (Reverso): seleccione si el código de 
barras está ubicado en el anverso o el reverso de una imagen.

Keep bar codes with mask (Conservar códigos de barras con máscara): 
utilice esta opción si se han definido una o varias zonas de código de barras 
con la opción Anywhere (Cualquier lugar). El valor de código de barras solo se 
almacena para la zona definida cuando cumple con la máscara especificada 
en el campo Keep bar codes with mask (Conservar códigos de barras con 
máscara). Esto garantiza que los valores de código de barras que se leen en 
una página se asignen a la zona de código de barras adecuada.
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Esta opción también resulta útil cuando hay más de una zona de código de 
barras en la misma ubicación física de una página, pero las zonas tienen 
distintos valores y significados (p. ej., una zona definida para una hoja de 
encabezado de lote frente a una zona definida para una hoja de encabezado 
de documento). Para cumplir con una máscara especificada, cada carácter del 
valor del código de barras debe coincidir con la sintaxis que la posición de ese 
carácter tiene en la máscara. 

Por ejemplo, una máscara de A<8> almacenará un valor de código de barras 
que puede alcanzar ocho caracteres alfabéticos, sin sobrepasarlos:

¿Se almacena el valor de código de barras?
CIRUGÍA Sí
ADMISIONES No

Si corresponde, introduzca un valor de máscara.

Minimum length (Longitud mínima): introduzca un número para la longitud 
mínima del valor de código de barras. Por defecto, esta opción se establece 
según la longitud del valor de código de barras probado. Si no se encuentra un 
valor o si el valor es igual o mayor que seis caracteres, el valor 
predeterminado se definirá como “6”. Se recomienda establecer el parámetro 
de longitud mínima en seis caracteres o menos para que el software Capture 
Pro almacene los valores de código de barras en caso de una lectura parcial.

Si la opción Partial Reading (Lectura parcial) no es obligatoria o no está 
activada, las configuraciones de máscara y longitud mínima podrán utilizarse 
juntas para restringir los valores de códigos de códigos de barras 
almacenados. 
Por ejemplo:
Máscara: 9(10)
Cantidad mínima de bytes: 6

almacena valores de código de barras de entre seis y diez dígitos, 
mientras que

Máscara: 9(10)
Longitud mínima: 10

almacena valores de código de barras únicamente si tienen exactamente 
diez dígitos. 

Bar code width (Anchura del código de barras) y Bar code height (Altura del 
código de barras): si el código de barras tiene una longitud o una altura fija, 
introduzca estos valores en centésimas de pulgada. Una entrada en uno de 
estos campos o en ambos se aumentará el rendimiento de la lectura de 
código de barras. Si una de las dimensiones es variable, introduzca 0. El valor 
predeterminado es 0.

Las dimensiones del código de barras pueden variar dependiendo de lo 
inclinado que esté. Por ello, se recomienda que introduzca estos valores 
únicamente cuando esté seguro de las dimensiones del código de barras.

NOTA: Debe especificar una altura de código de barras inferior a 40 píxeles 
(p. ej., a 200 dpi, 40 píxeles equivalen a 20 centésimasde pulgada).

Cuando se especifica la anchura o la altura de un código de barras, la 
tolerancia es ±10 % (es decir, si especifica 20 centésimasde pulgada para la 
altura del código de barras, se detectará cualquier código de barras de entre 
18 y 22 centésimas de pulgada). 
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Type (Tipo): también puede seleccionar tipos de códigos de barras 
adicionales que se considerarán válidos para esta zona de códigos de barras. 
Aunque es poco frecuente que haya más de un tipo de código de barras en 
una zona, es posible seleccionar varios tipos de códigos de barras. Para 
obtener más información sobre los tipos de códigos de barras, consulte la 
sección “Tipos de códigos de barras”, que aparece más adelante en este 
capítulo. 

Cuantos más tipos de códigos de barras seleccione, más lento será el 
rendimiento de la digitalización. 

Cuando dibuja la ubicación de un código de barras, el software Capture Pro 
busca la ubicación de todos los tipos de códigos de barras. Si se realiza con 
éxito, el software define el tipo de código de barras como el tipo detectado. 
De lo contrario, no se selecciona ningún tipo de código de barras. Hay dos 
excepciones:

• Para los tipos Code 39 Extended y Code 39 HIBC, el software Capture Pro 
puede definir el tipo como Code 39. Como resultado, es posible que tenga 
que seleccionar Code 39 Extended y Code 39 HIBC manualmente.

• Para los códigos de barras MSIPH, el software Capture Pro puede definir el 
tipo de código de barras como MSI. Como resultado, es posible que tenga 
que seleccionar MSIPH manualmente.

Cuadro de diálogo Zona de 
código de barras 
(continuación)

Verify checksum (Verificar suma de comprobación): marque esta casilla si el 
código de barras contiene un carácter de suma de comprobación. Los 
caracteres de suma de comprobación ayudan a garantizar la precisión de la 
lectura de código de barras. No todos los tipos de código de barras admiten la 
verificación de suma de comprobación. Entre los tipos de código de barras 
que pueden admitir la verificación mediante suma de comprobación se 
incluyen:

Code 3 of 9
CODABAR
Interleaved 2 of 5

Algunos tipos de códigos de barras, como PDF417, UPC y EAN, tienen un 
procedimiento de suma de comprobación integrado que no se puede 
desactivar.

Si desactiva Verify checksum (Verificar suma de comprobación) para los 
códigos de barras que contienen una suma de comprobación, el valor de 
suma de comprobación (que es normalmente el último carácter del código de 
barras) aparecerá en el valor de código de barras; de lo contrario, el dígito de 
comprobación permanecerá oculto.

Si la verificación de suma de comprobación falla durante la digitalización, no 
se generará el valor de código de barras, lo que resulta en un error de las 
auditorías de campo de índice del software Capture Pro. Algunos tipos de 
códigos de barras, como Code 128, tienen caracteres de suma de 
comprobación obligatorios. El código siempre está presente y debe ser 
correcto para que se lea el valor. Otros códigos, como Code 39, tienen 
caracteres opcionales de suma de comprobación, que añaden un código 
adicional cuando aparecen. 

Para leer símbolos no válidos de Code 128, puede seleccionar la opción 
Minimum partial read characters (Caracteres de lectura mínima parcial). 
Comunicará los caracteres de datos aunque se produzca un error de suma de 
comprobación. No se devolverá una suma de comprobación no válida. Si el 
código de barras tiene una suma de comprobación opcional, el software no la 
validará. Funcionará según la especificación de código de barras. 



142 A-61993_es  Marzo de 2022

Si selecciona Minimum partial read characters (Caracteres de lectura 
mínima parcial) para un código de barras con una suma de comprobación 
opcional, se devolverán los resultados que se detecten, tanto si son buenos 
como malos. Habrá ocasiones en las que el código de barras devuelva el 
resultado correcto, pero la suma de comprobación falle. Como la suma de 
comprobación es implícita, no se devolverá y no podrá comprobarse 
directamente.

Minimum partial read characters (Caracteres de lectura mínima parcial): 
seleccione esta casilla si desea que el software Capture Pro genere un valor 
de código de barras, incluso cuando un código de barras esté incompleto. 
Si esta opción está activada, introduzca el número mínimo de caracteres 
permitido para una lectura parcial. Es útil para los códigos de barras que solo 
se utilizan para separar documentos o lotes en los que el valor absoluto 
es menos crítico.

Para crear índices, es recomendable que defina las máscaras de campo y las 
longitudes mínimas. El software Capture Pro no generará ningún valor de 
código de barras si el código de barras está incompleto y el campo Minimum 
partial read characters (Caracteres de lectura mínima parcial) está 
desactivado.

NOTA: Minimum partial read characters (Caracteres de lectura mínima 
parcial) no debe utilizarse si se ha activado Verify checksum 
(Verificar suma de comprobación), ya que puede provocar que se 
genere un valor de código de barras cuando falle la verificación de 
suma de comprobación. 

Filtering (Filtrado): cuando se leen códigos de barras de máquinas de fax 
u otros dispositivos con píxeles CCD defectuosos, la aplicación de un filtro 
puede mejorar la velocidad de lectura en el caso de barras a las que les falten 
píxeles. Si se selecciona Filter1 (Filtro1), se rellenará un espacio en una barra 
de 1 píxel. Filter2 (Filtro2) rellenará un espacio de 2 píxeles, etc.

Process bar code by (Procesar código de barras mediante): cuando esta 
opción está establecida en Auto (Automático), el código de barras se leerá en 
el escáner siempre que sea posible. Si el escáner alcanza el número máximo 
de códigos de barras o el código de barras no es compatible con el escáner, el 
código de barras se leerá en Capture Pro. Cuando esta opción esté 
establecida en Capture Pro, el código de barras se leerá en el software.

Ventajas de leer los códigos de barras en el escáner (Automático):
• Rapidez: los códigos de barras se leen a la velocidad máxima del escáner.
• Resolución: los códigos de barras se detectan a la máxima resolución de 

imagen (1200 dpi). Es posible que la compresión y el procesamiento de 
imágenes degraden los bordes en algunos modelos de escáneres.

Desventajas de leer los códigos de barras en el escáner (Automático):
• El escáner puede leer una cantidad inferior de códigos de barras por 

imagen que Capture Pro.
• El escáner lee menos tipos de códigos de barras que Capture Pro.

NOTA: Si selecciona la opción Read all bar codes (Leer todos los códigos de 
barras), la opción Process bar code by (Procesar código de barras 
mediante) debe estar establecida en Capture Pro. 
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Cuadro de diálogo Zona de 
código de barras 
(continuación)

Orientation (Orientación): elija una opción de orientación en la lista 
desplegable. Si los códigos de barras comparten la misma orientación (p. ej., 
todos horizontales o verticales), se recomienda que indique la orientación 
específica, lo que aumentará el rendimiento de digitalización de la lectura de 
códigos de barras.

Si casi todos los códigos de barras tienen la misma orientación (p. ej., 
horizontal), pero aparecen códigos de barras con la dirección opuesta 
(vertical) de vez en cuando, se recomienda que utilice la orientación “y” 
adecuada (p. ej., Horizontal y Vertical). 

Cuando se crea una zona de código de barras por primera vez, el software 
Capture Pro define automáticamente la orientación de acuerdo con la del 
código de barras, si se encuentra. El valor predeterminado es Horizontal. 

Confidence (Fiabilidad): introduzca un número de tasa de fiabilidad para 
restringir lo que elsoftware Capture Pro considera una lectura de código de 
barras correcta. Por ejemplo, cuanto mayor sea el valor que introduzca, más 
se reducirán los errores de lectura de los códigos de barras.

Quality (Calidad): seleccione un ajuste de calidad entre Worst (Peor) y Best 
(Mejor). Los códigos de barras de más calidad están impresos mediante una 
impresora láser o preimpresos con una impresora offset. Los códigos de 
barras de menor calidad se imprimen con impresoras de inyección de tinta 
o matriciales. 

Defina el nivel de calidad en función de la calidad de los códigos de barras 
que vayan a digitalizarse. Cuanto mayor sea la configuración de calidad, más 
rápido será el rendimiento de lectura de códigos de barras.

Position (Posición): seleccione Anywhere (Cualquier lugar) o Zone (Zona). 

• Anywhere (Cualquier lugar): cuando cree una zona para un código de 
barras ubicado en cualquier lugar, dibuje una ubicación alrededor de un 
código de barras en la página y seleccione la opción Anywhere (Cualquier 
lugar). Esta situación se suele producir cuando se pueden encontrar 
códigos de barras en ubicaciones o documentos impredecibles. Cuando se 
buscan códigos de barras con la opción de cualquier lugar, el software 
Capture Pro busca códigos de barras horizontales y verticales en la imagen, 
desde arriba hacia abajo. Es importante comprender este orden de 
búsqueda si hay más de un código de barras con la opción cualquier lugar 
en una página o zona. 

• Zone (Zona): aumenta el rendimiento de lectura de códigos de barras 
y digitalización; es el valor de configuración predeterminado. 

- La opción Alternatively search on 180° rotated images (Buscar 
alternativamente en imágenes giradas 180º) solo funciona cuando la 
opción Zone (Zona) está activada. Si la lectura de códigos de barras no 
se realiza correctamente, el software Capture Pro también buscará la 
zona después de girar la imagen 180º. Esto ralentiza la lectura de 
códigos de barras y digitalización, pero evita fallos de lectura si la página 
se digitalizó en sentido inverso. La imagen no se gira de forma 
permanente, a no ser que se seleccione la opción Rotate based on bar 
code (Girar según código de barras). 

• Alternatively search on the reverse side (Buscar de forma alternativa en 
reverso): si se activa esta opción, se aumenta la separación de documento/
lote y la precisión de indexación cuando se da la vuelta a las páginas 
accidentalmente antes de la digitalización.
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• Rotate based on bar code (Girar según código de barras): el software 
Capture Pro puede determinar si un código de barras se ha girado 180º 
y girará la página del código de barras 180º para mostrarla con la 
orientación correcta. Esta opción se utiliza para la separación de 
documentos. Todas las páginas del documento se girarán de la misma 
forma que la página inicial que contiene la zona de código de barras. Si esta 
opción es necesaria, solo una zona de código de barras debe tener la 
opción Rotate based on bar code (Girar según código de barras) activada. 

NOTA: El software Capture Pro no es compatible con la opción Batch 
rotation (Rotación de lotes).

Read all bar codes (Leer todos los códigos de barras): cuando esta opción 
está seleccionada y la opción Position (Posición) está configurada como 
Anywhere (Cualquier lugar), se leerán todos los códigos de barras de la 
página. Los valores de código de barras se separarán con el carácter ^. 
El orden de los valores será el orden en que se encontraron los códigos de 
barra al buscar de izquierda a derecha y de arriba hacia abajo en la página.

NOTA: Si selecciona la opción Read all bar codes (Leer todos los códigos de 
barras), la opción Process bar code by (Procesar código de barras 
mediante) debe estar establecida en Capture Pro. 

Separation (Separación): están disponibles las siguientes opciones:

• Create a new batch (Crear nuevo lote): después de la separación, todas 
las imágenes se incluyen en un documento nuevo de un lote nuevo.

• Create a new document (Crear nuevo documento): después de la 
separación, todas las imágenes se incluyen en un documento nuevo del 
lote actual.

• Next page stays in current document (La página siguiente se mantiene 
en el documento actual): después de la separación, la página siguiente 
permanece en el documento actual.

• Only separate when change in value (Separar solo cuando cambie un 
valor): el software separa por documento o lote solo si un valor cambia.

• No separation (Sin separación): seleccione Batch level (Nivel de lote) 
o Document level (Nivel de documento) para las zonas de códigos de 
barras:

- El código de barras se encuentra en: Batch level (Nivel de lote): los 
códigos de barras que se encuentran a nivel de lote o que separan lotes 
están disponibles para la indexación de lotes y documentos. Los códigos 
de barras de nivel de lote son de solo lectura cuando aparecen en una 
página de encabezado de lote. Se crea una página de encabezado de lote 
cada vez que se define la separación de lotes por códigos de parche 
o códigos de barras (al menos una zona de códigos de barras en la 
configuración de trabajo está configurada para la separación de lotes). 

- El código de barras se encuentra en: Document level (Nivel de 
documento): códigos de barras que se encuentran a nivel de documento 
o lotes independientes disponibles para la indexación de documentos. 
No están disponibles para la indexación de lotes.

• Delete Page (Eliminar página): seleccione esta opción para eliminar la 
página que contiene el código de barras con el que se ha iniciado el 
documento nuevo. Esto resulta importante cuando se emplean inserciones 
para la separación de documentos que no contienen información 
significativa. Sin embargo, el código de barras todavía está disponible para 
la indexación de nivel de documento.
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Cuadro de diálogo 
Configuración de 
páginas de zona

De forma predeterminada, la zona de código de barras (OCR, detección de 
marcas) solo se aplicará a la primera página de un documento. Para leer 
códigos de barras (extraer texto o buscar marcas) en páginas adicionales, 
utilice el cuadro de diálogo de configuración de páginas de zona para 
seleccionar una página específica o un rango de páginas. El cuadro de 
diálogo de configuración de páginas de zona se muestra al seleccionar el 
icono Select pages to apply for all zones (Seleccionar páginas para aplicar 
a todas las zonas), ubicado en la esquina inferior derecha del cuadro de 
diálogo de configuración de trabajo de código de barras, OCR y detección de 
marcas. El cuadro de diálogo Zone Pages Setup (Configuración de páginas de 
zona) le permite seleccionar de forma independiente la página o páginas a las 
que aplicar el código de barras, OCR o zona de detección definidos. 

Pages to read OCR zones (Páginas para leer zonas de OCR): se utiliza para 
seleccionar la página o páginas a las que se aplicarán las zonas de OCR 
definidas. Se pueden introducir varias páginas separando los números 
mediante comas “,”. Por ejemplo: “3,8”. Para cada zona de OCR definida, se 
comprobará la página o páginas especificadas en busca de texto válido. Si se 
encuentra texto válido en la zona, se asignará el texto leído a la zona. 
Cualquier texto válido dentro de la zona en una página siguiente sustituirá el 
texto leído anteriormente.

Si un documento tiene un número de páginas inferior al introducido, el valor de 
zona permanecerá vacío. Por ejemplo, si un documento tiene 6 páginas y el 
número de páginas para leer está establecido en “8, 11-15”, el valor de zona 
permanecerá vacío incluso si las 6 primeras páginas contienen texto válido 
dentro de la zona. 

Si necesita leer siempre el valor de la zona en la última página del documento 
y el documento puede contener un número de páginas variable, puede utilizar 
un asterisco “*” para leer todas las páginas del documento. El valor leído en la 
última página será el valor final asignado a la zona.

NOTA: Si el valor de la última página no es legible o es inválido, se asignará 
a la zona un valor válido de una página anterior.

Si Pages to read Bar Code (Páginas para leer código de barras) está vacío, 
no se leerá ninguna zona de OCR.
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Pages to read Bar Code (Páginas para leer código de barras): se utiliza para 
seleccionar la página o páginas a las que se aplicarán las zonas de código de 
barras definidas. Se pueden introducir varias páginas separando los números 
mediante comas “,”. Por ejemplo: “1,2,5,6”. Se puede introducir un rango de 
páginas introduciendo el primer número de página, un guion “-” y el último 
número de página. Por ejemplo: “3-8”. Para cada zona de código de barras 
definida, se comprobará la página o páginas especificadas en busca de un 
código de barras válido. Si se encuentra un código de barras válido en la 
zona, se asignará el valor de código de barras leído a esta zona. Cualquier 
código de barras válido dentro de la zona en una página siguiente sustituirá el 
código de barras leído anteriormente.

Si un documento tiene un número de páginas inferior al introducido, el valor de 
zona permanecerá vacío. Por ejemplo, si un documento tiene 6 páginas y el 
número de páginas para leer está establecido en “8, 11-15”, el valor de zona 
permanecerá vacío incluso si las 6 primeras páginas contienen uno o varios 
códigos de barras válidos dentro de la zona.

Si necesita leer siempre el valor de la zona en la última página del documento 
y el documento puede contener un número de páginas variable, puede utilizar 
un asterisco “*” para leer todas las páginas del documento. El valor leído en la 
última página será el valor final asignado a la zona. 

NOTA: Si el valor de la última página no es legible o es inválido, se asignará 
a la zona un valor válido de una página anterior.

Si el campo Pages to read Bar Code (Páginas para leer código de barras) está 
vacío, no se leerá ninguna zona de código de barras.

Pages to read OMR (Optical Mark Recognition) zones (Páginas para leer 
zonas de reconocimiento óptico de marcas [OMR]): especificar varias páginas 
para aplicar la detección de zonas de marcas no suele resultar útil. Si la zona 
de detección de marcas está definida como No Frame (Sin marco), la última 
página especificada en el rango de páginas determinará el valor de la zona de 
detección de marcas. Incluso las zonas de detección de marcas definidas 
como Frame (Con marco) pueden producir resultados poco satisfactorios.

Separación de 
documentos mediante 
zonas de código de 
barras

El software Capture Pro permite separar documentos con zonas de código de 
barras dentro de un lote:

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo) y elija 
un trabajo y un lote. 

2. Abra la pestaña Capture (Captura) y seleccione Separation > By Bar 
Code Zones (Separación > Por zonas de código de barras). Se mostrará 
la ventana de separación por zona de código de barras.

3. Seleccione una zona de código de barras existente o defina una zona 
nueva. 

4. Haga clic con el botón secundario del ratón para mostrar el menú 
contextual y haga clic en Zone Properties (Propiedades de zona). 
Se mostrará el cuadro de diálogo de configuración de zona de código de 
barras.

5. En Separation (Separación), seleccione Create a new document (Crear 
nuevo documento).

6. Active la opción Delete page (Eliminar página) si quiere eliminar la página 
que contiene el código de barras con el que se ha iniciado el documento 
nuevo.
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7. Introduzca valores en los campos Keep bar codes with mask (Conservar 
códigos de barras con máscara) o Minimum length (Longitud mínima) si 
desea restringir la separación de documentos a una máscara o valor de 
código de barras específicos.

8. Seleccione Rotate based on bar code (Girar según el código de barras) 
si desea rotar todas las páginas del documento en la misma orientación 
que la del código barras del encabezado de documento. La rotación del 
documento según el código de barras no funciona cuando se elimina la 
página de separación por código de barras.

Por ejemplo: 

Máscara = ”ER”9(8)”-”999 Longitud mínima = 14. Solo los valores de 
código de barras con una longitud de 14 caracteres, que empiezan con la 
cadena “ER” seguida por ocho caracteres numéricos, un guion y tres 
caracteres numéricos pueden iniciar un documento nuevo. 
Por ejemplo, el código de barras de número de paciente de la portada de 
una carpeta inicia un documento nuevo. En este caso, el número de 
paciente también se puede utilizar como índice de documento. Si un 
código de barras de la misma zona crea un lote con un determinado valor 
y un documento con otro valor, las dos zonas se deben dibujar una encima 
de otra. 

9. Una vez realizada la configuración, haga clic en OK (Aceptar) para cerrar 
el cuadro de diálogo y volver a la ventana Separación por código de 
barras.

10. Haga clic en OK (Aceptar) para guardar los valores y salir del cuadro de 
diálogo de configuración de trabajo. 

Separación de lotes 
mediante zonas de 
código de barras

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By Bar Code Zone (Separación > Por zona de 
código de barras). Se mostrará la ventana de separación por zona de 
código de barras.

4. Seleccione una zona de código de barras existente o defina una zona 
nueva.

5. Haga clic con el botón secundario del ratón para mostrar el menú 
contextual y haga clic en Zone Properties (Propiedades de zona). 
Se mostrará el cuadro de diálogo de configuración de zona de código de 
barras.

6. En Separation (Separación), seleccione Create new batch (Crear nuevo 
lote).

7. Haga clic en OK (Aceptar) para salir del cuadro de diálogo y volver a la 
ventana Separación por código de barra.

8. Haga clic en OK (Aceptar) para guardar los valores y salir del cuadro de 
diálogo de configuración de trabajo.

NOTAS:
• Las zonas de código de barras que se van a utilizar para la indexación 

a nivel de lote son de solo lectura cuando aparecen en una página de 
encabezado de lote.
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• Se crea una página de encabezado de lote cada vez que se define la 
separación de lotes por códigos de parche, códigos de barras o zonas de 
OCR (al menos una zona en el trabajo está configurada para la separación 
de lotes).

Edición de una zona 
de código de barras

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job name 
(Nombre del trabajo).

3. Abra la pestaña Capture (Captura) y seleccione Separation > By Bar 
Code Zones (Separación > Por zonas de código de barras). Se mostrará 
la ventana de separación por zona de código de barras.

4. Haga clic en la zona de código de barras que desee cambiar o haga clic 
sobre su nombre en la lista de la parte derecha de la ventana de 
separación por zona de código de barras. 

5. Haga clic con el botón secundario del ratón para mostrar el menú 
contextual y haga clic en Zone Properties (Propiedades de zona). 
Se mostrará el cuadro de diálogo de configuración de zona de código de 
barras.

6. Una vez que haya modificado la configuración, haga clic en OK (Aceptar) 
para cerrar el cuadro de diálogo.

7. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de trabajo. 

8. Después de editar la zona de código de barras, compruebe el código de 
barras para asegurarse de que aún puede leerse. 

Eliminación de una 
zona de código de 
barras

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job name 
(Nombre del trabajo).

3. Abra la pestaña Capture (Captura) y seleccione Separation > By Bar 
Code Zones (Separación > Por zonas de código de barras). Se mostrará 
la ventana de separación por zona de código de barras.

4. Haga clic en la zona de código de barras que desee eliminar. También 
puede hacer clic en el nombre de la zona de código de barras en la lista 
que aparece a la izquierda en la ventana Código de barras. Se resaltará la 
zona.

5. Haga clic en Delete (Eliminar). 

6. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de trabajo. 
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Transferencia de una 
imagen a la ventana 
Código de barras

El software Capture Pro permite transferir una imagen con códigos de barras 
desde el visor de imágenes hasta la ventana de código de barras para crear 
zonas de código de barras. 

1. En la ventana principal, digitalice la imagen que contiene el código de 
barras.

2. Localice en el visor de imágenes la imagen que quiera transferir y haga 
clic en ella con el botón secundario.

3. Seleccione Copy Image to Job Setup (Copiar imagen a la configuración 
de trabajo). Se mostrará el cuadro de diálogo para copiar la imagen a la 
configuración de trabajo.

4. Escriba el nombre de la imagen nueva en el campo Save image as 
(Guardar imagen como).

5. Haga clic en OK (Aceptar). Ahora puede visualizar la imagen en la 
ventana Código de barras y utilizarla para crear una zona de código de 
barras.

También puede digitalizar imágenes de código de barras directamente en la 
ventana Código de barras. Consulte la sección “Digitalización de una imagen 
para la configuración de códigos de barras”, que aparece anteriormente en 
este capítulo.

Definición del rango 
para el tamaño de 
imagen de código de 
barras

Cuando se definen zonas de código de barras, se comprobará cada una de 
las páginas digitalizadas para ver si contienen esos códigos de barras. 
Esta comprobación puede ralentizar el rendimiento de la digitalización. Si las 
páginas de códigos de barras tienen siempre aproximadamente el mismo 
tamaño de bytes y si ese tamaño varía con respecto al de otras páginas que 
digitalice, puede indicar al software que solo es necesario comprobar la 
existencia de códigos de barras en las imágenes que se encuentren dentro de 
un rango de tamaño determinado (recuento de bytes). Esta configuración 
puede acelerar el rendimiento de digitalización.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By Bar Code Zones (Separación > Por zonas 
de código de barras). Se mostrará la ventana de separación por zona de 
código de barras.
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4. Seleccione cualquier imagen y haga clic con el botón secundario en una 
zona de código de barras. Se mostrará el cuadro de diálogo de 
propiedades generales de zona OCR y código de barras.

NOTA: Si no existe una zona de código de barras, esta opción no estará 
disponible hasta que se defina una zona de código de barras.

5. Active la casilla de verificación Extract bar codes/OCR from images 
between (Extraer códigos de barras/OCR de imágenes entre) y 
especifique un rango para el tamaño máximo y mínimo de bytes.

6. Después de definir los valores de configuración, haga clic en OK (Aceptar) 
para cerrar el cuadro de diálogo y volver a la ventana Bar Code (Código de 
barras).

7. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de trabajo. Se guarda el nuevo rango de imagen.

8. Después de editar la zona de código de barras, pruebe la zona de código 
de barras para verificar que aún sea legible. 

NOTA: Al digitalizar imágenes en blanco y negro y en color/escala de 
grises, especifique el rango de la imagen en blanco y negro.

Creación de datos 
adjuntos con zonas 
de código de barras

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo), elija un 
trabajo y abra la pestaña Capture (Captura). 

2. Seleccione Separation > By Bar Code Zones (Separación > Por zonas 
de código de barras). Se mostrará la ventana de código de barras.

3. Seleccione una zona de código de barras existente o defina una zona 
nueva. 

4. Haga clic con el botón secundario del ratón para mostrar el menú 
contextual y haga clic en Zone Properties (Propiedades de zona). 
Se mostrará el cuadro de diálogo de configuración de zona de código de 
barras.

5. En Separation (Separación), seleccione Next page stays in current 
document (La página siguiente se mantiene en el documento actual). 
Esta opción solo es válida para una página de adjunto. Si es necesario 
agregar varios adjuntos, deberá aplicar un código de barras de adjunto 
a cada uno de ellos. El código de barras de la página de adjunto no está 
disponible para la indexación.

6. Seleccione la opción Delete page (Eliminar página) para eliminar el 
anverso y el reverso de la página que contiene el código de barras 
y utilizar la siguiente página como adjunto. Esto resulta útil para realizar 
inserciones indicando si la siguiente página es un adjunto. Cualquier 
rotación se aplicará a la siguiente página.

7. Introduzca valores en los campos Keep bar codes with mask (Conservar 
códigos de barras con máscara) o Minimum length (Longitud mínima) si 
desea restringir los adjuntos a una máscara o valor de código de barras 
específicos.
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8. Seleccione la casilla de verificación Rotate based on bar code (Girar 
según código de barras) si desea girar los adjuntos (anverso y reverso) en 
la misma orientación que la del código de barras de la página.

9. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo.

Prueba de zonas de 
código de barras 

Al definir una zona de código de barras nueva desde una imagen, el software 
Capture Pro comprueba automáticamente la zona para verificar que sea 
legible. Sin embargo, si edita la zona de código de barras o modifica sus 
propiedades más adelante, dejará de ser legible. Puede probar las zonas de 
código de barras manualmente para verificar que el software Capture Pro 
pueda leerlas.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By Bar Code Zones (Separación > Por zonas 
de código de barras). Se mostrará la ventana de código de barras.

4. Haga clic en el icono Test All Bar Code, OCR & Mark Detection Zones 
(Probar todas las zonas de código de barras, OCR y detección de marcas) 
para probar todos los códigos de barras, o haga clic en el icono Test 
Selected Bar Code, OCR & Mark Detection Zones (Probar zona de 
código de barras, OCR y detección de marcas seleccionada) para probar 
una zona de código de barras individual. Se mostrará el cuadro de diálogo 
de valores de código de barras, OCR y detección de marcas.

5. Después de visualizar los valores de este cuadro, haga clic en OK 
(Aceptar) para volver a la ventana de código de barras.

6. Haga clic en OK (Aceptar) para guardar los valores y salir del cuadro de 
diálogo de configuración de trabajo. Todas las zonas de código de barras 
se han probado. Si realiza cambios en los valores de configuración de 
código de barras, pruebe los códigos de nuevo.

Tipos de códigos de 
barras

El software Capture Pro es compatible con los siguientes tipos de códigos de 
barras:
• Airline 2 de 5
• Aztec
• Barcode 32
• CODABAR
• Code 128
• Code 2 of 5: mutuamente excluyente con Interleaved 2 of 5
• Code 3 of 9
• Code 39 (sin parada en inicio)
• Code 39 Extended
• Code 93
• DataMatrix
• EAN 13
• EAN 8
• Intelligent Mail Barcode
• Interleaved 2 of 5: mutuamente excluyente con Code 2 of 5 
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• PDF417: un tipo de código de barras bidimensional de alta densidad que 
puede contener hasta 1250 bytes de información en un espacio reducido. 
Con este tipo de densidad, todos los datos de índice de un documento 
pueden contenerse en un único código de barras.

• Planet (Código de los servicios postales de los EE. UU.)
• PostNet (postal): no puede seleccionarse con ningún otro tipo de código de 

barras 
• QR Code
• UCC Code 128
• UPC-A
• UPC-E

Sintaxis especial para 
códigos de barras 
bidimensionales

Cuando se utilizan códigos de barras bidimensionales, se puede utilizar un 
único código de barras que contenga todos los datos de índice de un 
documento o lote. Para facilitar el índice con códigos de barras de dos 
dimensiones, se ha añadido una sintaxis especial con subcadenas: 

<códigodebarras.nombredezona:[inicio;longitud]>
<códigodebarras.nombredezona:[inicio;fin]>
<códigodebarras.nombredezona:[n.º de elementos de datos, delimitador 
(con comillas simples)]>

El delimitador puede ser el símbolo real del carácter o su valor numérico 
decimal ASCII (para símbolos que no se pueden imprimir ni escribir). 
El delimitador debe ir entre comillas dobles (“ ”). 

Por ejemplo, si un código de barras PDF417 contiene los siguientes datos: 
12345678*ENFERMERÍA*11/19/1962, los siguientes datos pueden usarse 
como valores predeterminados para tres campos de índice de datos: 

Uso de zonas de OCR OCR (Reconocimiento Óptico de Caracteres) es la traducción mecánica 
o electrónica de imágenes de texto escrito o impreso (normalmente, 
capturado mediante un escáner) para convertirlo en texto que pueda editarse 
en una máquina.

La configuración de OCR permite definir lo siguiente:

• El nombre de la zona de OCR
• La ubicación física en la que se encontrará el texto (ubicación de la zona en 

la imagen)
• El nivel en el que se puede encontrar el texto (nivel de lote o documento)

Valor predeterminado Valor real
<BC.PDF417:[1, '*']> 12345678
Devuelve el primer elemento de la cadena de código de barras delimitado 
por un asterisco.
<BC.PDF417:[2, '42']> GUARDERÍA
Devuelve el segundo elemento de la cadena de código de barras delimitado 
por un asterisco (42 es el valor decimal ASCII del asterisco).
<BC.PDF417:[3, '*']> 19/11/1962
Devuelve el tercer elemento de la cadena de código de barras delimitado por 
un asterisco.
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Utilice la función Bar Code, OCR and Mark Detection Setup (Configuración de 
códigos de barras, OCR y detección de marcas) de la pestaña Capture 
(Captura) en el cuadro de diálogo Job Setup (Configuración de trabajo) para 
configurar el lector de códigos de barras de modo que lea uno o varios 
parámetros de códigos de barras o de OCR para una o varias zonas de OCR.

La configuración de separación por zona de OCR de la pestaña Capture 
(Captura) en el cuadro de diálogo Job Setup (Configuración de trabajo) 
permite digitalizar una imagen en la ventana Separation by OCR Zone 
(Separación por zona de OCR), así como definir zonas y propiedades 
específicas de zona de OCR. 

NOTA: Los componentes de las ventanas Separation by Bar Code 
(Separación por código de barras) y Separation by OCR Zone 
(Separación por zona de OCR), los iconos y el menú contextual se 
describen de forma detallada en las secciones “Ventana Código de 
barras, OCR y detección de marcas” y “Menú contextual de las 
ventanas de código de barras, OCR y detección de marcas”, que 
aparecen anteriormente en este capítulo.

La indexación de OCR utiliza bibliotecas de idioma locales y permite leer texto 
alfanumérico a alta velocidad (1000 caracteres/segundo). Es zonal (similar 
a la lectura de códigos de barras) y se procesa durante la digitalización. 

El software Capture Pro es compatible con la siguiente información de texto 
para el OCR:

- Ligaduras (caracteres “unidos”)
- Caracteres rotos
- Caracteres degradados
- Texto con una resolución de 200 a 600 dpi
- Fuentes de texto de 8 a 72 puntos
- Números de 0 a 9
- Letras de A-Z y a-z
- Símbolos ! " $ % & ( ) * + , - . / :, ; < = > ? @ [ \ ] { } £ • ß ´ ª

• Para obtener mejores resultados, utilice una resolución de 300 dpi y un tipo 
de fuente sans serif de 12 puntos (o superior si utiliza resoluciones 
inferiores a 300 dpi). No utilice documentos que estén torcidos.

• El software Capture Pro es compatible con una amplia variedad de idiomas 
para la indexación OCR. Para ver una lista de estos idiomas:

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job 
Name (Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By OCR Zones (Separación > Por zonas de 
OCR). Se mostrará la ventana de separación por zonas de OCR.
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4. Haga clic en cualquier zona de OCR y seleccione Zone Properties 
(Propiedades de zona). Se mostrará el cuadro de diálogo de 
configuración de zona OCR.

5. Seleccione el idioma del texto entre los idiomas disponibles en la lista 
desplegable Language (Idioma).

Digitalización de una 
imagen para la 
configuración de OCR

El software Capture Pro permite separar páginas digitalizadas en lotes 
y documentos basándose en zonas de OCR. Estas zonas de OCR también 
permiten crear adjuntos a sus documentos. 

Antes de utilizar el texto de OCR como separador, debe realizar las siguientes 
acciones:

1. Digitalice una imagen que contenga texto de OCR con el software 
Capture Pro. 

2. Cree y defina las zonas de OCR. 

3. Configure el trabajo para la separación por zonas de OCR.

Para digitalizar una imagen directamente en la ventana Separación por zona 
de OCR:

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura). 

3. Seleccione Separation > By OCR Zones (Separación > Por zonas de 
OCR). Se mostrará la ventana de separación por zonas de OCR. 
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4. Coloque el documento original en el alimentador y haga clic en Start/Scan 
(Iniciar/Digitalizar). La imagen se mostrará en el cuadro de diálogo. 
Digitalice la imagen lo más enderezada posible. El escáner utilizará los 
parámetros de la configuración de página actual del software Capture Pro. 

NOTAS:
• Los parámetros de la configuración de trabajo actual se también se 

aplicarán a la imagen digitalizada antes de que se visualice.

• Si la imagen es aceptable, introduzca un nombre en el campo Image 
Name (Nombre de la imagen). El nombre de la imagen no debe contener 
ninguno de los siguientes caracteres especiales: : “ ? * . < > \ / . 

• Para descartar la imagen, haga clic en Cancel (Cancelar).

• Antes de poder definir una zona de OCR, debe tener al menos una 
imagen en la lista desplegable Image (Imagen).

• Puede transferir una imagen desde el visor de imágenes a la ventana 
separación por zona de OCR. Para obtener más información, consulte la 
sección “Transferencia de una imagen a la ventana OCR”, que aparece 
más adelante en este capítulo.

5. Haga clic en OK (Aceptar).

Creación y selección de 
una zona de OCR

Antes de poder utilizar una imagen de OCR para separar documentos o lotes, 
debe crear y seleccionar una zona de OCR. 

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione la configuración Separation > By OCR Zones (Separación > 
Por zonas de OCR). Se mostrará la ventana de separación por zonas de 
OCR.

4. Seleccione una imagen de la lista desplegable Image (Imagen). Si es 
necesario digitalizar la imagen, haga clic en el icono verde Start/Scan 
(Iniciar/Digitalizar) de la ventana de separación por zona de OCR. 
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NOTA: Coloque el cursor del ratón en la esquina superior izquierda del 
área de la imagen mostrada en la que desea definir la ubicación 
para esta zona de OCR. Para la indexación OCR de longitud 
y altura variable, asegúrese de dibujar una zona lo suficientemente 
grande para capturar todos los datos de indexación. A la vez, tenga 
cuidado de no dibujar una zona demasiado grande que capture 
datos (como líneas de un formulario) de forma accidental.

Las zonas de OCR son específicas del trabajo, no de la imagen. Por 
ello, cuando visualice una nueva imagen, se seguirán mostrando las 
zonas que haya definido utilizando imágenes anteriores.

5. Haga clic con el botón primario del ratón y arrastre el cursor para dibujar 
un rectángulo alrededor del área de texto. Cuando suelte el cursor, se 
mostrará el cuadro de diálogo de configuración de zona OCR.

6. En el campo Zone name (Nombre de zona), introduzca un nombre para la 
nueva zona de OCR. Deberá poner un nombre para guardar la zona.

7. Una vez realizada la configuración, haga clic en OK (Aceptar) para cerrar 
el cuadro de diálogo y volver a la ventana de separación por zona de 
OCR.

8. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de trabajo. 

Cuadro de diálogo 
Configuración de zona 
de OCR

Las zonas de OCR proporcionan información determinada al software Capture 
Pro, como las dimensiones de la zona. Después de dibujar una zona de OCR, 
el software Capture Pro intenta leer la información contenida en la zona 
y muestra automáticamente la ventana de propiedades de zona de OCR con 
el texto que el software ha podido leer.

NOTA: La función OCR tiene dificultades para leer caracteres subrayados y en 
cursiva de los conjuntos de caracteres asiáticos. Para aumentar la 
fiabilidad de OCR, se recomienda utilizar imágenes en blanco y negro.

Zone name (Nombre de zona): introduzca un nombre para la zona de OCR. 
Es necesario asignar un nombre a la zona de OCR para poder guardarla. 

Side (Cara): Front (Anverso) o Back (Reverso): seleccione si la zona de OCR 
está ubicada en el anverso o el reverso de una imagen.
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Rule for values to keep (Regla para mantener valores): puede introducir 
cualquier expresión de texto válida de formato de entrada o dejar este campo 
en blanco. Si introduce cualquier expresión con formato de texto de entrada, 
únicamente se mantendrán las cadenas de lectura de OCR que cumplan esta 
regla. Por ejemplo, si se introduce la expresión A<10>, únicamente se 
mantendrán las cadenas de lectura de OCR que contengan 10 o menos 
caracteres alfanuméricos. Para obtener más información consulte “Formatos 
de entrada” en el capítulo 2.

Search for value in zone (Buscar valores en la zona): cuando la opción Rule 
for values to keep (Regla para mantener valores) está definida como un 
formato de cadena fija, el valor de lectura de la zona de OCR solamente debe 
contener cadenas fijas para que se mantenga el valor.

Por ejemplo, si la Regla para mantener valores (Regla para mantener 
valores) está definida como Formulario 1099, las siguientes cadenas de 
lectura serán lecturas válidas y, si se selecciona, se producirá la separación 
de documentos o lotes.

“77644 formulario 1099 - revisión 1,2”
“81763 formulario 1099 - revisión 1,4”
“77644 formulario 1099 - revisión 2,2”

Character set rule (Regla de conjuntos de caracteres): no aplicable en este 
momento.

Primary language (Idioma principal): seleccione el idioma principal adecuado 
para garantizar que el software Capture Pro funcione adecuadamente con los 
caracteres de OCR especiales específicos de un idioma (por ejemplo, ç o ü). 
Utilice la lista desplegable para mostrar una lista de idiomas compatibles.

Secondary language (Idioma secundario): si una zona contiene caracteres 
de más de un idioma, es posible seleccionar uno o varios idiomas 
secundarios.

Custom dictionary (Diccionario personalizado): puede utilizar un diccionario 
personalizado para mejorar la precisión en el reconocimiento de palabras 
únicas o poco frecuentes que aparecen en su conjunto de documentos. Haga 
clic en Browse (Examinar) para seleccionar un diccionario personalizado. 

Separation (Separación): están disponibles las siguientes opciones:

• Create a new batch (Crear nuevo lote): después de la separación, todas 
las imágenes se incluyen en un documento nuevo de un lote nuevo.

• Create a new document (Crear nuevo documento): después de la 
separación, todas las imágenes se incluyen en un documento nuevo del 
lote actual.

• Next page stays in current document (La página siguiente se mantiene 
en el documento actual): después de la separación, la página siguiente 
permanece en el documento actual.

No separation (Sin separación): seleccione una de las siguientes opciones:

• OCR is located on (OCR se encuentra en): Document level (Nivel de 
documento): las zonas de OCR incluidas en el nivel de documento y las 
zonas de OCR que separan los documentos están disponibles para la 
indexación de documentos. Sin embargo, no están disponibles para la 
indexación de lotes.
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• OCR is located on (OCR se encuentra en): Batch level (Nivel de lote): 
las zonas de OCR incluidas en el nivel de lote y las zonas de OCR que 
separan los lotes están disponibles para la indexación de lotes 
y documentos. 

Only separate when change in value (Separar solo cuando cambie un 
valor): el sistema separa por documento o lote solo si un valor cambia.

Eliminar página (Delete page): elimina la página que contiene el valor de 
lectura de OCR que ha iniciado la separación.

OK (Aceptar): permite cerrar el cuadro de diálogo y volver a la ventana de 
separación por zona de OCR.

Aplicación de zonas de 
OCR a páginas 
específicas

Para obtener información acerca de cómo seleccionar la página o páginas 
a las que aplicar todas las zonas de OCR, consulte la sección “Cuadro de 
diálogo Configuración de páginas de zona”, que aparece anteriormente en 
este capítulo. 

Separación de 
documentos mediante 
zonas OCR

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By OCR Zones (Separación > Por zonas de 
OCR). Se mostrará la ventana de separación por zonas de OCR.

4. Seleccione una imagen de la lista desplegable Image (Imagen). Si es 
necesario digitalizar la imagen, haga clic en el icono verde Start/Scan 
(Iniciar/Digitalizar) de la ventana de separación por zona de OCR.

NOTA: Utilice el ratón para dibujar la zona de OCR. Se mostrará el cuadro 
de diálogo de configuración de zona OCR.

5. En Separation (Separación), haga clic en la opción Create a new 
document (Crear nuevo documento).

6. Haga clic en OK (Aceptar) para salir del cuadro de diálogo y volver a la 
ventana de separación por zona de OCR.

7. Haga clic en OK (Aceptar) para guardar los valores y salir del cuadro de 
diálogo de configuración de trabajo. 

NOTA: Se crea una página de encabezado de lote cada vez que se define 
la separación de lotes por códigos de parche, códigos de barras 
o zonas de OCR (al menos una zona en la configuración de trabajo 
está configurada para la separación de lote).
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Separación de lotes 
mediante zonas de OCR

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By OCR Zones (Separación > Por zonas de 
OCR). Se mostrará la ventana de separación por zonas de OCR.

4. Seleccione una imagen de la lista desplegable Image (Imagen). Si es 
necesario digitalizar la imagen, haga clic en el icono verde Start/Scan 
(Iniciar/Digitalizar) de la ventana de separación por zona de OCR.

5. Utilice el ratón para dibujar la zona de OCR. Se mostrará el cuadro de 
diálogo de configuración de zona OCR. Si define un área en una imagen 
para la separación de lotes por OCR, dicha área debe permanecer en 
blanco en todas las páginas restantes del lote. 

6. En Separation (Separación), haga clic en la opción Create a new batch.

7. Haga clic en OK (Aceptar) para salir del cuadro de diálogo y volver a la 
ventana de separación por zona de OCR.

8. Haga clic en OK (Aceptar) para guardar los valores y salir del cuadro de 
diálogo de configuración de trabajo. 

NOTA: Las zonas de OCR de nivel de lote solo se leen cuando están 
presentes en una página de encabezado de lote. Se crea una página 
de encabezado de lote cada vez que se define la separación de lotes 
por códigos de parche, códigos de barras o zonas de OCR (al menos 
una zona en la configuración de trabajo está configurada para la 
separación de lote). 

Para obtener información sobre la separación de lotes durante la digitalización 
en color/escala de grises, consulte la sección “Uso de separadores durante la 
digitalización en color”, que aparece más adelante en este capítulo.

Edición de las 
propiedades de una 
zona de OCR

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By OCR Zones (Separación > Por zonas de 
OCR). Se mostrará la ventana de separación por zonas de OCR. 

4. Haga clic en la OCR zone (Zona de OCR) que desee cambiar o haga clic 
en el nombre de la zona de OCR en la lista de la parte izquierda de la 
ventana de separación por zona de OCR.

5. Haga clic con el botón secundario del ratón para mostrar el menú 
contextual y haga clic en Zone Properties (Propiedades de zona). 
Se mostrará el cuadro de diálogo de configuración de zona OCR.

6. Una vez que haya modificado la configuración, haga clic en OK (Aceptar) 
para cerrar el cuadro de diálogo y volver a la ventana de separación por 
zona de OCR.

7. Haga clic en OK (Aceptar) para guardar los valores y salir del cuadro de 
diálogo de configuración de trabajo.

Después de editar la zona de OCR, pruebe la zona de OCR para verificar que 
aún sea legible.
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Eliminación de una 
zona OCR

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By OCR Zones (Separación > Por zonas de 
OCR). Se mostrará la ventana de separación por zonas de OCR.

4. Haga clic en la zona de OCR que desee eliminar. También puede hacer 
clic en el nombre de la zona de OCR en la lista que aparece a la izquierda 
en la ventana de separación por zona de OCR. Se resaltará la zona.

5. Haga clic en Delete (Eliminar). 

6. Haga clic en OK (Aceptar). 

Transferencia de una 
imagen a la ventana 
OCR

Puede digitalizar una imagen que contenga texto para OCR directamente en 
el visor de imágenes y, a continuación, transferirla a la ventana de separación 
por zona de OCR para crear una zona de OCR.

1. Digitalice la imagen que contiene el texto de OCR.

2. Localice la imagen en el visor de imágenes y haga clic en ella con el botón 
secundario.

3. Seleccione Copy image to job setup (Copiar imagen a la configuración 
de trabajo). Se mostrará el cuadro de diálogo para copiar la imagen a la 
configuración de trabajo.

4. Escriba el nombre de la imagen nueva en el campo Save image as 
(Guardar imagen como).

5. Haga clic en OK (Aceptar).

Definición del rango 
para el tamaño de 
imagen OCR

En ocasiones, una imagen de OCR es demasiado pequeña para ser legible. 
Puede establecer un rango de tamaño de imagen para excluir las imágenes 
que sean demasiado pequeñas.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By OCR (Separación > Por OCR). Se mostrará 
la ventana de separación por zonas de OCR.

4. Seleccione cualquier imagen y haga clic con el botón secundario en la 
zona OCR. Se mostrará el cuadro de diálogo de propiedades generales de 
zona OCR y código de barras.

NOTA: Si no existe una zona OCR, esta opción no estará disponible hasta 
que se defina una zona OCR.
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5. Active la casilla de verificación Extract bar codes/OCR from images 
between (Extraer códigos de barras/OCR de imágenes entre) y 
especifique un rango para el tamaño máximo y mínimo de bytes.

6. Una vez que haya realizado la configuración, haga clic en OK (Aceptar) 
para cerrar el cuadro de diálogo y volver a la ventana de separación por 
zona de OCR.

7. Después de editar la zona de OCR, pruebe la zona de OCR para verificar 
que aún sea legible. 

Creación de datos 
adjuntos mediante 
zonas de OCR

La creación de adjuntos es útil en trabajos en los que normalmente cada una 
de las páginas es un documento (p. ej., documentos de transacciones, como 
cheques, billetes de avión, facturas, etc.), pero en los que puede haber una 
página (como una nota correspondiente) que debe adjuntarse a un 
documento.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By OCR Zones (Separación > Por zonas de 
OCR). Se mostrará la ventana de separación por zonas de OCR.

4. Seleccione una imagen de la lista desplegable Image (Imagen). Si es 
necesario digitalizar la imagen, haga clic en el icono verde Start/Scan 
(Iniciar/Digitalizar) de la ventana de separación por zona de OCR 

5. Utilice el cursor para definir la zona de OCR de la imagen donde espera 
encontrar el texto de OCR. El área definida para los adjuntos de OCR 
debe estar en blanco en todas las demás páginas del lote. Se mostrará el 
cuadro de diálogo de configuración de zona OCR.

6. En Separation (Separación), seleccione Next page stays in current 
document (La página siguiente se mantiene en el documento actual). 
Esta opción solo es válida para una página de adjunto. Si es necesario 
agregar varios adjuntos, deberá aplicar una zona de OCR de adjunto 
a cada uno de ellos. La zona de OCR de la página de adjunto no está 
disponible para la indexación.

7. Seleccione Delete page (Eliminar página) para eliminar la página (tanto el 
anverso como el reverso) que contiene la zona de OCR y utilizar la 
siguiente página como adjunto. Esto resulta útil para realizar inserciones 
indicando si la siguiente página es un adjunto.

8. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo.
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Prueba de zonas OCR Al definir una zona de OCR nueva desde una imagen, el software Capture Pro 
comprueba automáticamente la zona para verificar que sea legible. Sin 
embargo, si edita la zona OCR o modifica sus propiedades más adelante, 
dejará de ser legible. Puede probar las zonas de OCR manualmente para 
verificar que siguen siendo legibles.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Separation > By OCR Zones (Separación > Por zonas de 
OCR). Se mostrará la ventana de separación por zonas de OCR. 

4. Haga clic en el icono Test All Bar Code, OCR & Mark Detection Zones 
(Probar todas las zonas de código de barras, OCR y detección de marcas) 
para probar todas las zonas de OCR, o haga clic en Test Selected Bar 
Code, OCR & Mark Deletion Zone (Probar zona de código de barras, 
OCR y detección de marcas seleccionada) para probar una zona de OCR 
individual. Se mostrará el cuadro de diálogo de valores de código de 
barras, OCR y detección de marcas.

5. Después de ver los valores, haga clic en OK (Aceptar) para volver a la 
ventana de separación por zona de OCR.

6. Haga clic en OK (Aceptar). Si realiza cambios en los valores de 
configuración de zona OCR, pruebe las zonas de nuevo.

Uso de separadores 
durante la 
digitalización en 
color

El software Capture Pro puede digitalizar imágenes en color, en escala de 
grises y en blanco y negro con separadores (zonas de código de barras, 
zonas de OCR o códigos de parche). Las imágenes se pueden separar 
o combinar. Para separar estas imágenes en color o escala de grises de forma 
rápida y fiable, el software Capture Pro emplea imágenes duplicadas en 
blanco y negro para leer los separadores.

Cuando se digitalizan tanto imágenes en color/escala de grises como 
imágenes en blanco y negro y el software detecta una zona de código de 
barras, un código de parche o una zona de OCR, el software elimina las 
cuatro imágenes de la página (anverso en color, reverso en color, anverso en 
blanco y negro y reverso en blanco y negro) o las adjunta al nuevo documento 
o lote actual. Esta acción vendrá determinada por la configuración del cuadro 
de diálogo de configuración de zona de código de barras, de configuración de 
código de parche o de configuración de zona de OCR.

Cuando digitalice sólo imágenes a color o en escala de grises, el software 
leerá las imágenes duplicadas en blanco y negro. Aunque estas imágenes en 
blanco y negro nunca se muestran ni se generan, se utilizan para la lectura de 
códigos de barras, de códigos de parche y de indexación de OCR.
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Configuración de una 
imagen en color para 
zonas de códigos de 
barras/OCR 

El software Capture Pro puede utilizar imágenes en color o en escala de 
grises como fuente para códigos de barras o texto de OCR. Sin embargo, 
el rendimiento y la fiabilidad del software Capture Pro mejorarán si se utiliza 
como fuente una imagen en blanco y negro.

1. Seleccione Capture > Page Setup List (Lista de configuraciones de 
página). Se mostrará el cuadro de diálogo de lista de configuraciones de 
página.

2. Seleccione una configuración de página de digitalización simultánea en la 
lista (p. ej., color y blanco y negro, 200 dpi, eliminar hojas en blanco).

3. Coloque el original en color/escala de grises en el escáner y haga clic en 
el icono verde Start/Scan (Iniciar/Digitalizar). Las imágenes se mostrarán 
en el visor de imágenes.

4. Seleccione la imagen en blanco y negro que contiene zonas de código de 
barras y OCR, y haga clic con el botón secundario del ratón para mostrar 
el menú contextual Imagen.

5. Seleccione Edit > Copy Image (Editar > Copiar imagen) en configuración 
de código de barras/OCR. Se mostrará el cuadro de diálogo para copiar la 
imagen a la configuración de trabajo.

6. Escriba el nombre de la imagen nueva en el cuadro de texto y haga clic en 
OK (Aceptar).

7. Haga clic en File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

8. Abra la pestaña Capture (Captura) y seleccione Separation > By Bar 
Code Zones (Separación > Por zonas de código de barras) o Separation 
By OCR Zones (Separación por zonas de OCR). En función de su 
selección, se mostrará la ventana de separación por código de barras o de 
separación por zona de OCR.

9. El nuevo nombre de la imagen se mostrará en el cuadro desplegable 
Image (Imagen). Siga los procedimientos para definir una zona de código 
de barras o una zona de OCR, que se describieron en el capítulo anterior. 

10. Haga clic en OK (Aceptar).
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Descargos de 
responsabilidad de 
código de barras 
y OCR

Copyright 2000-2015, AllMyPapers, Todos los derechos reservados.

Este software incluye ABBYY® FineReader®. ABBYY y FineReader son 
marcas comerciales registradas de ABBYY. Si la instalación original de este 
software fue Capture Pro versión 5.5 o anterior, el software incluye OmniPage/
-E OCR © 1995-2017 Nuance Communications, Inc. Todos los derechos 
reservados.

Las siguientes condiciones de exención de responsabilidad en relación con el 
código de barras, el OCR y la detección de marcas se aplican al software 
Capture Pro.

Aunque el producto utiliza una tecnología vanguardista de OCR, código de 
barras y detección de marcas, no es posible garantizar un reconocimiento 
preciso en todas las condiciones. Todo el software y la documentación se 
entregan tal cual, sin ninguna garantía expresa o implícita de precisión de 
reconocimiento de códigos de barras, OCR y detección de marcas.

Kodak Alaris Inc. o sus distribuidores no serán responsables de ningún daño 
directo o indirecto derivado de un uso ilegal o de las infracciones en las que 
pueda incurrir un usuario al modificar, copiar, reproducir o convertir cualquier 
información obtenida mediante el uso de las tecnologías de reconocimiento de 
códigos de barras, OCR y detección de marcas del software Capture Pro.

Uso de las zonas de 
detección de marcas

La detección de marcas es un método de detección de la presencia o 
ausencia de una marca de tinta dentro de un área específica que se utiliza 
para transmitir algún tipo de información.

Un buen diseño de documentos e instrucciones claras para los encuestados 
son muy importantes para obtener mayor precisión. Se recomienda imprimir 
muestras de modelos con casillas de verificación bien rellenadas y mal 
rellenadas, e incluirlas en las instrucciones. Los encuestados deberán rellenar 
el documento con tinta azul oscura o negra. Deberán evitar el uso de lápices 
y de bolígrafos con un color de tinta similar al color de omisión, si el color del 
formulario se omite durante la digitalización.

La configuración de la detección de marcas permite definir lo siguiente:

• El nombre de la zona de detección de marcas.

• La ubicación física en la que se encontrará la marca (ubicación de la zona 
en la imagen).

• El valor cuando se detecta una marca.

• El valor cuando no se detecta una marca.

• Si la marca se encuentra contenida en un marco, como un casillero 
o círculo.

• La sensibilidad para distinguir una marca debido a la suciedad o un “ruido” 
de raya.

• Un grupo de zonas de detección de marca para devolver un único conjunto 
de valores.

Utilice la opción Configuración de códigos de barras, OCR y detección de 
marcas de la pestaña Captura en el cuadro de diálogo Configuración de 
trabajo para configurar los parámetros de detección de marcas para una 
o varias zonas de detección de marcas.
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NOTAS:

• La separación de lotes y documentos no se proporciona para las zonas 
de detección de marcas.

• Para obtener mejores resultados, utilice imágenes con una resolución de 
300 dpi. 

Digitalización de una 
imagen para la 
configuración de 
detección de marcas

El software Capture Pro permite capturar y guardar el estado de una zona de 
marca o un grupo de zonas de marca.

Para utilizar la detección de marcas:

• Digitalice una imagen que contenga las zonas de marca en el software 
Capture Pro.

• Dibuje y seleccione las zonas de detección de marcas.

• Configure grupos opcionales de zonas de detección de marcas.

El software Capture Pro permite digitalizar imágenes de detección de marcas 
directamente en la ventana de detección de marcas para su visualización, 
definición y edición.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job name 
(Nombre del trabajo).

3. Abra la pestaña Capture (Captura) y seleccione Bar Code, OCR and 
Mark Detection (Código de barras, OCR y detección de marcas). 
Se mostrará la ventana de detección de marcas.

4. Seleccione el botón verde Start/Scan (Iniciar/Digitalizar). Se mostrará el 
cuadro de diálogo para digitalizar imágenes.

5. Coloque el documento original en el alimentador y haga clic en Start/Scan 
(Iniciar/Digitalizar). La imagen se mostrará en el cuadro de diálogo. 
Digitalice la imagen lo más enderezada posible. El escáner utilizará los 
parámetros de la configuración de página actual del software Capture Pro.

NOTAS:

• Los valores de configuración de rotación automática, enderezamiento y 
recorte automático de la configuración actual se aplicarán a la imagen 
digitalizada antes de que se visualice.

• Si la imagen es aceptable, introduzca un nombre en el campo Image name 
(Nombre de la imagen). El nombre de la imagen no debe contener ninguno 
de los siguientes caracteres especiales:  : “  ?  .  <  >  \  /.

• Para descartar la imagen, haga clic en Cancel (Cancelar).

• Antes de poder definir una zona de detección de marcas, debe tener al 
menos una imagen en la lista desplegable Image (Imagen).

• También puede transferir una imagen del visor de imágenes a la ventana de 
detección de marcas. Consulte la sección “Transferencia de una imagen a 
la ventana de detección de marcas”, que aparece más adelante en este 
capítulo.

6. Para guardar la imagen, haga clic en OK (Aceptar).
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Creación y selección de 
una zona de detección 
de marcas

Antes de utilizar una imagen de detección de marcas para la indexación, debe 
crear y seleccionar una o varias zonas de detección de marcas. Las zonas de 
detección de marcas se crean para indicar dónde se debe buscar una marca. 
Varias zonas de detección de marcas pueden agruparse para completar un 
solo campo de índice.

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job Name 
(Nombre del trabajo) y abra la pestaña Capture (Captura).

3. Seleccione Bar Code, OCR and Mark Detection (Código de barras, OCR 
y detección de marcas). Se mostrará la ventana de código de barras, OCR 
y detección de marcas.

4. Seleccione una imagen de la lista desplegable Image (Imagen). Si tiene 
que digitalizar la imagen, haga clic sobre el icono verde Start/Scan 
(Iniciar/Digitalizar) de la ventana de código de barras, OCR y detección de 
marcas.

• Coloque el cursor del ratón en la esquina superior izquierda del área de 
la imagen en la que desea definir la ubicación para esta zona de 
detección de marcas.

• Cuando dibuje una zona alrededor de un área de detección de marcas 
que contiene un marco alrededor de la marca (casillero, círculo, elipse, 
etc.), deje un área de borde de aproximadamente ¼ in alrededor del 
marco.

• Cuando dibuje una zona alrededor de un área de detección de marcas 
que no tiene un marco (área o línea vacía que se proporciona para la 
marca), asegúrese de que los caracteres u otros elementos de la 
imagen no se encuentren en la zona.

5. Haga clic con el botón primario del ratón y arrastre el cursor para dibujar 
un rectángulo alrededor del área de la marca. Cuando suelte el cursor, se 
mostrará el cuadro de diálogo de configuración de la zona de detección de 
marcas.

6. En el campo Zone name (Nombre de zona), introduzca un nombre para la 
nueva zona de detección de marcas. Deberá poner un nombre para 
guardar la zona.

7. Una vez realizada la configuración, haga clic en OK (Aceptar) para cerrar 
el cuadro de diálogo y volver a la ventana de detección de marcas. Para 
obtener descripciones detalladas de los campos, consulte la sección 
“Cuadro de diálogo Configuración de zona de detección de marcas”.

8. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de trabajo.
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Edición de una zona de 
detección de marcas

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job name 
(Nombre del trabajo).

3. Abra la pestaña Capture (Captura) y seleccione Bar Code, OCR & Mark 
Detection (Código de barras, OCR y detección de marcas). Aparecerá la 
ventana Bar Code, OCR & Mark Detection Zone (Zona de código de 
barras, OCR y detección de marcas).

4. Haga clic en la zona de detección de marcas que desee cambiar. 

5. Haga clic con el botón secundario del ratón para mostrar el menú 
contextual y haga clic en Zone Properties (Propiedades de zona). 
Se mostrará el cuadro de diálogo de configuración de la zona de detección 
de marcas.

6. Una vez que haya modificado la configuración, haga clic en OK (Aceptar) 
para cerrar el cuadro de diálogo.

7. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de trabajo. 

8. Después de editar una zona de detección de marcas, pruébela utilizando 
la función Test Selected Bar Code, OCR or Mark Detection zone (Probar 
zona de código de barras, OCR o detección de marcas seleccionada). 

Eliminación de una zona 
de detección de marcas

1. Seleccione File > Job Setup (Archivo > Configuración de trabajo). 
Se mostrará el cuadro de diálogo de configuración de trabajo.

2. Seleccione una configuración de trabajo en la lista desplegable Job name 
(Nombre del trabajo).

3. Abra la pestaña Capture (Captura) y seleccione Bar Code, OCR & Mark 
Detection (Código de barras, OCR y detección de marcas). Se mostrará 
la ventana de código de barras, OCR y detección de marcas.

4. Haga clic en la zona de detección de marcas que desea eliminar. 

5. Haga clic en Delete (Eliminar). 

6. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de trabajo. 
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Transferencia de una 
imagen a la ventana de 
detección de marcas

El software Capture Pro permite transferir una imagen con zonas de detección 
de marcas desde el visor de imágenes hasta la ventana de detección de 
marcas para crear zonas de detección de marcas. 

1. En la ventana principal, digitalice la imagen que contiene la marca o las 
marcas.

2. Localice en el visor de imágenes la imagen que quiera transferir y haga 
clic en ella con el botón secundario.

3. Seleccione Copy Image to Job Setup (Copiar imagen a la configuración 
de trabajo). Se mostrará el cuadro de diálogo para copiar la imagen a la 
configuración de trabajo.

4. Escriba el nombre de la imagen nueva en el campo Save image as 
(Guardar imagen como).

5. Haga clic en OK (Aceptar). Ahora, puede visualizar la imagen en la 
ventana de detección de marcas y utilizarla para crear una zona de 
detección de marcas.

También puede digitalizar imágenes de detección de marcas directamente en 
la ventana de detección de marcas. Consulte la sección “Digitalización de una 
imagen para la configuración de detección de marcas”, que aparece 
anteriormente en este capítulo.



A-61993_es  Marzo de 2022 169

Cuadro de diálogo 
Configuración de zona 
de detección de marcas

Utilice este cuadro de diálogo para asignar un nombre a la zona de detección 
de marcas, describir cómo se detecta la marca y, si lo desea, agrupar varias 
zonas para obtener un único resultado.

Zone name (Nombre de zona): introduzca un nombre para la nueva zona de 
detección de marcas. Este nombre identifica el área de marcas y aparece en 
la configuración de indexación como MD_(nombredezona) en la lista de 
valores predeterminados.

Filled value (Valor completado): la zona arrojará este valor cuando se detecte 
como “completado”. El valor puede ser un valor individual como “1” o un valor 
de múltiples caracteres como “Se seleccionó esta casilla de verificación”. 
El valor también puede quedar vacío.

Si la zona se añade a un grupo de zonas de detección de marcas, este valor 
se incluye en el valor que arroja el grupo de zonas. Consulte el apartado 
“Configuración de un grupo de zonas de detección de marcas”, que aparece 
más adelante en esta sección.

Unfilled value (Valor no completado): la zona arrojará este valor cuando se 
detecte como “no completado” o vacío. El valor puede ser un valor individual 
como “0” o un valor de múltiples caracteres como “No se seleccionó esta 
casilla de verificación”. El valor también puede quedar vacío. 

Si la zona se añade a un grupo de zonas de detección de marcas, este valor 
no se utiliza. El valor no completado arrojado por un grupo de zonas se define 
en la configuración del grupo. Consulte el apartado “Configuración de un 
grupo de zonas de detección de marcas”, que aparece más adelante en esta 
sección.

Side (Cara): Front (Anverso) o Back (Reverso): seleccione si el área de 
marca está ubicada en el anverso o el reverso de una imagen.
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Frame (Marco): Frame (Marco) o No Frame (Sin marco): un marco puede ser 
un rectángulo, círculo, elipse, etc., donde se espera que aparezca la marca. 
Las dimensiones del marco deben ser de al menos 50 píxeles en cada 
dirección, 4 mm (0,2 pulg.) en el caso de la resolución de 300 dpi.

• Si se selecciona el Frame (Marco), puede estar relleno con cualquier forma, 
como una X, una marca de verificación, tachado, líneas horizontales 
o verticales, etc. Se recomienda utilizar una X o una marca de verificación. 
Una pequeña cantidad de píxeles negros continuos dentro del área del 
marco generará el valor “rellenado” para la zona de detección de marcas.

• Si selecciona No Frame (Sin marco), cualquier marca de píxeles negros 
continuos generará el valor “rellenado” para la zona de detección de 
marcas. Si la forma contiene marcos para la marca, pero se omitirá el color 
del marco, deberá seleccionar la opción No Frame (Sin marco).

Mark sensitivity (Sensibilidad de marca): Low (Baja) a High (Alta): para las 
formas bien impresas de alta calidad, la sensibilidad deberá configurarse 
como High (Alta). Cuando seleccione High (Alta), las marcas pequeñas de 
píxeles negros continuos generarán el valor “rellenado”. Para los formularios 
de baja calidad, una sensibilidad más baja permitirá ignorar manchas o fibras 
de papel visibles para lograr un procesamiento satisfactorio. 

Add zone to group (Agregar zona al grupo): seleccione esta opción si esta 
zona de detección de marcas está asociada a otras zonas de detección de 
marcas y desea obtener un resultado individual para el grupo de zonas 
asociadas. Por ejemplo, un formulario presenta una pregunta con tres casillas 
de verificación: “Me gusta”, “No me gusta” y “No me interesa”. Se definen tres 
zonas de detección de marcas, una para cada respuesta posible. Las tres 
zonas de detección de marcas tendrían esta opción seleccionada y se 
añadirían al mismo grupo.

Aplicación de zonas de 
detección de marcas a 
páginas específicas

Para obtener información acerca de cómo seleccionar la página o páginas 
a las que aplicar todas las zonas de detección de marcas, consulte la sección 
“Cuadro de diálogo Configuración de páginas de zona”, que aparece 
anteriormente en este capítulo. 
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Configuración de un 
grupo de zonas de 
detección de marcas

Para cada marca prevista en una página, se crea una zona de detección de 
marcas y se configura como se describe en la sección “Configuración de la 
zona de detección de marcas”. Cada zona de detección de marcas arrojará un 
valor dependiendo de si el área de marca está “rellenada” o “no rellenada”. 
Esto funciona bien para las preguntas que se responden con “Sí” o “No”. Para 
una pregunta con varias respuestas posibles, donde se desea una sola 
respuesta, las zonas de detección de marcas pueden “agruparse”. 

Por ejemplo, la pregunta “Cuando viaja en avión, ¿qué tipo de asiento 
prefiere?” puede tener tres respuestas posibles, “Pasillo”, “Ventana” o “No 
tengo preferencia”. Se crearían tres zonas de detección de marcas, una para 
cada una de las tres respuestas posibles. Las tres zonas de detección de 
marcas se añadirían a un nuevo grupo de detección de marcas. Se crearía un 
campo de índice individual para la respuesta a esta pregunta y el grupo de 
detección de marcas se utilizaría como valor predeterminado para el campo 
de índice. Consulte la sección “Adición de un campo de índice de documento” 
en el capítulo 2.

Para añadir una zona de detección de marcas a un grupo:

1. Seleccione Add zone to group (Agregar zona al grupo). Se mostrará una 
lista de grupos de detección de marcas existente. Seleccione el grupo en 
el cual desea añadir esta zona de detección de marcas. 

• Si no hay un grupo de detección de marcas existente, se visualizará el 
cuadro de diálogo para crear un nuevo grupo de zonas.

• Escriba un nombre de grupo nuevo y haga clic en OK (Aceptar).
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2. Seleccione Add/Edit Group (Agregar/Editar grupo). Se mostrará el 
cuadro de diálogo de grupo de zonas de detección de marcas.

• Group List (Lista de grupos): muestra el nombre del grupo de 
detección de marcas actual. Haga clic en la lista desplegable para 
visualizar otros grupos de detección de marcas.

• No selection value (Sin valor de selección): el grupo arrojará este valor 
si no se detectan marcas en ninguna zona de detección de marcas 
dentro del grupo. El valor puede ser un valor individual como “0” o un 
valor de múltiples caracteres como “Sin selección”. El valor también 
puede quedar vacío. 

• Group properties (Propiedades del grupo): mediante el botón ->, 
seleccione las zonas de detección de marcas que desee incluir en el 
grupo y muévalas de la lista Zones not in group (Zonas que no están en 
el grupo) a la lista Zones in the group (Zonas del grupo).

3. Mediante el botón <-, seleccione las zonas de detección de marcas que no 
desee incluir en el grupo y muévalas de la lista Zones in the group (Zonas 
del grupo) a la lista Zones not in group (Zonas que no están en el grupo).

4. Haga clic en OK (Aceptar).
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5   Configuración de página 

Cuadro de diálogo 
Configuración de 
página

Utilice el cuadro de diálogo de configuración de página para definir parámetros 
de digitalización de imágenes, eliminar imágenes de forma automática, dividir 
imágenes o fusionar imágenes.

Para acceder a la configuración de página, haga clic en File > Page setup 
(Configuración de página).

Page setup name (Nombre de configuración de página): seleccione una 
configuración de página existente en la lista desplegable.

Iconos

Pestaña Image (Imagen): permite definir cómo se visualizarán las imágenes 
después de su digitalización.

Pestaña Auto Delete (Eliminación automática): permite eliminar 
automáticamente una imagen digitalizada si supera la configuración indicada 
en esta pestaña.

Pestaña Split (Dividir): permite dividir automáticamente una imagen 
digitalizada si se supera una anchura determinada. 

Pestaña Merge (Fusionar): permite fusionar las imágenes digitalizadas del 
anverso y el reverso de un documento en una sola imagen. 

Add (Agregar): muestra el cuadro de diálogo para guardar 
como, que permite agregar una configuración de página nueva.

Rename (Cambiar nombre): muestra el cuadro de diálogo para 
cambiar nombre, que permite renombrar la configuración de 
página seleccionada actualmente. 
Delete (Eliminar): muestra un cuadro de confirmación, que 
permite eliminar la configuración de página seleccionada. 
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Pestaña Intelligent QC: permite configurar la aplicación de las funciones de 
orientación automática, binarización y relleno de orificios durante el 
procesamiento de imágenes.

OK (Aceptar): permite guardar la configuración y cerrar el cuadro de diálogo.

Cancel (Cancelar): permite cerrar el cuadro de diálogo sin guardar los 
cambios. 

Apply (Aplicar): permite aceptar los cambios realizados en el cuadro de 
diálogo sin cerrar el cuadro de diálogo.

Pestaña Imagen La pestaña Imagen permite configurar los parámetros del escáner y realizar 
cambios en las imágenes antes de almacenarlas.

Settings (Configuración): al hacer clic en Settings (Configuración), se 
mostrará la fuente de datos TWAIN, donde podrá definir la configuración de 
digitalización. Para obtener información más específica sobre el escáner, 
consulte la Guía de usuario de su escáner. 

Display settings prior to scanning (Mostrar configuración antes de 
digitalizar): abre la fuente de datos TWAIN después de hacer clic en el icono 
verde Start/Scan (Iniciar/Digitalizar).

Flatbed delay (Retraso de cama plana): define un retraso de tiempo entre las 
digitalizaciones para que el operario tenga tiempo de abrir otra página 
diferente de un libro o revista y colocarla sobre la cama plana. Seleccione la 
cantidad de segundos de retraso en la lista desplegable.
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Software rotation (Giro de software): gira automáticamente la imagen tras su 
digitalización. Seleccione None, 90, 180 o 270 (Ninguna, 90º, 180º o 270º). 
Cuando introduzca una configuración distinta, el icono mostrará el aspecto 
que tendrá la imagen tras la rotación. 

NOTA: Si configura esta rotación en la fuente de datos TWAIN, puede lograr 
un mejor rendimiento que si usa la opción de giro de software de la 
pestaña Imagen.

2-sided mode (Modo a doble cara): seleccione el modo Classic (Clásico) 
o Calendar (Calendario) en la lista desplegable para la digitalización a doble 
cara. Se mostrará el icono correspondiente. Compare la imagen original con el 
icono para determinar si tiene un diseño clásico o de calendario.

• Classic (Clásico): se suele utilizar para informes de varias páginas. 
La opción 2-sided mode (Modo a doble cara) solo influye sobre la forma en 
que la imagen del anverso se gira con respecto a la del reverso. No define 
la rotación general del documento (0°, 90°, 180° o 270°).

Cuando utilice Classic: 2-sided mode (Clásico: modo a doble cara), las 
imágenes del anverso y el reverso corresponden a lo siguiente:

Un anverso girado 0° gira el reverso 0°.
Un anverso girado 180° gira el reverso 180°.
Un anverso girado 90° gira el reverso 270°. 
Un anverso girado 270° gira el reverso 90°.

• Calendar (Calendario): se suele utilizar para folletos de presentación, 
informes financieros, calendarios de pared, etc. La opción 2-sided mode 
(Modo a doble cara) solo influye sobre la forma en que la imagen del 
anverso se gira con respecto a la imagen del reverso. No define la rotación 
general del documento (0°, 90°, 180° o 270°).

• Cuando utilice el modo Calendar: 2-sided mode (Calendario: modo 
a doble cara), las imágenes del anverso y el reverso corresponden a lo 
siguiente: 

Un anverso girado 0° gira el reverso 180°.
Un anverso girado 180° gira el reverso 0°.
Un anverso girado 90° gira el reverso 90°. 
Un anverso girado 270° gira el reverso 270°.

Image order (Orden de las imágenes): utilice Move Up (Desplazar hacia 
arriba) o Move Down (Desplazar hacia abajo) para cambiar el orden de las 
imágenes que se muestran en el cuadro.

Overcrop (Recortar): active esta casilla de verificación para recortar todos los 
bordes de la imagen según la cantidad especificada en centésimas de 
pulgada.

OK (Aceptar): permite guardar la configuración y cerrar el cuadro de diálogo.

Cancel (Cancelar): permite cerrar el cuadro de diálogo sin guardar los 
cambios. 

Apply (Aplicar): permite aceptar los cambios realizados en el cuadro de 
diálogo sin cerrar el cuadro de diálogo.
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Pestaña Eliminación 
automática

La pestaña Auto Delete (Eliminación automática) permite configurar opciones 
para eliminar una imagen de forma automática. Es posible que desee eliminar 
imágenes sin contenido o páginas sumamente recargadas (p. ej., el reverso 
de un formulario que contiene mucho texto explicativo). Los valores de 
eliminación automática se especifican de forma independiente para las 
imágenes del anverso y del reverso. 

Si va a digitalizar de forma simultánea tipos de imágenes tanto en color como 
en escala de grises y en blanco y negro, la configuración de eliminación 
automática también se especifica de forma independiente. Por lo tanto, puede 
seleccionar que se elimine solo el tipo de imagen seleccionado.

Cuando se utiliza la opción eliminación automática, es recomendable utilizar la 
opción Test (Probar) para digitalizar algunos documentos representativos que 
querría eliminar. Los resultados de la opción Test (Probar) le ayudarán 
a determinar si debería especificar configurar los valores de eliminación 
automática mediante la opción Image size (byte) is (Tamaño de la imagen 
[bytes]) o la opción Image content (%) (Contenido de la imagen [%]). Para 
obtener más información, consulte la sección “Prueba de la configuración”. 

• Image size (byte) is Above (Tamaño de la imagen [bytes] superior a): 
seleccione esta opción si quiere eliminar páginas con una gran cantidad de 
contenido recargado y explicativo. Por ejemplo, si está digitalizando el 
anverso y el reverso de documentos con contenido similar (como 
formularios de seguros) y el anverso incluye contenido que necesita 
conservar, pero el reverso contiene instrucciones sobre cómo presentar una 
reclamación (que no necesita conservar), introduzca el número de bytes por 
encima del que el software Capture Pro debe eliminar cualquier archivo de 
imagen. Cualquier imagen con un valor superior a este se considerará 
demasiado grande y se eliminará. 

• Image size (byte) is Below (Tamaño de la imagen [bytes] inferior a): 
seleccione esta opción si quiere eliminar páginas en blanco o con poco 
contenido. Introduzca el número de bytes que el software Capture Pro 
considerará como el tamaño de imagen en blanco. Cualquier imagen con 
un valor inferior a este se considerará que está en blanco y se eliminará.
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• Image content (%) is Above (Contenido de la imagen [%] superior a): esta 
opción es similar a la opción Image size (byte) Above (Tamaño de la 
imagen [bytes] superior a), excepto por el hecho de que el usuario introduce 
un valor porcentual por encima del cual el software Capture Pro considerará 
que la imagen tiene demasiado contenido. Cualquier imagen con un 
contenido superior a este valor se eliminará. 

• Image content (%) is Below (Contenido de la imagen [%] inferior a): esta 
opción es similar a la opción Image size (byte) Below (Tamaño de la 
imagen [bytes] inferior a), excepto por el hecho de que introduce un valor 
porcentual por el que el software Capture Pro considerará que la imagen 
está en blanco o tiene poco contenido. Cualquier imagen con un valor 
inferior a este se considerará que está en blanco y se eliminará. Utilice este 
ajuste cuando haya páginas en blanco. 
NOTAS:

• Cuando seleccione la opción Image size (byte) (Tamaño de la imagen 
[bytes]), otros factores como la resolución, la compresión, etc. 
afectarán al tamaño de la imagen. 

• La opción Image content (%) (Contenido de la imagen [%]) solo se fija 
en el porcentaje de información en la imagen y, por tanto, es una 
opción más coherente y fiable para usar cuando puede variar de 
tamaño, la resolución, la compresión, etc. de la imagen.

Never (Nunca): haga clic en Never (Nunca) si no desea que el software 
elimine ninguna imagen automáticamente.

Apply deletion to both images of a side (Aplicar eliminación de ambas 
imágenes de una cara): elimina tanto las imágenes en blanco y negro como 
las imágenes en color/escala de grises.

Delete images after Intelligent QC (Eliminar imágenes tras Intelligent QC): 
seleccione esta opción si desea que las funciones de procesamiento de 
imagen Intelligent QC se apliquen a una imagen antes de que esta se elimine. 
Por ejemplo, puede que desee crear una imagen en escala de grises a partir 
de una imagen a color antes de eliminar la imagen a color.

Test (Probar): muestra el cuadro de diálogo para probar imágenes, que le 
permite digitalizar una imagen de muestra y probar la configuración.

OK (Aceptar): permite guardar la configuración y cerrar el cuadro de diálogo.

Cancel (Cancelar): permite cerrar el cuadro de diálogo sin guardar los 
cambios. 

Apply (Aplicar): permite aceptar los cambios realizados en el cuadro de 
diálogo sin cerrar el cuadro de diálogo.

Keep blank images (Mantener imágenes en blanco): cuando esta opción está 
activada (marcada), las imágenes en blanco
se resaltan en lugar de eliminarse.
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Prueba de la configuración El cuadro de diálogo Test Image (Probar imagen) permite probar las imágenes 
con el fin de determinar si cumplen o no con la configuración de eliminación. 
Se recomienda encarecidamente probar la configuración para verificar que se 
eliminan las imágenes que quiere eliminar y que se conservan las que no 
quiere eliminar.

1. Haga clic en Test (Probar) en la pestaña de eliminación automática para 
mostrar el cuadro de diálogo Test Image (Probar imagen).

2. Coloque en el escáner algunos documentos representativos de los 
documentos en los que quiere comprobar la eliminación automática.

3. Antes de digitalizar una página, seleccione Black and White - Front, 
Black and White - Back, Color - Front o Color - Back (Blanco y negro: 
anverso, Blanco y negro: reverso, Color: anverso o Color: reverso) en la 
lista desplegable.

NOTA: Las opciones que se muestran en la lista desplegable dependen 
de la configuración de la página.

4. Haga clic en el icono Start/Scan (Iniciar/Digitalizar). Los resultados se 
mostrarán en el cuadro Test result (Resultado de la prueba).
• The image is (La imagen es): indica si la imagen es una imagen Blank 

(En blanco) o Not Blank (No en blanco).
• Image size is - bytes (El tamaño de la imagen es - bytes): el tamaño 

en bytes de la imagen de prueba.

• Content is - % (El contenido es - %): el porcentaje de contenido de la 
imagen de prueba.

5. Evalúe los valores mostrados en los campos Image size is - (bytes) 
(El tamaño de la imagen es - [bytes]) o Content is - % (El contenido es - %) 
del cuadro Test result (Resultado de la prueba).

NOTA: Según los valores que se muestren en el cuadro de resultado de la 
prueba, puede que quiera introducir un valor ligeramente menor 
o mayor que el que se muestra, según la salida que desee. 
Por ejemplo, si el tamaño en bytes representativo para imágenes 
en blanco es de 799 bytes y para imágenes prácticamente en 
blanco es de 900 bytes, puede introducir un valor de 850 bytes en 
el campo Image size is - (bytes) (El tamaño de la imagen es - 
[bytes]) de la pestaña Auto Delete (Eliminación automática).
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6. Haga clic en OK (Aceptar).

NOTA: Durante la digitalización de la imagen de prueba, se ignorarán las 
opciones para dividir y fusionar.

División de imágenes La división de imágenes se utiliza con frecuencia en el procesamiento de 
formularios. Cuando digitalice formularios plegados, es posible que desee 
dividirlos en varias imágenes más pequeñas para que el registro y la 
verificación de formularios sea más fiable. El software Capture Pro divide las 
imágenes, las clasifica y extrae de ellas los datos en la secuencia correcta.

La división se produce solo en las páginas que cumplen con una anchura 
mínima y máxima expresada en centésimas de pulgada. La operación de 
división es una división vertical, lo que quiere decir que la página se divide en 
porciones iguales a la izquierda, en el medio y a la derecha (si se divide en 
tres partes). La división se produce después de la rotación. Cuando se 
digitalizan formularios de gran tamaño que no se pueden digitalizar en formato 
horizontal debido a que superan la anchura del transporte del escáner, es 
necesario girarlos.

Configure la opción Software rotation (Giro de software) en la pestaña Image 
(Imagen) del cuadro de diálogo de configuración de página en función de la 
forma en la que va a digitalizar el documento.

Tras la división, las imágenes impares se considerarán como imágenes del 
anverso y las imágenes pares se considerarán como del reverso. Como el 
software Capture Pro muestra inmediatamente el resultado tras la fusión o 
división, puede comprobar la configuración de página y realizar los cambios 
que sean necesarios.

Si está digitalizando imágenes de una cara (o está digitalizando desde el 
escáner de cama plana), la división solo se producirá en la imagen frontal.

División de una imagen Para dividir imágenes durante la digitalización:

1. Haga clic en la casilla de verificación Split Page or Image (Dividir página o 
imagen).
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NOTA: Las opciones Merge (Fusionar) y Split (Dividir) no se pueden 
activar al mismo tiempo. Para inhabilitar la opción Merge 
(Fusionar), abra la pestaña correspondiente y desactive la casilla 
de verificación Merge front and back into one single image 
(Fusionar imagen frontal y posterior en una sola imagen).

2. Elija de 2 a 12 imágenes en la lista desplegable Number of resultant 
images (Número de imágenes resultantes).

3. Seleccione un rango de anchuras para la página o la imagen en el campo 
Split image if width is between (Dividir imagen si la anchura está entre). 
Si la anchura de página está dentro de este intervalo, entonces se dividirá. 
Si el anverso o el reverso de lapágina quedan fuera de rango, no se 
dividirá ninguna de las dos caras.

4. Seleccione Front (Anverso) o Back (Reverso) para activar una división. 
Aparecerá un gráfico que muestra su selección. Por ejemplo, si activa las 
dos casillas de verificación, los iconos se mostrarán con una “X” de color 
rojo en cada página.

Haga clic en cada segmento de imagen en el que orden en el que desea 
que aparezcan las imágenes durante la salida. Al hacer clic en un 
segmento de imagen, el símbolo “X” rojo desaparece.
Cualquier segmento de imagen que todavía esté marcado con el símbolo 
“X” rojo se eliminará y no se enviará a la salida. Esta opción puede resultar 
útil para la última página de un panfleto que siempre está en blanco.

NOTA: Cuando se utiliza un escáner solo símplex y se selecciona Front 
(Anverso) y Back (Reverso), el resultado será que no se producirá 
ninguna división. Seleccione solo Front (Anverso) para que se 
produzca una división.

5. Si lo desea, haga clic en Reset Order (Restablecer orden) para eliminar el 
orden de salida y volver a empezar.

6. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de página. 
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Pestaña Fusionar Para fusionar imágenes durante la digitalización:

1. Haga clic en la casilla de verificación Merge front and back image into 
one single image (Fusionar anverso y reverso en una sola imagen).

NOTA: Las opciones Merge (Fusionar) y Split (Dividir) no se pueden 
activar al mismo tiempo. Para desactivar la opción Split (Dividir), 
abra la pestaña Split (Dividir) y desactive la casilla de verificación 
Split Page or Image (Dividir página o imagen).

2. Configure las anchuras y alturas de imagen máxima y mínima en 
centésimas de pulgada para que se fusionen las imágenes del anverso 
y del reverso en los campos if width is between (si el ancho está entre) y if 
height is between (si la altura está entre). El software Capture Pro fusiona 
solo las imágenes que cumplen estos parámetros. El resto de las 
imágenes no se fusionan. 

3. Haga clic en Horizontal o Vertical para aplicar la orientación deseada a la 
imagen fusionada.

4. Haga clic en Front, Back (Anverso, reverso) o Back, Front (Reverso, 
anverso) para aplicar el orden que desee del anverso y reverso en la 
imagen fusionada.

5. Haga clic en OK (Aceptar) para guardar los valores y cerrar el cuadro de 
diálogo de configuración de página.
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Pestaña Intelligent QC La pestaña Intelligent QC del cuadro de diálogo de configuración de página le 
permite configurar estas funciones de procesamiento de imágenes durante su 
captura:
• Orientación automática
• Binarización
• Creación de escala de grises a partir de color 
• Relleno de orificios
• Recorte automático
• Enderezamiento

Orientación automática La función de orientación automática analiza el contenido de los documentos 
y orienta cada documento, de modo que se lea correctamente. Puede 
seleccionar la opción Orient Front (Orientar anverso), que orienta el anverso 
de una página, o la opción Orient Back (Orientar reverso), que orienta el 
reverso de una página.

Binarización La función de binarización convierte las imágenes en color o escala de grises 
en imágenes en blanco y negro. El escáner debe estar configurado en 
digitalización a color o en escala de grises. Durante la digitalización, la imagen 
se convertirá a blanco y negro y se hará una comprobación de ruido. Si se 
detecta demasiado ruido, la imagen se marcará y podrá ajustar la imagen para 
resaltar el contenido deseado después de la digitalización. 

Ajustes de imagen

• Enable Binarize (Activar binarización): seleccione esta opción para ajustar 
el valor Contrast (Contraste). 
- Contrast (Contrast): establece el contraste de cada imagen. Si el 

documento contiene imágenes con texto claro o fondos oscuros/
coloreados, es probable que desee aumentar el contraste.
Si el papel de los documentos es ligero y el contenido del reverso es 
visible en el anverso, puede que una disminución del contraste produzca 
mejores resultados. En numerosos casos, con un contraste 0 obtendrá los 
mejores resultados.
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Opciones de retención de la imagen

• Keep all images (Conservar todas las imágenes): de forma 
predeterminada, solo las imágenes en color o en escala de grises marcadas 
permanecerán en el lote con las imágenes en blanco y negro, y solo se 
podrán modificar estas imágenes después de la digitalización. Seleccione 
esta casilla si desea conservar todas las imágenes en escala de grises 
o a color para que se pueda modificar cualquier imagen enviada desde el 
escáner, estén marcadas o no.
NOTAS:

• Al utilizar un escáner Kodak o Alaris con la opción Thresholding: 
Intelligent QC activada, la imagen en escala de grises solo estará 
disponible para las imágenes que el escáner considere que tienen un 
exceso de ruido.

• Aunque seleccione Keep all images (Conservar todas las imágenes), 
las imágenes eliminadas automáticamente no se conservarán.

• Si no desea conservar las imágenes en escala de grises o en color 
después de la salida, seleccione solo la casilla de verificación Black and 
White (Blanco y negro) en la pestaña Output (Salida) de la configuración 
de trabajo.

Creación de escala de grises 
a partir de color

La función para crear escala de grises a partir de color creará una imagen en 
escala de grises para cada imagen en color enviada desde el escáner. Tanto 
la imagen a color como la imagen en escala de grises se añadirán al lote. 
No se necesita ninguna configuración.

Relleno de orificios La función de relleno de orificios rellenará agujeros redondos o rectangulares 
próximos al borde de la página.

El fondo del escáner debe ser negro. Puede seleccionar Fill Front (Rellenar 
anverso), que rellena los agujeros encontrados en el anverso de la página, 
o Fill Back (Rellenar reverso), que rellena los agujeros encontrados en el 
reverso de la página. 

Recorte automático La función de recorte automático recorta la imagen digitalizada eliminando el 
borde de fondo de los extremos de la imagen. Se recomienda utilizar la 
función de recorte automático del escáner si dispone de ella. No se necesita 
ninguna configuración.

Enderezamiento La función de enderezamiento corrige una inclinación o rotación mínimas de 
una imagen. Cuando se selecciona esta opción, se activa automáticamente el 
recorte automático. No se necesita ninguna configuración.
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6   Accesos directos de productividad

Administrador de 
botones 

Cuando se crean accesos directos para la digitalización, puede asignar el 
nombre de cada acceso directo a un valor concreto de los botones del 
escáner (si el escáner tiene botones). Puede asignar hasta 9 botones. Una 
vez asignados los números, puede acceder a estas opciones de digitalización 
y utilizarlas rápidamente pulsando el botón de inicio del panel de control. 

Para acceder al cuadro de diálogo Button Manager (Administrador de botones):

1. Haga clic con el botón secundario en el icono del software Capture Pro en 
la bandeja del sistema y seleccione Button Setup (Configuración de 
botones):

Se mostrará el cuadro de diálogo Button Manager (Administrador de 
botones).

2. Asigne los Botones 1 a 9 como desee; para ello, seleccione en la lista 
desplegable la acción que desea que el escáner realice. El valor 
predeterminado es no realizar ninguna acción. 

3. Haga clic en Shortcut Setup (Configuración de accesos directos) para 
mostrar el cuadro de diálogo de configuración de accesos directos, que 
permite asignar un nombre de acceso directo de trabajo, de configuración 
de página y de configuración de trabajo.

4. Haga clic en OK (Aceptar).

Icono del software 
Capture Pro
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NOTA: Si experimenta problemas con Button Manager (Administrador de 
botones), consulte la sección Preguntas frecuentes del Capítulo 9: 
Solución de problemas.

Cuadro de diálogo 
Configuración de 
accesos directos

Cuando seleccione Shortcut Setup (Configuración de accesos directos) en el 
cuadro de diálogo Button Manager (Administrador de botones), se mostrará el 
cuadro de diálogo de configuración de accesos directos. Este cuadro de 
diálogo permite crear un nuevo acceso directo de trabajo, así como cambiar el 
nombre o eliminar el acceso directo de trabajo seleccionado actualmente. 
También puede utilizar este cuadro de diálogo para seleccionar o cambiar las 
configuraciones de página y de trabajo asociadas a él.

NOTA: El administrador de botones no es compatible con la asignación de 
accesos directos a los botones del escáner.

1. Seleccione el nombre del acceso directo de trabajo que desee en la lista 
desplegable. También puede utilizar los iconos para agregar, cambiar el 
nombre o eliminar un acceso directo de trabajo.
• Add (Agregar): muestra el cuadro de diálogo Save As (Guardar como), 

que permite agregar un nuevo acceso directo de trabajo.

• Rename (Cambiar nombre): muestra el cuadro de diálogo Rename 
(Cambiar nombre), que permite renombrar el método de acceso 
directo de trabajo seleccionado actualmente.

• Delete (Eliminar): muestra un cuadro de confirmación que permite 
eliminar el método de acceso directo de trabajo seleccionado.

2. Si lo desea, seleccione una configuración de página de la lista desplegable 
Page Setup (Configuración de página) o haga clic en Setup (Configurar) 
para mostrar el cuadro de diálogo Configuración de página (Page Setup) 
y crear una configuración de página nueva.

3. Si lo desea, seleccione una configuración de trabajo en la lista 
desplegable Job Setup (Configuración de trabajo) o haga clic en Setup 
(Configuración) para mostrar el cuadro de diálogo de configuración de 
trabajo y crear una configuración de trabajo nueva.

4. Haga clic en OK (Aceptar).
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7   Configuración de usuarios y grupos

Cuadro de diálogo 
Configuración de 
usuario

El cuadro de diálogo User Setup (Configuración de usuario) permite configurar 
y gestionar los usuarios del software Capture Pro. Únicamente los usuarios 
con acceso de administrador al software Capture Pro pueden definir las 
funciones de configuración de usuario.

Para acceder a la configuración de usuario, seleccione File > User Setup 
(Archivo > Configuración de usuario). Se mostrará el cuadro de diálogo de 
configuración de usuario.

Este cuadro de diálogo se compone de tres pestañas: General (General), 
User (Usuario) y Group (Grupo).

Pestaña General La pestaña General permite omitir la función de inicio de sesión para un 
usuario al seleccionar la casilla de verificación Windows user ID login 
(Inicio de sesión con ID de usuario de Windows). 

Si desea autenticar a los usuarios con el servidor de Active Directory, marque 
la casilla de verificación Active Directory.

Configuración de 
usuarios y grupos 
mediante 
Active Directory

Cuando Active Directory esté seleccionado y un nuevo usuario inicie sesión, 
el software Capture Pro comprobará cada grupo de Active Directory para 
verificar que dicho usuario sea miembro y encontrar una coincidencia con un 
grupo del software Capture Pro. El nuevo usuario se añadirá al primer grupo 
del software Capture Pro que coincida con el grupo de Active Directory del 
usuario.
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Si no se encuentra ningún grupo que coincida, el nuevo usuario se añadirá al 
software Capture Pro y se creará un nuevo grupo en el software Capture Pro 
basado en uno de los grupos de Active Directory del usuario. De forma 
predeterminada, el nuevo grupo no tendrá permisos ni trabajos en el software 
Capture Pro. Un usuario del software Capture Pro que disponga del permiso 
necesario para modificar los parámetros de configuración de usuario deberá 
acceder a la configuración de usuario y asignar permisos y trabajos al nuevo 
grupo o asignar el nuevo usuario a un grupo del software Capture Pro 
existente.

Si un nuevo usuario no es miembro de ningún grupo de Active Directory, 
la primera vez que el usuario inicie sesión recibirá un mensaje de advertencia 
que le informará de que debe formar parte de al menos un grupo.

Se recomienda que el administrador del sistema (sysadmin) del software 
Capture Pro agregue los grupos correspondientes al software Capture Pro 
antes de que los usuarios inicien sesión la primera vez. El nombre del grupo 
introducido en el software Capture Pro debe coincidir con el nombre del grupo 
indicado en Active Directory.

Cuando los usuarios inician sesión en el software Capture Pro, el nombre de 
usuario debe incluir el dominio, por ejemplo, dominio\IDdeusuario.

Pestaña Usuario Los usuarios y los grupos de usuarios se pueden configurar en el software 
Capture Pro para limitar el acceso a trabajos y funciones específicos del 
software Capture Pro.

Incorporación de un 
usuario nuevo 

1. Seleccione File > User Setup (Archivo > Configuración de usuario).
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2. Abra la pestaña User (Usuario).

3. Haga clic en New (Nuevo). Se mostrará el cuadro de diálogo de usuario 
nuevo.

4. Introduzca un nombre para el usuario en el campo User name (Nombre de 
usuario).

5. Introduzca una contraseña para este usuario en el campo Password 
(Contraseña).

6. Vuelva a introducir la contraseña en el campo Confirm password 
(Confirmar contraseña) y haga clic en Create (Crear). Este usuario se 
añade automáticamente a la lista.

NOTA: El usuario puede cambiar esta contraseña en File > Change 
Password (Archivo > Cambiar contraseña).

Incorporación de un 
usuario a un grupo

1. Seleccione File > User Setup (Archivo > Configuración de usuario) y abra 
la pestaña User (Usuario). Se mostrará el cuadro de diálogo de 
configuración de usuario.

2. Seleccione un nombre de usuario en la lista desplegable User name 
(Nombre de usuario).

3. Seleccione un nombre de grupo en la lista desplegable Add to Group 
(Agregar a grupo).
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4. Marque la opción Allow automatic login (Permitir inicio de sesión 
automático) si quiere omitir la función de inicio de sesión del software 
Capture Pro y que este usuario pueda iniciar sesión automáticamente al 
iniciar el software Capture Pro.

NOTA: Si quiere iniciar sesión como otro usuario, seleccione File > 
Logout (Archivo > Cerrar sesión) y, a continuación, inicie sesión 
como el usuario nuevo.

5. Haga clic en OK (Aceptar). 

Eliminar un usuario 1. Seleccione File > User Setup (Archivo > Configuración de usuario) y abra 
la pestaña User (Usuario). Se mostrará el cuadro de diálogo de 
configuración de usuario.

2. Seleccione el usuario que quiere eliminar en la lista desplegable User 
name (Nombre de usuario).

3. Haga clic en Delete (Eliminar). Se mostrará un cuadro de confirmación.

4. Haga clic en Yes (Sí) para completar la eliminación. 

5. Haga clic en OK (Aceptar).

Restablecimiento de una 
contraseña

1. Seleccione File > User Setup (Archivo > Configuración de usuario) y abra 
la pestaña User (Usuario). Se mostrará el cuadro de diálogo de 
configuración de usuario.

2. Seleccione el usuario para el que quiere restablecer la contraseña en la 
lista desplegable.

3. Haga clic en Reset Password (Restablecer contraseña). Se mostrará el 
cuadro de diálogo del sysadmin para cambiar la contraseña.
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4. Introduzca una contraseña nueva en el campo New password 
(Contraseña nueva).

5. Vuelva a introducir la contraseña en el campo Confirm password 
(Confirmar contraseña).

6. Haga clic en OK (Aceptar). 

NOTA: El usuario puede cambiar esta contraseña en File > Change 
Password (Archivo > Cambiar contraseña).

Pestaña Grupo Utilice la pestaña Group (Grupo) para agregar y eliminar grupos de usuarios, 
así como agregar y quitar privilegios de trabajos.

Configuración de un grupo 
de usuarios

1. Seleccione File > User Setup (Archivo > Configuración de usuario) y abra 
la pestaña Group (Grupo). Se mostrará la pestaña Group (Grupo) del 
cuadro de diálogo de configuración de usuario.

2. Haga clic en el icono Add (Agregar). Se mostrará el cuadro de diálogo 
para guardar como.

3. Introduzca un nombre de grupo nuevo y haga clic en OK (Aceptar). 
El nuevo nombre de grupo se mostrará en la lista desplegable Group 
name (Nombre de grupo). También puede añadir notas acerca del grupo 
en el campo Description (Descripción).

NOTA: Al crear un grupo nuevo, primero debe crear el grupo y, 
a continuación, debe ir a la pestaña User (Usuario) para agregar 
miembros al grupo. 
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4. Utilice los botones Add (Agregar), Remove (Quitar), Add All (Agregar 
todo), Remove all (Quitar todo) de las casillas Members (Miembros) para 
mover usuarios dentro o fuera del grupo seleccionado. Las casillas 
Members (Miembros) contienen todos los usuarios que se pueden agregar 
al grupo. Durante la creación de un nuevo grupo, los campos Not in group 
(No pertenece al grupo) y In group (Pertenece al grupo) estarán en blanco.

5. En Privileges: Features (Privilegios: Funciones), seleccione los menús, 
barras de herramientas y funciones del software Capture Pro que desee 
que estén disponibles para los miembros de este grupo. Puede utilizar 
Select All (Seleccionar todo) o Deselect All (Anular la selección de todo) 
para hacer cambios globales. La configuración predeterminada otorga al 
grupo acceso total a todas las funciones de software y configuraciones de 
trabajo.

6. En Privileges: Jobs (Privilegios: Trabajos), seleccione las 
configuraciones de trabajo que desee que estén disponibles para los 
miembros de este grupo. Puede utilizar Select All (Seleccionar todo) 
o Deselect All (Anular la selección de todo) para hacer cambios globales.

7. Haga clic en OK (Aceptar).

Eliminar un grupo 1. Seleccione File > User Setup (Archivo > Configuración de usuario) y abra 
la pestaña Group (Grupo). Se mostrará la pestaña Group (Grupo) del 
cuadro de diálogo de configuración de usuario.

2. Seleccione el grupo que quiere eliminar en la lista desplegable Group 
name (Nombre de grupo). 

3. Haga clic en el icono Delete (Eliminar). Se mostrará un cuadro de 
confirmación. Haga clic en Yes (Sí) para eliminar el grupo. 

NOTA: Cuando elimine un grupo, los usuarios de ese grupo se eliminan 
del grupo y se incluyen en la lista Members: Not in Group 
(Miembros: no pertenece al grupo).

Cambio de nombre de un 
grupo

1. Seleccione File > User Setup (Archivo > Configuración de usuario) y abra 
la pestaña Group (Grupo). Se mostrará la pestaña Group (Grupo) del 
cuadro de diálogo de configuración de usuario.

2. Seleccione el grupo cuyo nombre quiera cambiar en la lista desplegable 
Group name (Nombre de grupo). 

3. Haga clic en el icono Rename (Cambiar nombre). Se mostrará el cuadro 
de diálogo para cambiar el nombre.

4. Introduzca un nombre de grupo nuevo y haga clic en OK (Aceptar).
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8   Importación automática

Descripción general La función Auto Import (Importación automática) permite importar imágenes 
al software Capture Pro sin necesidad de un escáner local o de intervención 
manual. Esto se lleva a cabo mediante la observación de directorios 
especiales denominados “carpetas de inspección”. Los archivos que se van 
a importar se copiarán en subcarpetas de una carpeta de inspección 
denominadas Auto Import (Importación automática) o AI batch (Lote de 
importación automática). La importación automática extrae las imágenes de 
estos archivos y las envía a la estación de trabajo del software Capture Pro, 
del mismo modo que si procediesen de un scanner local.

Los archivos de importación automática crean una carpeta de importación 
automática en una carpeta de inspección. Las instrucciones de procesamiento 
para esta carpeta de lotes de importación automática se definieron durante el 
proceso de configuración de importación automática y están asociadas a la 
carpeta de inspección en la que se encuentra la carpeta de lotes de 
importación automática. A continuación, se iniciará un temporizador de cuenta 
atrás en el nuevo lote de importación automática. El usuario copiará los 
archivos (que pueden encontrarse en subcarpetas anidadas) en la carpeta de 
lotes de importación automática. Cada vez que aparezca un archivo nuevo en 
alguna parte de la carpeta de lotes de importación automática, el temporizador 
de cuenta atrás se restablecerá al valor inicial y se reiniciará la cuenta atrás. 
Si el temporizador finaliza, la carpeta de lotes de importación automática se 
bloqueará y se agregará al final de una cola de captura de importación 
automática para su procesamiento. Para obtener más información, consulte 
“Funcionamiento de importación automática”.

Para los dispositivos MFP (impresoras multifunción) que no pueden crear 
carpetas de lotes de importación automática, es posible que los archivos de 
imagen se copien directamente en la carpeta de inspección.

Se pueden especificar reglas especiales de separación de lotes para la 
importación automática, de modo que se puedan crear lotes nuevos para cada 
lote de importación automática de forma opcional. Aparte de eso, el 
procesamiento se realizará del mismo modo que cualquier otro trabajo de 
digitalización, según las reglas de configuración de trabajo y de la página. 
Cada lote de importación automática debe procesarse completamente antes 
de avanzar al siguiente.

Los formatos de imagen compatibles son los siguientes: tiff, jpg, pdf, bmp, 
ioca, modca, gif, cmp y png.
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Configuración de 
importación 
automática

1. Seleccione Auto Import Setup (Configuración de importación automática) 
en el menú Capture (Captura). Se mostrará el cuadro de diálogo para la 
configuración de la importación automática.

NOTA: La configuración realizada en este cuadro de diálogo se aplica 
a todos los lotes de importación automática creados en la ubicación 
de importación automática especificada (carpeta de inspección).

2. Seleccione Start Auto Import when application is launched (Iniciar la 
importación automática cuando se ejecuta la aplicación) para iniciar 
automáticamente la supervisión de la carpeta de inspección de 
importación automática al ejecutar Capture Pro.

3. Especifique un nombre para esta configuración de importación automática. 
El nombre es una referencia descriptiva y no hace referencia a ningún 
nombre de carpeta ni a ningún otro tipo de referencia específica.

4. Seleccione una ubicación para la carpeta de inspección de importación 
automática asociada a la configuración de importación automática. 
La importación automática supervisará esta carpeta para detectar la 
creación de nuevas carpetas de lotes de importación automática 
y procesará el lote de importación automática cuando haya transcurrido el 
intervalo de tiempo de espera (consulte la sección “Funcionamiento de 
importación automática” para obtener más información).
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Existen diversas condiciones que se aplican a la carpeta de inspección. 
• La carpeta de inspección debe contar con acceso de lectura/escritura 

por parte de cualquier usuario del software Capture Pro. 

• La carpeta de inspección debe poder editarse desde cualquier origen de 
imagen que desee. Si se va a acceder a ella desde una red, deberá 
confirmar que el recurso compartido de red se ha configurado para 
permitir el acceso de escritura de todos los usuarios, escáneres de red 
y otros dispositivos que copien archivos a la carpeta de inspección. 

• El software Capture Pro no intentará configurar ningún archivo 
compartido ni configurar privilegios de acceso de usuario en la carpeta 
de inspección. El uso compartido de archivos y la configuración son su 
responsabilidad. 

• La carpeta de inspección debe estar ubicada en una unidad local 
o asignada.

5. Seleccione un intervalo de tiempo de espera de importación automática. 
Este intervalo debe basarse en el retraso máximo esperado de cualquier 
origen que envíe archivos a la carpeta de inspección. El intervalo puede 
variar bastante según la operación. Por ejemplo:

• Network Scanner (Escáner de red): un usuario ha configurado un 
escáner Scan Station 500 para enviar imágenes directamente a la 
carpeta de inspección a través de la red. La operación consiste en 
digitalizar una pila de documentos, retirarla del escáner, recoger la 
siguiente pila y digitalizarla. Es necesario un retraso de 60 segundos 
para completar esta transición. La carpeta de inspección se ha 
configurado con un retraso de 120 segundos para ofrecer tiempo 
suficiente al usuario para recoger la siguiente pila sin agotar el tiempo 
de espera y evitar que se cierre el lote de importación automática.

• Copy images from network folder (Copiar imágenes de una carpeta 
de red): un usuario tiene un conjunto de archivos que se ha capturado 
con otro escáner (u otro origen de entrada). Cuando se realiza la 
transferencia de los archivos a la estación de trabajo del software 
Capture Pro para importación automática, se requiere una operación 
de “copia”. La red local envía imágenes en intervalos de un segundo. 
El tiempo de espera se establece en 10 segundos.

Para obtener más información, consulte la sección “Funcionamiento de 
importación automática”.

6. Seleccione o cree una configuración de trabajo para asociarla a esta 
carpeta de inspección.
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7. Seleccione o cree una configuración de página para asociarla a esta 
carpeta de inspección. Las opciones de configuración de página están 
restringidas a las siguientes:
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8. Seleccione Separation Options (Opciones de separación) para seleccionar 
las opciones de separación de documentos y lotes para la carpeta de 
importación automática y cualquier subcarpeta que pueda contener. 
También puede crear un nuevo documento para cada archivo. Esta opción 
es útil si cada archivo contiene un documento de varias páginas.
Las opciones de separación son limitadas cuando los archivos se copian 
directamente a la carpeta de inspección, dado que no existirá una carpeta 
y una subcarpeta. La única opción que puede utilizarse es For each file 
create new document (Crear un documento nuevo para cada archivo). 
Cuando esta opción no está seleccionada, todos los archivos copiados 
a la carpeta de inspección se colocarán en un único documento. Cuando 
esta opción está seleccionada, se creará un nuevo documento para cada 
archivo.

9. Seleccione Backup the files to (Guardar copia de seguridad de los 
archivos en) y especifique una ubicación de copia de seguridad si desea 
realizar una copia de seguridad del contenido del lote de importación 
automática cuando la importación automática finalice. 
Se copiará todo el contenido de un lote de importación automática a la 
ubicación de archivos especificada, incluidos los archivos sin procesar 
(como hojas de cálculo y documentos de procesamiento de texto) en su 
formato original junto con los archivos de imagen originales. 

• Se puede utilizar una única ubicación de archivos para varias carpetas 
de inspección. 

• No es necesario crear una carpeta de archivos exclusiva para cada 
configuración de importación automática.

• La ubicación del archivo debe ser una unidad local o asignada.

10. Especifique el número de errores permitido antes de interrumpir el 
procesamiento de importación automática. Se producen errores cuando 
los archivos de imagen no se pueden leer correctamente. Estos errores no 
se aplican a los errores de indexación o a cualquier otro aspecto que no 
sea la capacidad de abrir y leer el contenido de un archivo de imagen 
compatible. Si se ha superado el valor del cuadro desplegable Maximum 
import errors (Máximo de errores de importación), se detendrá el 
procesamiento y aparecerá un cuadro de diálogo que permite al usuario 
recuperar la imagen dañada, ignorarla o anular la importación automática. 
Para obtener más información sobre la gestión y la recuperación de 
errores, consulte la sección “Gestión de errores”. 
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11. Especifique una ubicación en la que copiar los archivos no legibles en el 
campo Cache the error files and data to (Guardar en caché los archivos 
y datos incorrectos en). Durante el proceso de importación automática, 
si no se puede abrir un archivo compatible, se sustituirá la imagen 
“marcador” y la imagen incorrecta se copiará en la memoria caché de 
errores.
NOTA: La ubicación de la memoria caché de errores debe ser una unidad 

local o asignada.

12. Haga clic en OK (Aceptar) cuando haya terminado.

Funcionamiento de 
importación 
automática

NOTA: En los siguientes ejemplos, se han agregado iconos especiales 
a algunas de las carpetas para ofrecer una mayor claridad. Estos 
iconos no se mostrarán en las carpetas reales en una configuración 
real de importación automática.

Tras la configuración de importación automática AIDemo1 descrita 
anteriormente, los directorios tendrán el siguiente aspecto:

Para activar la importación automática, seleccione File > Workstation Setup 
(Archivo > Configuración de la estación de trabajo) y, a continuación, 
seleccione Auto Import (Importación automática) como fuente. De esta 
forma, se desactivan todos los escáneres y su configuración específica. Si no 
ha seleccionado Start Auto Import when application is launched (Iniciar la 
importación automática cuando se ejecuta la aplicación), tendrá que 
seleccionar Start (Iniciar) como si estuviera iniciando un escáner. La 
importación automática comenzará a supervisar todas las carpetas de 
inspección definidas anteriormente para detectar la entrada de archivos, es 
decir, controlará de forma activa todas las carpetas de inspección y procesará 
todos los trabajos nuevos de lotes de importación automática por orden de 
llegada hasta que se seleccione Stop (Detener). Para reanudar las 
operaciones normales de digitalización, seleccione File > Workstation Setup 
(Archivo > Configuración de la estación de trabajo) y, a continuación, 
seleccione el escáner.

NOTA: Si una configuración de importación automática se vuelve obsoleta, 
es necesario eliminarla antes de llevar a cabo la eliminación manual 
de las carpetas relacionadas para evitar que se muestren mensajes 
de error.

Carpeta de inspección AIDemo 1
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Para crear un nuevo lote de importación automática, se creará una carpeta de 
lotes de importación automática en la carpeta de inspección. 

El temporizador comenzará la cuenta atrás. Transcurridos cinco segundos, no 
se ha agregado ningún archivo nuevo a la carpeta de lote de importación 
automática (06112009_AIBatch) y el valor del contador se encuentra en 5.

Un nuevo lote de 
importación automática.
Temporizador = 10 s
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Cada vez que aparezca un archivo en la carpeta de lotes de importación 
automática o en cualquier subcarpeta de lotes de importación automática, 
el temporizador se restablecerá. 

Las subcarpetas de las carpetas de lotes de importación automática pueden 
estar anidadas. Se restablecerá el temporizador de la carpeta de lotes de 
importación automática principal. Al agregar archivos a las subcarpetas 
anidadas de 06112009_AIBatch, se restablecerá el temporizador. 
Las subcarpetas anidadas no disponen de sus propios temporizadores. 
Existe únicamente un temporizador para 06112009_AIBatch.

NOTA: Las rutas que superen los 256 caracteres pueden no ser compatibles 
con el sistema operativo Windows. Es recomendable que las 
subcarpetas y los nombres de archivos respeten este límite.
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En cualquier momento, puede aparecer una nueva carpeta de lotes de 
importación automática en la carpeta de inspección. Dispondrá de su propio 
temporizador y su funcionamiento no dependerá de otros lotes de importación 
automática.

Cuando finaliza un temporizador, la carpeta de lotes de importación 
automática se bloquea y se inserta en la cola de procesamiento de 
importación automática.

Cola de procesamiento de 
importación automática
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Se insertarán otros trabajos en la cola de procesamiento a medida que 
finalicen sus temporizadores.

La cola de procesamiento de importación automática se procesará por orden 
de llegada. En este ejemplo, se procesará todo el contenido de 
06112009_AIBatch seguido del de 06112009_AIBatch2. Ya que ambos lotes 
de importación automática cuentan con la misma configuración de trabajo 
(proceden de la misma carpeta de inspección), se insertará un separador de 
lotes entre los dos lotes de importación automática según la configuración del 
trabajo AIDemo1. 

Los archivos de un lote de importación automática se procesarán mediante la 
iteración recursiva a través de los archivos y subcarpetas, y el procesamiento 
de contenidos por orden alfanumérico.

No obstante, ya que TODOS los lotes comparten la misma cola de 
procesamiento de importación automática, si un lote de importación 
automática de una carpeta de inspección diferente era el siguiente de la cola, 
se insertaría un separador de lotes con independencia de las opciones de 
configuración de importación automática.

Todos los lotes de la cola de procesamiento de importación automática se 
procesarán por orden de llegada. No existe ninguna forma de gestionar esta 
cola. Todos los lotes de importación automática se procesarán por completo 
y en secuencia, a menos que se produzcan errores (consulte la sección 
“Gestión de errores”).

Una vez que se haya procesado el lote completo, los archivos originales se 
copiarán de forma opcional en el archivo.

Configuración de 
servidor/servicio

La instalación de la función de importación automática en un sistema 
operativo de servidor de Windows proporciona un entorno más sólido 
y minimiza el trabajo del operador. Se recomienda que la carpeta de 
inspección esté ubicada en el mismo servidor. 

Cola de procesamiento de 
importación automática
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1. Instale la función de importación automática de Capture Pro en el servidor 
utilizando el procedimiento que encuentra en la sección Auto Import 
Setup (Configuración de importación automática).

2. Inicie Capture Pro y configure los trabajos de importación automática. 

Asegúrese de seleccionar la opción Start Auto Import when application 
is launched (Iniciar la importación automática cuando se ejecuta).
NOTA: Si la carpeta de inspección no está ubicada en el servidor, el 

servicio de importación automática de Capture Pro requerirá 
acceso de lectura y escritura a la carpeta de inspección. Esto 
suele ser difícil porque los servicios no tienen un usuario definido.

3. Verifique que la importación automática funciona correctamente.
4. Cierre el software Capture Pro.

5. Descargue el servicio de importación automática de Capture Pro del sitio 
web del software Capture Pro: www.kodakalaris.com/go/
CaptureProAIService.

6. Instale el servicio de importación automática de Capture Pro en el mismo 
servidor donde esté instalada la función de importación automática de 
Capture Pro.

7. De forma predeterminada, el servicio de importación automática de 
Capture Pro se configurará para iniciarse automáticamente y tendrá el 
estado inicial Stopped (Detenido). Inicie el servicio manualmente o reinicie 
el servidor.

La función de importación automática de Capture Pro ya se está ejecutando 
en el servidor. Cualquier archivo de imagen colocado en la carpeta de 
inspección se importará y procesará como se describe en el trabajo 
seleccionado en la configuración de importación automática.

La importación automática se iniciará automáticamente cuando se reinicie el 
servidor.

Para modificar o añadir configuraciones de trabajo, detenga el servicio de 
importación automática de Capture Pro e inicie el software Capture Pro de 
forma manual. Cuando se hayan completado las actualizaciones, cierre el 
software Capture Pro e inicie el servicio de importación automática de Capture 
Pro de forma manual, o reinicie el servidor.

NOTA: Si una configuración de trabajo se modifica en un entorno de grupo de 
trabajo compartido, la importación automática deberá detenerse 
y reiniciarse para que los cambios se efectúen.
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Propiedades del servicio de importación automática

Si fuera necesario cambiar el registro del servicio de importación automática 
desde la cuenta predeterminada del sistema local hasta una cuenta de 
usuario, asegúrese de agregar el usuario al grupo de administración local.

Gestión de errores Si, cuando se está procesando un lote, no se puede abrir un archivo de 
imagen compatible: 

• el archivo incorrecto se copiará en la memoria caché de errores; 

• se sustituirá por una imagen de error genérica; y 

• se incrementará el recuento de errores del lote de importación automática.

Si se ha alcanzado el umbral de error definido en la configuración del lote, se 
detendrá el procesamiento del lote. Se mostrará un cuadro de diálogo con las 
siguientes opciones:

- Ignore (Ignorar): pasa a la siguiente imagen. El lote reiniciará el 
procesamiento hasta que encuentre la siguiente imagen incorrecta.

- Abort (Anular): los archivos restantes del lote se copiarán en la memoria 
caché de errores y la importación automática se detendrá. Cuando la 
importación automática se reinicia después de una anulación, continúa 
con el siguiente lote de la cola. No existe ningún procedimiento de 
recuperación automático para los lotes copiados en la memoria caché de 
errores. El usuario deberá localizar y corregir los archivos incorrectos 
y volver a insertar el lote manualmente en la carpeta de inspección.
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9   Selección de trabajo inteligente

Descripción general La funcionalidad de selección de trabajo inteligente, que se puede encontrar 
en el menú File (Archivo) de Capture Pro, le permite configurar parámetros 
avanzados para cambiar las configuraciones de trabajo o de página 
automáticamente durante la digitalización. Cuando se digitalice un código de 
parche con una condición predefinida, se cambiará la configuración de trabajo 
o de página sin necesidad de que el operador realice ninguna otra acción. 

A fin de que la selección de trabajo inteligente funcione correctamente, es 
necesario preparar los documentos para añadir las hojas de parche al lote. 

Esta función está disponible únicamente para escáneres Kodak o Alaris. Si no 
dispone de un escáner Kodak o Alaris, esta función se desactivará. Este 
capítulo proporciona información sobre los procedimientos relacionados con la 
selección de las opciones en las pestañas General (General) y Setup 
(Configuración) de Intelligent Job Select (Selección de trabajo inteligente). 

Deberá realizar lo siguiente: 

1. Configurar una o más hojas de parche para activar los cambios en la 
configuración.

2. Configurar Capture Pro para reconocer los cambios activados por cada 
hoja de parche. 

 Para acceder a la selección de trabajo inteligente, vaya a Intelligent Job 
Select… (Selección de trabajo inteligente…) en el menú File (Archivo) de 
Capture Pro. 
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Selección de trabajo 
inteligente: pestaña 
General

La ventana Setup (Configuración) de la selección de trabajo inteligente le 
permite definir cuándo y cómo se aplicarán los cambios de configuración en 
función de los códigos de parche leídos por el escáner. La pestaña General de 
esta ventana ofrece las siguientes opciones:

Enable Intelligent Job Select on (Activar selección de trabajo inteligente en): 
seleccione el tipo de parche que desea utilizar en la hoja de parche de 
función. Los parches de función válidos son: Parche 10, Parche 11, Parche 
12, Parche 13, Parche 14 o Parche 15. 

Sample Image (Imagen de muestra): seleccione una imagen ya almacenada 
como imagen de muestra a fin de definir una regla para este parche. La lista 
desplegable contiene todas las imágenes que se han digitalizado para la 
configuración de la selección de trabajo inteligente. Debe tener al menos una 
imagen en la lista para poder definir una zona de código de barras o de OCR. 

Iconos

Start/Scan (Iniciar/Digitalizar): abre el cuadro de diálogo para 
digitalizar una imagen, que permite introducir el nombre de una 
imagen y digitalizar una imagen que contenga códigos de 
barras, segmentos de texto OCR o áreas de marcas.
NOTA: El software Capture Pro utilizará la configuración de 

página seleccionada actualmente para digitalizar la 
imagen de muestra.

Draw region (Dibujar región): permite dibujar un rectángulo 
alrededor de un código de barras o segmento de texto OCR en 
la imagen digitalizada y, a continuación, muestra el cuadro de 
diálogo de configuración de zona de código de barras 
o configuración de zona de OCR.
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OK (Aceptar): permite guardar la configuración y cerrar el cuadro de diálogo

CANCEL (Cancelar): permite descartar los cambios que no se han aplicado y 
cerrar el cuadro de diálogo.

APPLY (Aplicar): permite guardar la configuración y dejar el cuadro de diálogo 
abierto.

Magnify (Aumentar): amplía una parte de una imagen. Para 
ampliar cualquier parte de la imagen, coloque la herramienta 
Magnify (Aumentar) sobre la imagen y mantenga pulsado el 
ratón.
Pan (Desplazar): permite mover la imagen cuando su tamaño es 
mayor que la ventana de configuración de parches de función.

Zoom in (Acercar): agranda la imagen.

Zoom out (Alejar): reduce la imagen.

Fit window (Ajustar a la ventana): cambia la visualización de la 
imagen para que se ajuste a la ventana de imagen de la 
configuración de la selección de trabajo inteligente.
Actual size (Tamaño real): muestra la imagen a tamaño real. Un 
píxel digitalizado equivale a un píxel de la ventana de imagen de 
la configuración de la selección de trabajo inteligente.
Test selected bar code, OCR or Mark Detection zone (Probar 
zona de código de barras, OCR o detección de marcas 
seleccionada): abre el cuadro de diálogo de valores de código 
de barras, OCR y detección de marcas, que permite ver los 
resultados de la prueba en una zona seleccionada.
Create OCR zone (Crear zona de OCR): permite crear una 
zona de OCR a partir de la imagen visualizada en la ventana de 
configuración de la selección de trabajo inteligente.
Create barcode (Crear código de barras): permite crear una 
zona de código de barras a partir de la imagen visualizada en la 
ventana de código de barras, OCR y detección de marcas.
Zone properties (Propiedades de zona): abre el cuadro de 
diálogo de configuración de zona de código de barras, 
configuración de zona de OCR o configuración de zona de 
detección de marcas, que permite ver las propiedades de la 
zona de código de barras, OCR o de detección de marcas 
seleccionada.
Delete selected zone (Eliminar zona seleccionada): permite 
eliminar una zona de código de barras, OCR o detección de 
marcas. Aparecerá un cuadro de confirmación para que 
verifique su selección.
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Creación de una hoja 
de parche de función

Cree una hoja de parche que se utilizará para activar un cambio de 
configuración. Utilice uno de los siguientes parches: Parche 10, Parche 11, 
Parche 12, Parche 13, Parche 14 o Parche 15. La hoja de parche debe estar 
personalizada con texto o un código de barras. 

NOTA: Solo se permite una zona para la configuración de la selección de 
trabajo inteligente. Para activar distintos cambios de configuración, 
cree una hoja de parche para cada uno. 

Por ejemplo, la hoja de Parche 10 que se muestra a continuación a la 
izquierda se puede utilizar para implementar un cambio de configuración 
como “Si el valor de un código de barras es 12345678, cambiar la 
Configuración de página a Color 150 DPI”.

La hoja de Parche 10 que se muestra a continuación a la derecha se puede 
utilizar para implementar un cambio de configuración como “Si la zona de 
OCR equivale a Digitalizar a PDF, cambiar la configuración de trabajo 
a Digitalizar a PDF”. 

Creación de una 
configuración de 
parche de función

1. Una vez que haya preparado las hojas de parche, debe establecer la 
configuración de la selección de trabajo inteligente. En la pestaña General, 
seleccione la opción Enable Intelligent Job Select on (Activar selección 
de trabajo inteligente en). En la lista desplegable, seleccione el tipo de 
parche de función que ha personalizado para esta función. 

2. Seleccione una imagen de su hoja de parche en la lista desplegable 
Sample image (Imagen de muestra) o digitalice la hoja de parche que ha 
creado en “Creación de una hoja de parche de función”. 

3. Cree una zona de código de barras o una zona de OCR para el texto que 
ha añadido a la hoja de parche. 

4. Pruebe la zona para garantizar que el código de barras o el texto se 
reconocen correctamente. 
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5. Utilice el menú de clic derecho de la imagen según sea necesario para 
ajustar la imagen o la zona. 

6. A continuación, configure una o más reglas para definir el cambio de 
configuración que se activará cuando el escáner reconozca esta hoja de 
parche. 

Selección de trabajo 
inteligente: pestaña 
Configuración

Una vez que haya activado la selección de trabajo inteligente y configurado 
una página de imagen de muestra con una zona de OCR o de código de 
barras, debe crear la regla que se seguirá al detectar el parche de función. 
Las reglas se definen en la pestaña Setup (Configuración) de la ventana de 
selección de trabajo inteligente. La pestaña de configuración presenta las 
siguientes opciones:

If detect (Si se detecta): introduzca el valor de código de barras o el valor de 
texto OCR de la hoja de parche que ha configurado en la pestaña General.

Change (Cambiar): seleccione el nombre de la configuración de trabajo o de 
página en la lista desplegable.

To (A): seleccione el nombre de la configuración de trabajo o de página en la 
lista desplegable. Cuando se detecta la hoja de parche, la configuración se 
cambiará a la configuración que haya seleccionado en este campo.

Add (Agregar): una vez que haya definido una regla, este botón la añadirá a la 
lista mostrada.
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Delete (Eliminar): seleccione una regla de la lista mostrada y haga clic en este 
botón para borrar la regla seleccionada. 

When changing jobs (Al cambiar trabajos): esta opción no está disponible 
para los escáneres que realizan la lectura del código de parche en el escáner 
(p. ej., el escáner Kodak i5x50). En estos escáneres, la digitalización se 
llevará a cabo a la velocidad nominal del escáner.

• Always change to page setup in job (slower) (Cambiar siempre 
a configuración de página en el trabajo [más lento]): seleccione esta opción 
si desea utilizar la configuración de página definida en el trabajo o la última 
configuración de página utilizada si no se ha definido ninguna.

• Use one page setup for all jobs (faster) (Utilizar una configuración de 
página para todos los trabajos [más rápido]): seleccione esta opción si 
desea realizar la digitalización a la velocidad nominal del escáner. 
Es necesario definir una configuración de página en la lista desplegable que 
se utilizará para todos los trabajos.

OK (Aceptar): permite guardar la configuración y cerrar el cuadro de diálogo.

Cancel (Cancelar): permite descartar los cambios que no se han aplicado a la 
lista y cerrar el cuadro de diálogo.

Apply (Aplicar): permite guardar la configuración y dejar el cuadro de diálogo 
abierto.

Definir una regla La regla tendrá un formato similar al siguiente: If detect (Si se detecta) 
<valor> change (cambiar) <configuración de trabajo o de página> to (a) 
<nombre de configuración deseada>. 

1. Configure una regla para el parche mediante el uso de los campos If 
detect (Si se detecta), change (cambiar) y to (a). 

2. Una vez que haya definido la regla, seleccione el botón Add (Agregar) 
para añadir la regla a la lista. 

3. Seleccione Apply (Aplicar) u OK (Aceptar) para guardar los cambios. 

4. Cree reglas adicionales según sea necesario. Si cuenta con distintos tipos 
de hojas de parche personalizadas, necesitará una regla para cada una de 
las hojas.

NOTA: Para cambiar una regla, elimínela y añada una nueva. 
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10   Solución de problemas

Cómo borrar los 
errores

La ventana Batch Process Status (Estado de procesamiento del lote) de 
Capture Pro proporciona información sobre los lotes que se están preparando 
para su generación.

Para ver la ventana Batch Status (Estado del lote):

• Seleccione Batch > View Batch Output Status (Lote > Ver estado de 
generación del lote).

Para borrar los errores:

• Haga clic en Job Name (Nombre del trabajo) y, en Clear All Errors (Borrar 
todos los errores) o Clear Selected Errors (Borrar los errores 
seleccionados).

Inicio de sesión con 
la línea de comandos

El software Capture Pro admite el inicio de sesión mediante la línea de 
comandos con la siguiente instrucción:

Capture.exe/username <nombre de usuario>/password <contraseña>
Por ejemplo, un usuario con el nombre de usuario “tester” y la contraseña 
“123465” puede iniciar el software Capture Pro con el siguiente comando:

Capture.exe/username tester/password 123465
Si el usuario utiliza el nombre de usuario de Windows actual para iniciar 
sesión en el software Capture Pro, podrá iniciar dicho software con el 
comando:

Capture.exe/username

Asistencia técnica Puede encontrar asistencia técnica sobre el software Capture Pro en el sitio 
web de Kodak Alaris: www.kodakalaris.com/go/CaptureProSupport. Las 
páginas de asistencia técnica proporcionan información específica sobre los 
productos, como descargas de actualizaciones, controladores y accesorios, 
acceso a las preguntas frecuentes y detalles sobre las opciones de asistencia 
del software Capture Pro disponibles en su país o región.
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Anexo A   Administrador de licencias

El Administrador de licencias es una utilidad que puede instalarse y ejecutarse 
independientemente del software Capture Pro. Se instala con el software 
Capture Pro y, para abrirlo y ejecutarlo, se puede seleccionar License 
manager (Administrador de licencias) en el menú Help (Ayuda) o hacer clic en 
el acceso directo correspondiente en Kodak > Kodak Capture Pro Software 
(Kodak > Software Kodak Capture Pro). Si el software Capture Pro no está 
instalado en el equipo, el Administrador de licencias se puede descargar de 
www.kodakalaris.com/go/captureprodownload. Esta utilidad proporciona un 
conjunto de funciones para obtener y administrar la licencia del software 
Capture Pro.

El Administrador de licencias proporciona el método más sencillo de obtener 
una licencia para una estación de trabajo que ejecuta el software Capture Pro 
y que no tiene acceso a Internet.

Software Serial Number (Número de serie del software): muestra el número 
de serie del software, que se utiliza para identificar la licencia.
Version Number (Número de versión): especifica la versión del software 
Capture Pro que desea utilizar. No se pueden seleccionar versiones anteriores 
a la versión 4.0.0.
License Location (Ubicación de licencia): especifica la ubicación de 
instalación de la licencia. Para una instalación típica, la ubicación sería 
C:\Archivos de programa\Kodak\Capture Pro\System.
License Status (Estado de licencia): los estados son: Licensed, Temporary 
License o Not Licensed (Con licencia, Con licencia temporal o Sin licencia). 
Las licencias temporales caducan en una fecha predeterminada.

http://www.alarisworld.com/go/CaptureProDownload
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Pestañas Request License, Release License y Replace License (Solicitar 
licencia, Liberar licencia y Sustituir licencia): consulte las secciones siguientes 
para obtener más información y conocer los procedimientos.
Register (Registrar): permite registrar el software Capture Pro y obtener la 
información del campo Registration ID (ID de registro). La información del 
campo Registration ID (ID de registro) se puede utilizar para futuras 
instalaciones de esta licencia u otras licencias del software Capture Pro que 
pueda tener.

Show Hardware ID (Mostrar ID de hardware): muestra el identificador del 
hardware que se utiliza para individualizar la estación de trabajo con licencia.
Close (Cerrar): cierra la ventana del Administrador de licencias.

Solicitud de una 
licencia

Las funciones de la pestaña Request License (Solicitar licencia) se utilizan 
para solicitar una licencia al servidor de licencias de Kodak Alaris.  

Get License (Obtener licencia): utilice esta opción si la estación de trabajo 
para la que desea obtener la licencia tiene acceso a Internet. 

Get Trial License (Obtener licencia de prueba): permite solicitar una licencia 
de prueba si no tiene un número de serie de software.

Request License (Solicitar licencia): si la estación de trabajo para la que 
desea obtener la licencia no tiene acceso a Internet, seleccione Request 
License (Solicitar licencia) para crear un archivo de solicitud de licencia que 
se puede utilizar para pedir la licencia en un equipo con acceso a Internet. 
Se le solicitará que introduzca una ubicación para el archivo de solicitud de 
licencia.
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Upload Request (Cargar solicitud): esta función se utiliza en un equipo con 
acceso a Internet para enviar el archivo de solicitud de licencia al servidor de 
licencias de Kodak Alaris. Se le solicitará que introduzca la ubicación del 
archivo de solicitud de licencia. Si la solicitud de licencia es correcta, el 
archivo de licencia devolverá a esta ubicación.

Install License (Instalar licencia): esta función se utiliza en la estación de 
trabajo sin acceso a Internet para instalar la licencia que se obtuvo en el 
equipo con acceso a Internet. Se le solicitará la ubicación del archivo de 
licencia.

A continuación, se muestran algunos ejemplos de uso de la opción Solicitar 
licencia:

Ejemplo 1

Situación: El software Capture Pro está instalado en la estación de trabajo. 
Compré una función opcional y necesito actualizar la licencia para activarla. 
La estación de trabajo tiene acceso a Internet.

Solución: 

1. Seleccione Help > License Manager (Ayuda > Administrador de licencias) 
en la barra de menú. 

2. En la ventana License Manager (Administrador de licencias), seleccione la 
pestaña Request License (Solicitar licencia) y, a continuación, seleccione 
Get License (Obtener licencia).

Se obtendrá e instalará una nueva licencia.

Ejemplo 2

Situación: Estoy instalando el software Capture Pro en una estación de trabajo 
sin acceso a Internet. Durante la instalación, el instalador creó un archivo de 
solicitud de licencia. ¿Qué debo hacer ahora?

Solución: 

1. En un equipo distinto con acceso a Internet, descargue la herramienta 
Administrador de licencias desde el sitio de descarga del software Capture 
Pro (www.kodakalaris.com/go/CaptureProDownload). 

2. Instale el Administrador de licencias e inícielo. 

3. En la pestaña Request License (Solicitar licencia), seleccione Upload 
Request (Cargar solicitud). 

4. Busque el archivo de solicitud de licencia creado en la estación de trabajo 
sin acceso a Internet y cárguelo. 

Se obtendrá la licencia y se guardará en la misma ubicación a la que 
accedió para seleccionar el archivo de solicitud de licencia.

5. Mueva el archivo de licencia obtenido a la estación de trabajo donde está 
instalando el software Capture Pro y continúe con la instalación.

Ejemplo 3

Situación: El software Capture Pro está instalado en la estación de trabajo. 
Compré una función opcional y necesito actualizar la licencia para activarla. 
La estación de trabajo no tiene acceso a Internet.

http://www.alarisworld.com/go/CaptureProDownload
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Solución: 

1. Seleccione Help > License Manager (Ayuda > Administrador de licencias) 
en la barra de menú. 

2. En la ventana License Manager (Administrador de licencias), seleccione la 
pestaña Request License (Solicitar licencia) y, a continuación, seleccione 
Request License (Solicitar licencia). 

3. Introduzca la ruta en la que desea que se guarde el archivo de solicitud de 
licencia. Seleccione Request (Solicitar). Se creará un archivo de solicitud 
de licencia. 

4. Mueva el archivo de solicitud de licencia a un equipo con acceso 
a Internet. 

5. En el equipo con acceso a Internet, descargue la herramienta License 
Manager (Administrador de licencias) desde el sitio de descargas del 
software Capture Pro (www.alarisworld.com/go/CaptureProDownload). 

6. Instale el Administrador de licencias e inícielo. 

7. En la pestaña Request License (Solicitar licencia), seleccione Upload 
Request (Cargar solicitud). 

8. Busque el archivo de solicitud de licencia que movió a este equipo y 
seleccione Upload (Cargar).

Se obtendrá la licencia y se guardará en la misma ubicación a la que 
accedió para seleccionar el archivo de solicitud de licencia. 

9. Mueva el archivo de licencia obtenido a la estación de trabajo en la que se 
está ejecutando el software Capture Pro y seleccione Install License 
(Instalar licencia) en la pestaña Request License (Solicitar licencia). Se le 
solicitará que introduzca la ruta del archivo de licencia que movió a la 
estación de trabajo.

http://www.alarisworld.com/go/CaptureProDownload
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Liberación de una 
licencia

Las funciones de la pestaña Release License (Liberar licencia) se utilizan para 
liberar la licencia de la estación de trabajo asignada en ese momento. Debe 
liberar una licencia antes de desinstalar el software Capture Pro o trasladarla 
a una estación de trabajo distinta.  

Release License (Liberar licencia): si la estación de trabajo con licencia tiene 
acceso a Internet, esta opción eliminará la licencia de la estación de trabajo de 
modo que esté disponible para una nueva estación de trabajo.

Request Release (Solicitar liberación): si la estación de trabajo con licencia 
no tiene acceso a Internet, utilice esta opción para crear un archivo de 
solicitud de liberación. Este archivo se puede mover a un equipo con acceso a 
Internet y enviarlo al servidor de licencias de Kodak Alaris mediante la opción 
Upload Request (Cargar solicitud). Se le solicitará que indique una ubicación 
para el archivo de solicitud de liberación.

Upload Request (Cargar solicitud): esta opción se utiliza para liberar la 
licencia mediante el envío del archivo de solicitud de liberación al servidor de 
licencias de Kodak Alaris desde un equipo con acceso a Internet. Se le 
solicitará que introduzca la ubicación del archivo de solicitud de liberación.

A continuación, se muestran algunos ejemplos de uso de la opción Liberar 
licencia:

Ejemplo 1

Situación: El software Capture Pro está instalado en la estación de trabajo. Me 
gustaría migrar el software Capture Pro a una estación de trabajo más rápida 
y nueva. La estación de trabajo tiene acceso a Internet.

Solución: 

1. Seleccione Help > License Manager (Ayuda > Administrador de licencias) 
en la barra de menú. 
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2. En la ventana License Manager (Administrador de licencias), seleccione la 
pestaña Release License (Liberar licencia) y, a continuación, seleccione 
Release License (Liberar licencia). 

3. Cierre el software Capture Pro. La licencia se eliminará de esta estación 
de trabajo y estará disponible para instalarse en la nueva estación de 
trabajo.

Ejemplo 2

Situación: El software Capture Pro está instalado en la estación de trabajo 
y tengo que modificar la configuración (agregar/eliminar memoria, actualizar el 
BIOS, cambiar el nombre del equipo, cambiar la placa base, etc.). La estación 
de trabajo tiene acceso a Internet.

Solución: 

1. Seleccione Help > License Manager (Ayuda > Administrador de licencias) 
en la barra de menú. 

2. En la ventana License Manager (Administrador de licencias), seleccione la 
pestaña Release License (Liberar licencia) y, a continuación, seleccione 
Release License (Liberar licencia). 

3. Cierre el software Capture Pro.

4. Modifique la configuración de la estación de trabajo según sea necesario. 

5. Ejecute la herramienta License Manager (Administrador de licencias), que 
suele encontrarse en la carpeta de la aplicación Capture Pro, en la ruta 
<unidad>: \Archivos de programa\Kodak\Capture Pro\KCSPLM.exe.

6. En la ventana License Manager (Administrador de licencias), seleccione la 
pestaña Request License (Solicitar licencia) y, a continuación, seleccione 
Get License (Obtener licencia). Se obtendrá e instalará una nueva 
licencia. 

Ejemplo 3

Situación: El software Capture Pro está instalado en la estación de trabajo 
y tengo que modificar la configuración (agregar/eliminar memoria, actualizar el 
BIOS, cambiar el nombre del equipo, cambiar la placa base, etc.). La estación 
de trabajo no tiene acceso a Internet.

Solución: 

1. Seleccione Help > License Manager (Ayuda > Administrador de licencias) 
en la barra de menú. 

2. En la ventana License Manager (Administrador de licencias), seleccione la 
pestaña Release License (Liberar licencia) y, a continuación, seleccione 
Request Release (Solicitar liberación). Introduzca la ruta donde desea 
guardar el archivo de solicitud de liberación. Seleccione Request 
(Solicitar).

3. Cierre el software Capture Pro.

4. Mueva el archivo de solicitud de liberación a un equipo con acceso 
a Internet. 

5. Descargue la herramienta License Manager (Administrador de licencias) 
desde el sitio de descargas del software Capture Pro. 
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6. Instale el Administrador de licencias e inícielo. 

7. En la pestaña Release License (Liberar licencia), seleccione Upload 
Request (Cargar solicitud). 

8. Busque el archivo de solicitud de licencia que movió a este equipo 
y seleccione Upload (Cargar).

9. Modifique la configuración de la estación de trabajo que ejecuta el 
software Capture Pro. 

10. Cuando se haya completado la configuración, ejecute la herramienta 
License Manager (Administrador de licencias), que suele encontrarse en 
la carpeta de la aplicación Capture Pro, en la ruta <unidad>: \Archivos de 
programa\Kodak\Capture Pro\KCSPLM.exe. 

11. Seleccione la pestaña Request License (Solicitar licencia) y, 
a continuación, Request License (Solicitar licencia). Introduzca la ruta en 
la que desea que se guarde el archivo de solicitud de licencia. Seleccione 
Request (Solicitar). Se creará un archivo de solicitud de licencia. 

12. Mueva el archivo de solicitud de licencia al equipo con acceso a Internet 
que tiene instalado el Administrador de licencias. 

13. En la pestaña Request License (Solicitar licencia), seleccione Upload 
Request (Cargar solicitud). 

14. Busque el archivo de solicitud de licencia que movió a este equipo 
y seleccione Upload (Cargar). 

15. Mueva el archivo de licencia obtenido a la estación de trabajo sin acceso 
a Internet, seleccione la pestaña Request License (Solicitar licencia) y, 
a continuación, seleccione Install License (Instalar licencia). Se le 
solicitará que introduzca la ruta del archivo de licencia que movió a esta 
estación de trabajo.

Ejemplo 4

Situación: Realicé cambios en la configuración del hardware de la estación de 
trabajo y, desde entonces, cuando ejecuto el software Capture Pro, aparece el 
mensaje Invalid License Code (Código de licencia no válido). ¿Qué debo 
hacer?

Solución 1: 

1. Restablezca la configuración de hardware original de la estación de 
trabajo. Si esto no fuera posible, consulte la Solución 2. 

2. Consulte el Ejemplo 2 si tiene acceso a Internet o el Ejemplo 3 si su 
estación de trabajo no tiene acceso a Internet.

Solución 2: 

• Si la estación de trabajo tiene acceso a Internet: 

1. Vaya a la carpeta de instalación del software Capture Pro (normalmente, 
Archivos de programa > Kodak > Capture Pro) y ejecute el 
Administrador de licencias: KCSPLM.exe.

2. En la pestaña Replace License (Sustituir licencia), seleccione Replace 
Lost License (Sustituir licencia perdida). Se obtendrá e instalará una 
nueva licencia.

• Si la estación de trabajo no tiene acceso a Internet: 
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1. Vaya a la carpeta de instalación del software Capture Pro 
(normalmente, Archivos de programa > Kodak > Capture Pro) y 
ejecute el Administrador de licencias: KCSPLM.exe.

2. En la pestaña Replace License (Sustituir licencia), seleccione Request 
Replacement (Solicitar sustitución). Introduzca la ruta en la que desea 
que se guarde el archivo de solicitud de sustitución. Seleccione 
Request (Solicitar). Se creará un archivo de solicitud de sustitución de 
licencia.

3. Cierre el software Capture Pro.

4. Mueva el archivo de solicitud de sustitución a un equipo con acceso a 
Internet. 

5. En el equipo con acceso a Internet, descargue la herramienta License 
Manager (Administrador de licencias) desde el sitio de descargas del 
software Capture Pro. 

6. Instale el Administrador de licencias e inícielo. 

7. En la pestaña Replace License (Sustituir licencia), seleccione Upload 
Request (Cargar solicitud). 

8. Busque el archivo de solicitud de sustitución que movió a este equipo 
y seleccione Upload (Cargar). Se obtendrá la licencia y se guardará en 
la misma ubicación a la que accedió para seleccionar el archivo de 
solicitud de sustitución.

9. Mueva el archivo de licencia obtenido a la estación de trabajo sin 
acceso a Internet.

10. En la estación de trabajo sin acceso a Internet, vaya a la pestaña 
Replace License (Sustituir licencia) y seleccione Instalar licencia 
(Install License).

11. Busque la ubicación del archivo de licencia que movió a esta estación 
de trabajo y seleccione Install (Instalar).
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Sustitución de una 
licencia 

Las funciones de la pestaña Replace License (Sustituir licencia) se utilizan 
para sustituir una licencia original que se ha perdido debido al extravío o fallo 
del equipo. Sustituir una licencia que no se ha perdido supone una infracción 
del acuerdo de licencia y podría resultar en la pérdida del derecho a la 
licencia.

Replace Lost License (Sustituir licencia perdida): si la estación de trabajo en 
la que se va a realizar la sustitución tiene acceso a Internet, esta opción 
recuperará e instalará una nueva licencia para la estación de trabajo.

Request Replacement (Solicitar sustitución): si la estación de trabajo en la 
que se va a realizar la sustitución no tiene acceso a Internet, utilice esta 
opción para crear un archivo de solicitud de sustitución de licencia. Este 
archivo se puede mover a un equipo con acceso a Internet y enviarlo al 
servidor de licencias de Kodak Alaris mediante la opción Upload Request 
(Cargar solicitud).

Upload Request (Cargar solicitud): esta opción se utiliza en un equipo con 
acceso a Internet para enviar el archivo de solicitud de sustitución de licencia 
al servidor de licencias de Kodak Alaris.

Install License (Instalar licencia): esta función se utiliza en la estación de 
trabajo sin acceso a Internet para instalar la licencia que se obtuvo en el 
equipo con acceso a Internet.

A continuación, se muestran algunos ejemplos de uso de la opción Sustituir 
licencia:

Ejemplo 1

Situación: Se produjo un error en el disco duro de la estación de trabajo que 
ejecuta el software Capture Pro y no puedo recuperar el contenido. 
La estación de trabajo tiene acceso a Internet. ¿Qué debo hacer?
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Solución: 

1. Antes de instalar el software Capture Pro, descargue la herramienta 
License Manager (Administrador de licencias) desde el sitio de descargas 
del software Capture Pro. 

2. Instale el Administrador de licencias e inícielo. 

3. En la pestaña Replace License (Sustituir licencia), seleccione Replace 
Lost License (Sustituir licencia perdida). Se obtendrá una nueva licencia, 
pero no es necesaria en este momento. 

4. Descargue el software Capture Pro del sitio de descargas del software 
Capture Pro y ejecute el instalador. Durante la instalación, se obtendrá una 
copia de la nueva licencia del software Capture Pro desde el servidor de 
licencias de Kodak Alaris.

Ejemplo 2

Situación: Se produjo un error en el disco duro de la estación de trabajo que 
ejecuta el software Capture Pro y no puedo recuperar el contenido. 
La estación de trabajo no tiene acceso a Internet. ¿Qué debo hacer?

Solución:

1. Antes de instalar el software Capture Pro, descargue la herramienta 
License Manager (Administrador de licencias) desde el sitio de descargas 
del software Capture Pro. 

2. Instale el Administrador de licencias en la estación de trabajo sin acceso 
a Internet y ejecute el Administrador de licencias. 

3. En la pestaña Replace License (Sustituir licencia), seleccione Request 
Replacement (Solicitar sustitución). Introduzca la ruta en la que desea 
que se guarde el archivo de sustitución. Seleccione Request (Solicitar). 
Se creará un archivo de solicitud de sustitución de licencia. 

4. Mueva el archivo de solicitud de sustitución de licencia a un equipo con 
acceso a Internet. 

5. En el equipo con acceso a Internet, descargue la herramienta License 
Manager (Administrador de licencias) desde el sitio de descargas del 
software Capture Pro. 

6. Instale el Administrador de licencias e inícielo. 

7. En la pestaña Replace License (Sustituir licencia), seleccione Upload 
Request (Cargar solicitud). 

8. Busque el archivo de solicitud de sustitución de licencia que movió a este 
equipo y seleccione Upload (Cargar). Se obtendrá la licencia y se 
guardará en la misma ubicación a la que accedió para seleccionar el 
archivo de solicitud de sustitución de licencia.

9. Vuelva a la estación de trabajo donde desea instalar el software Capture 
Pro y ejecute el instalador del software Capture Pro. Durante la 
instalación, el instalador creará un archivo de solicitud de licencia. 

NOTA: El archivo de solicitud de licencia no es necesario, ya que se creó 
una licencia de sustitución en el paso 8.

10. Mueva el archivo de licencia de sustitución a la estación de trabajo donde 
está instalando el software Capture Pro y continúe con la instalación.
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